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Introduction Getting Started

Overview

| ntroduction

Application  Welcometo IBM® Sterling Gentran: Server® for Microsoft Windows Application
integration Integration subsystem, which is electronic commerce (EC) mapping software for the
subsystem Windows operating system. Sterling Gentran: Server provides you with the tools you need
to trandate your application filesto EDI standard formats for documents you send to your
partners (outbound mapping), and to translate EDI standard formats to your application
format for documents that you receive from your partners (inbound mapping).

Sterling Gentran:Server — May 2011 Application Integration ANSI Tutorial Guide



Getting Started

In this Guide

Overview

Contents

In this Guide

This guide contains a tutorial for the Sterling Gentran:Server Application Integration
subsystem, using the ANSI X 12 standard. Thistutorial includes an inbound mapping
exampl e (purchase order) and an outbound mapping example (invoice). The purpose of
thistutorial isto break the mapping process down into concise and understandabl e steps,
using examples that enable you to understand and master the tasks and processes required
to create your own maps.

To access reference information, refer to the Sterling Gentran:Server Application
Integration online Help or IBM® Serling Gentran: Server® for Microsoft Windows
Application Integration User Guide. For additional information on the various tasks
described in this guide, refer to the IBM® Serling Gentran: Server® for Microsoft
Windows User Guide.

Note
This guide assumes that you are familiar with using a PC and with Microsoft® Windows
functions, including:

» Theterminology used to describe mouse and cursor actions.

» Theterminology used to describe Windows-specific attributes, including dialog
boxes, icons, windows, and buttons.

» Using the Windows Program Manager.

This guide also assumes that you are familiar with EDI concepts, EDI standard structure,
your internal application format, data mapping concepts, and with the Sterling
Gentran: Server product.

This guide is organized into chapters. Thistable provides a brief description of each
chapter’s contents.

Chapter Description

1 Getting Started Explains the content, organization, and conventionsin
this guide, aswell asthe system requirements. This
chapter also describes a brief outline of how to build
maps using Sterling Gentran: Server Application
Integration, how to customize global display options, and
gives you an introduction to mapping and Sterling
Gentran: Server.

2 Inbound Purchase Order | Uses a step-by-step approach to explain the tasks and
procedures necessary to create an export map for an ANSI
inbound (850) purchase order.

Application Integration ANSI Tutorial Guide Sterling Gentran: Server — May 2011



In this Guide

Getting Started

Chapter

Description

3 Outbound Invoice

Uses a step-by-step approach to explain the tasks and
procedures necessary to create a system import map and
an import map for an ANSI outbound (810) invoice.

Glossary

Contains definitions of mapping and Sterling
Gentran:Server Application Integration subsystem terms
and concepts.

Sterling Gentran:Server — May 2011
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Getting Started

Mapping Overview

|ntroducing Mapping

M apping Overview

Introduction

Inbound mapping

Outbound
mapping

Trandation objects

A map isaset of instructions you define in the Sterling Gentran: Server Application
Integration subsystem that indicates the corresponding relationship between your
application file and the EDI standards, and defines how the system should translate data.

For inbound mapping, the system translates your trading partner’s EDI standard formatted
business document to your application file format. To translate inbound data, you need to
create an export map in Sterling Gentran: Server Application Integration (because the
system is exporting to your application file).

For outbound mapping, the system trandates your application file format to EDI standard
formats, so you can send documentsto your partners. To trand ate outbound data, you need
to create an import map and a system import map in the Sterling Gentran: Server
Application Integration subsystem. You need to create an import map because the system
isimporting from your application file.

The import map defines how to move data from your application file (flat file definition),
which may contain multiple documents, to the EDI standard-formatted documents that
your partners expect to receive from you. You need to create a system import map to
determine which trading relationship (established in Partner Editor) corresponds to each
document in the application file, so the system knows which import map to use to process
the document. Please see Creating a System Import Map on page 225 for more
information on creating a system import map.

The map you create is the source from which you compile atrandation object. A
translation object isa set of rulesthat instruct the translator how to convert afile from one
format to another. Every function performed during translation requires a translation
object. Translation objects control al the functions of Sterling Gentran:Server EDI
tranglation. Translation objects can belong to the following two categories:

» system translation objects or
» user trandation objects.

Application Integration ANSI Tutorial Guide Sterling Gentran: Server — May 2011
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Trandation objects  System translation objects control the creation and separation of interchanges, functional
(contd) groups, and transaction sets. They are also used to generate and reconcile functional
acknowledgements. User translation objects control data entry, importing, exporting,
document turnaround, and creating printed reports. All the required system translation
objects are automatically installed with the Sterling Gentran: Server system.

Sterling Gentran: Server Application Integration enables you to generate import, export,
and document turnaround translation objects. The Sterling Gentran: Server Forms

I ntegration subsystem enables you to generate data entry and print trandlation objects.
Once you generate a translation object using the Sterling Gentran: Server Application
Integration subsystem (or the Sterling Gentran: Server Forms Integration subsystem), you
must register the translation object with Sterling Gentran: Server. In addition, you must
establish correct trading relationships for all trading partners from which you receive or to
which you send data. During the process of establishing atrading relationship, you need to
specify the name of the appropriate trand ation object that the translator uses to translate
the data.

Reference

See the IBM® Serling Gentran: Server® for Microsoft Windows User Guide for more
information about trandlation objects, trading partner relationships, and naming translation
objects.

Diagram: Inbound  Thisdiagram illustrates the inbound and outbound translation process.
and outbound
translation process

Export Translation Object

'

Application
Inbound L L»
Sterling
Outbound -«———— Gentran:Server -
EDI Application

!

Import Translation Object

When you create an import map, you must define to Sterling Gentran: Server your
application file format and the EDI standard format in which your partners expect to
receive the documents. When you create an export map, you need to define to Sterling
Gentran: Server the EDI standard format in which your partners sends documents and your
application file format (how the data needs to be formatted for your application to process
it).

Sterling Gentran:Server — May 2011 Application Integration ANSI Tutorial Guide



Getting Started

File For mats

Overview

Application file
format

Map components

File Formats

The Application File Format and EDI File Format are described in this section.

If you are creating an import or export map, you must define your application to the
Sterling Gentran:Server Application Integration subsystem. In Sterling Gentran: Server
terminology, your application file is a so referred to as a fixed-format file or a positional
file. Your application file must contain al the information that you either need to extract
from your partner’s document (if the map isinbound) or need to send to your partner (if

the map is outbound).

This table describes the map components that you use to define your application file.

Component

lcon

Description

Group

)

Thisisalooping structure that contains related
records and/or groups that repeat in sequence until
either the group data ends or the maximum number
of times that the loop is allowed to repeat is
exhausted. If you create a group that is subordinate
to another group (asubgroup), this correspondsto a
nested looping structure (aloop within aloop). The
application (positional) file is a group and
therefore, it isvisualy represented the same way as
other groups and subgroups in the Application
Integration subsystem as illustrated to the | eft.

Record

Contains agroup of related fields. A record can
occur once or can repeat multipletimes. A record is
visually represented in the Application Integration
subsystem asiillustrated to the left.

Field

Thisisthe smallest piece of information defined in
the application file. A field isthe application map
component that is mapped (linked) to a
corresponding EDI element. A field isvisually
represented in the Application Integration
subsystems as illustrated to the | eft.

Application Integration ANSI Tutorial Guide
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Map components  Notes

(contd) » When afield hasamapping operation performed against it, ared checkmark is
displayed over the field icon.

» Whenafield contains a standard rule a black asterisk appears to the right of the
element icon.

Before you define your application file format, you should obtain alayout of the necessary
records, fields, and groups. Each map component is arranged sequentially in the order that
itismost logical for the system to process. Therefore, each level of your application file
must be created sequentially. For example, your application file contains records and
groups. The records contain fields and the groups contain records and/or subgroups. This
means that you must create records and groups before you create the subordinate fields.

EDI fileformat  TheEDI file must contain all the information that you expect to receive from your partner
(if the map isinbound) or need to send to your partner (if the map is outbound).

The Sterling Gentran: Server Application Integration subsystem generates an EDI file for
you, based on the standard (agency), version, transaction set, and release (for the
TRADACOMS standard only) you selected. The system includes all the groups, segments,
composites, and elements that are defined by the standards agency for the version of the
document you selected. Please see Creating a New Map on page 18 for more information
on generating an EDI file when you create a new map. If you are creating an import or
export map, you typically need to customize the system-generated EDI file by modifying
the properties of the map components, and using specialized Sterling Gentran: Server
functions to manipulate the EDI file structure.

The specific EDI map components that you use depends on the type of map you are
creating. Thisincludes the standard, version, and transaction set (document) selected, and
which groups, segments, composites, and elements your company requires. We
recommend that you determine which map components you are using before generating or
defining an EDI file.

Specialized EDI If you want to use a specialized version of an EDI standard that is not availablein the
standard varsions  Sterling Gentran: Server standards database, it may be appropriate for you to define the
EDI file yourself.

Sterling Gentran:Server — May 2011 Application Integration ANSI Tutorial Guide
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File Formats

Map components  Thistable describes the map components Sterling Gentran: Server uses to define the EDI

file.

Component

lcon

Description

Group

Thisisalooping structure that contains rel ated
segments and/or groups that repeat in sequence
until either the group data ends or the maximum
number of timesthat theloop isallowed to repeat is
exhausted. Groups are defined by the EDI
standards. A group that is subordinate to another
group is a subgroup (this corresponds to a nested
looping structure —aloop within aloop). The EDI
fileisagroup and is visually represented the same
way as other groups and subgroups in the
Application Integration subsystem as illustrated to
the left.

Segment

Contains a group of related elements or composite
data elements that combine to communicate useful
data. Segments are defined by the EDI standards. A
segment can occur once or can repeat multiple
times. A segment isvisually represented in the
Application Integration subsystem as illustrated to
the left.

Composite

Thisis adata element that contains two or more
component data elements or subelements.
Composites are defined by the EDI standards that
use them (EDIFACT, TRADACOMS, and certain
ANSI X12 standards). A compositeisvisually
represented in the Application Integration
subsystem as illustrated to the | eft.

Element

Thisisthe smallest piece of information defined by
the EDI standards. An individual element can have
different meanings depending on the context.
Elements are typically not considered to have
useful meaning until they are combined into
segments. An element is the EDI map component
that is mapped (linked) to a corresponding
application field to move datato and from the EDI
file. An element is visually represented in the
Application Integration subsystem asillustrated to
the left.

Notes

» When an element has a mapping operation performed against it, ared checkmark is

displayed over the element icon.

Application Integration ANSI Tutorial Guide

Sterling Gentran: Server — May 2011



File Formats Getting Started

» When an element contains a standard rule a black asterisk appearsto the right of the
element icon.

Reference

Please see the IBM® Serling Gentran: Server® for Microsoft Windows Application
Integration User Guide for more information on customizing the properties of the map

components, and using specialized Sterling Gentran:Server functions to manipulate the
EDI file structure.
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The Application Integration Subsystem

Overview

Introduction The Sterling Gentran: Server Application Integration subsystem enables you to translate
your application filesto EDI standard formats for documents you send to your partners
(outbound mapping), and to translate EDI standard formats to your application format for
documents that you receive from your partners (inbound mapping).

Navigation  You can accessthe Sterling Gentran: Server Application Integration Window in one of four
ways:
» Click the menu option from the Main Menu Bar.
» Click the appropriate button on the Main Toolbar.
» Click the appropriate part of the map.

» Click amap component with the right mouse button to access a shortcut menu, which
contains all the functions that are currently available for that map component. The
content of the shortcut menus varies, depending on the type and level of the selected
map component.

Note

When you start Sterling Gentran: Server Application Integration, the Main Menu Bar
contains a subset of menu items. A full set of menu itemsis displayed after you create a
new map or open (load) an existing map.

Application Integration ANSI Tutorial Guide Sterling Gentran: Server — May 2011
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Application I ntegration Window

Application  Thisdiagram illustrates the Sterling Gentran:Server - Application Integration Window.
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Main Toolbar ——
Status Bar

Application  Thistable describes the Application Integration Window components.

integration
window Part Function
components
Control Menu Contains the following commands:
» Restore
» Move
» Size

» Minimize
» Maximize
» Close

Title Bar Contains the name of the application. You can use
this to move the position of the EDI Director
window on your desktop.
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Part Function
Minimize Reduces the window to an icon.
Maximize Enlarges the window to its maximum size.
Main Menu Bar Contains the drop-down menus. Unavailable items
are dimmed.
Reference

A detailed description of each command can be
found in the online Help.

Main Toolbar Enables you access to some of the most common
operations in the Application Integration
subsystem. Unavailable items are dimmed. The
Main Toolbar is adockable toolbar, so you can affix
it to any edge of the client window.

Status Bar Displays status information about a selection,
command, or process, defines menu items as you
highlight each item in the menu, and indicates any
current keyboard-initiated modes for typing (e.g.,
CAP for the “Caps Lock” key).
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Customizing Globa Display Options

Overview

Introduction The Sterling Gentran: Server Application Integration subsystem allows you to customize
the display of mapsin several different ways. The global display optionsthat are
established apply to all maps. This section explains how to perform the following:

» Customizing global display options
» Displaying links (global option)
» Setting global confirmation options

Note
You can set or change global map display options at any time.

Customizing Use this procedure to customize global display options for all maps.
global display
options Sep Action

1 From the Options menu, select Preferences. The Preferences dialog box
enables you to set global defaults for Sterling Gentran: Server.

System Response
The Preferences dialog box is displayed. The Tree tab is displayed by
default.

Freferences

Tree |Links | Standard Formatsl PositionaIDefauItsl Filzs | Eonfirmationsl Versionl

Thesze settings customize the look of the file format tree.

V' Show group descriptions Coalours... |
¥ Show record descriptions Font... |

¥ Show field dezcriptions

Cancel Help

Sterling Gentran:Server — May 2011 Application Integration ANSI Tutorial Guide



Getting Started

Overview

Step

Action

To turn on the default display of group, record (segment), and field
(element) descriptions, select the appropriate options.

Tip

You typically want all descriptions displayed for reference. But depending

on the size of your monitor, it may be easier to see the entire map if the
descriptions are not displayed.

Note

You may want to experiment with shrinking the size of the font for the
map (see Customizing Global Fontsin the IBM® Serling

Gentran: Server® for Microsoft Windows Application Integration User
Guide) before you turn off the display of descriptions.

Click OK to save changes and exit the Preferences dialog box.

Customizing  Mapping Links are the visual linesthat connect a field/element on the Input side of the
global display of ~ map to afield/element on the Output side of the map.

links

Use this procedure to customize the global display of mapping links.

Step

Action

1

From the Options menu, select Preferences.

System Response
The Preferences dialog box is displayed. The Tree tab is displayed by
default.

Application Integration ANSI Tutorial Guide
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Sep Action
2 Click the Links tab to display the linking options. The Links tab enables
you to set the default display of mapping links.

Tree  Links |Standard Fomats | Postional Defaulis | Files | Confimations | Wersion |

These settings control how links are shown between the input and output file formats,

£ Show no links
" Show links to or from the curently selected element.

& Show links to or from all visible elemerts

Cancel Help

3 Select a setting.

»  Show no links: do not display mapping links.

» Show linksto or from the currently selected element: display only the
mapping links for the currently selected field (this option enables you
to concentrate on the selected field and removes the confusion of
viewing many links at once.

» Show linksto or from al visible elements: display al the mapping
links

The option you select is the default for all maps.

4 Click OK to save changes and exit the Preferences dialog box.
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How to customize
global
confirmation
options

Overview

The Confirmations tab on the Preferences dialog allows you specify when you want
confirmation messages displayed.

Warning

Depending on how you set these options, you may receive either more or fewer
confirmation messages than described in this tutorial.

Use this procedure to set the confirmation options.

Sep Action
1 From the Options menu, select Preferences.
System response
The system displays the Preferences dialog box (Tree tab displayed by
default).
2 Select the Confirmation tab.
System response
The system displays the confirmation options.
Preferences : |
Tree I Links I Standard Formats | Pozitional Defaults | Files  Confimations I Wersion I
These settings allow pou to control when pou will be prompted to confirm an action,
I~
Canfirm whern | ...
¥ delete an obiest
¥ delete a mandaton object
¥ change a mandatony ohiect to be conditional, o vice versa
¥ promote orsplit & repeating recard or group
¥ change the keyfieldion & recard
¥ change the format or datatype of & field
[ change the tipe of & fisldls standard e
¥ link chigcts at different levels
¥ change a conditional relationship
¥ delete an obiect that contains linked objects
¥ delete an ohiect that is used elsewhere
¥ change a singleton group's promate records to parent setting
¥ | delete & codelist
¥ link obizcts with different marimum usages
[ itk ohizcts when destination is sharter than source
kK I Cancel | Help
3 Set the global confirmation options by either selecting the “Confirm
everything” check box (displays all confirmation messages) or by selecting
individual confirmation messages by action performed.
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(Contd)
Sep Action
4 Click OK to save the confirmation options.

System response
The system sets the confirmation options you selected.
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Overview

Building aMap with Application Integration

Overview

Map-building  Thistable provides an overview of the map-building process.

process

Sage

Description

1

Prepare and Analyze

Obtain alayout of your application file and determine how it corresponds
with the EDI standard you are using. Determine how you move data to or
from each application field.

Set Global Defaults (first time only)

Thefirst time you use the Sterling Gentran: Server Application Integration
subsystem, you should establish the default date format that the system
uses. Please see the IBM® Serling Gentran: Server® for Microsoft
Windows User Guide for more information on setting the global date
default.

Create, Save, and Name a New M ap
Please see Creating the Export Map on page 2 - 17 for more information
on creating, saving, and naming a map.

Activate the Appropriate EDI Groups, Segments, and
Elements

Please see Activating EDI Map Components on page 2 - 22 for more
information on activation.

Define your Application File Format
Please see Defining Your Application File Format on page 2 - 27 for more
information on defining your application file format.

Map the Appropriate Data for Each Application Field
Please see Mapping Your Data on page 2 - 54 for more information on
mapping your data.

Compile the Translation Object

Please see How to Compile the Map on page 2 - 108 for more information
on compiling the translation object and trand ation object naming
conventions.

Print the Mapping Report

Validate and review the map, and make modifications as needed. Please
see How to Print the Report on page 2 - 110 for more information on
printing the mapping report.

Application Integration ANSI Tutorial Guide
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(Contd)
Sage Description
9 Register the Translation Object with Sterling

Gentran:Server
Please see the IBM® Serling Gentran: Server® for Microsoft Windows
User Guide for more information on registering translation objects.

10 Create the Appropriate Trading Relationship

Establish the appropriate trading relationship in Sterling Gentran: Server
for your trading partners. Please see the IBM® Serling Gentran: Server®
for Microsoft Windows User Guide for more information on creating
trading relationships. The trading relationship that you will usein this
tutorial (PETZONE) is provided on the tutorial diskettes. You need to
import the partner profile (PETZONE.PAR) into Sterling Gentran: Server,
before you begin thistutorial. Please see the IBM® Serling

Gentran: Server® for Microsoft Windows User Guide for more
information on importing trading relationships.

11 Testing the Translation Object

Obtain test data from your partners and process the data. Verify
acknowledgement processing (if applicable). Verify communicationswith
your network.
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Using the Tutorial

Using the Tutorial

Tutorial basics  For these tutorials, we have provided test data for the translation objects you create. The
following table describes how to locate that test data:

import and import)

Trandlation

Object Type Test Data Name | Default Path L ocation

Inbound (export) PETTSTELINT | CAGENSRVNT\TUTORIAL\PETTEST.INT
Outbound (system | PET_EINV.TXT

C\GENSRVNT\TUTORIAL\PET_810.TXT
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Introduction Inbound Purchase Order (850)

Overview

| ntroduction

Inthischapter  Thistutorial defines the tasks necessary to create amap used to translate ANSI X12
purchase orders (850) that you receive from your trading partner.

This chapter explains all the tasks and processes associated with creating a map for an
inbound purchase order, including the following:

» Mapping analysis

» Creating the new map

» Activating groups, segments, and elements
» Defining your application file format

» Mapping your data

» Finaizing the map
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Getting Sarted

Overview  Thistutorial exerciseis meant to be completed in its entirety. We recommend that you
complete each task sequentially, without referring to the completed map that is provided
with the installation program (although you may want to verify your completed map with
the model).

The purpose of completing each task in thistutorial in sequential order asif it were your

own scenario, isto teach you not only how to perform the individual mapping tasks, but

also to teach you alogical approach and methods that should be utilized when you create
your own map.

Inbound mapping  Make these assumptions in this tutorial exercise:

assumptions and » Your company is MWT Manufacturing Co., which manufactures awide variety of

scenario supplies for pet stores.
» MWT Manufacturing Co. sells pet supplies directly to large pet supply retail chains.

» Pet Zone, alarge pet supply retailer, isthe trading partner sending a purchase order to
your company.

You need to create a map that enables your company to tranglate the purchase orders that
you receive from Pet Zone. Once the purchase orders are trand ated into your application
file format, they can be processed through your Order Processing System, and your
company can ship the goods to Pet Zone.

You have an existing application file layout from your order entry department that defines
the information your system needs to process the order. And, from discussions with the
Pet Zone, you know the data content of the orders that your partner is sending you.

Mapping analysis  Thefirst step in creating amap is the analysis of the mapping requirements. Thisisthe
most important step in creating a successful map. If the analysis you perform is complete,
you have al the information you need to create the map in an efficient and logical manner.
If you omit this critical step and proceed directly to creating the map, it islikely that
creating the map is amuch longer and arduous task, and the map may be invalid due to
oversights and omissions.

This table describes the steps used in mapping analysis. These steps apply to translating
both inbound and outbound data.

Sep Action
1 Analyze your application file format.
2 Analyze your partner’s EDI file format.
3 Correlate your application and the EDI file formats.
4 Begin creating the map.
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Analyzing Your Application File Format

Overview  Thefirst step of mapping analysisis analyzing your application file format, because thisis
probably the component that is the most familiar to you. In this tutorial, your application
file format contains al the information that you need to extract from the purchase order
your partner sends you, so that your system can correctly process the purchase order, and

your company can fill the order correctly.

You must define your application file format to Sterling Gentran:Server. If your company
has an existing application file format, asin this tutorial, you should obtain the record
layout from the appropriate person. If you do not have an existing application file format,
you need to create one by determining which fields are necessary to process the data
correctly, and then grouping the fields logically under records.

Application file  The application file layout for thistutorial is as follows.

layout
Mand Data Min M ax
Field Name (x=Yes) Description Type Length | Length
Header Record (POHEADER) 1 per document

CUSTNUMHDR | X Customer Number | String 1 8

PODATEHDR X Purchase Order Dt/Tm 6 6
Date (MMDDYY)

PONUMHDR X Purchase Order String 1 22
Number

POTYPCODE Purchase Order String 0 2
Type Code

SHIPTONAME Ship To Name String 0 35

SHIPTOADD1 Ship To Address String 0 35
Linel

SHIPTOADD?2 Ship To Address String 0 35
Line2

SHIPTOCITY Ship To City String 0 30

SHIPTOSTATE Ship To State String 0 2

SHIPTOPOSTAL Ship To Postal String 0 9

CODE Code

BILLTONAME Bill To Name String 0 35

Sterling Gentran:Server — May 2011
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(Contd) Mand Data M ax
Field Name (x=Yes) Description Type Length | Length
BILLTOADD1 Bill To Address String 0 35
Linel
BILLTOADD2 Bill To Address String 0 35
Line2
BILLTOCITY Bill To City String 0 30
BILLTOSTATE Bill To State String 0 2
BILLTOPOSTAL Bill To Postal Code | String 0 9
CODE
DELDATE X Délivery Date Dt/Tm 6 6
(MMDDYY)
CANCELDATE X Cancel By Date Dt/Tm 6 6
(MMDDYY)
NUMLINEITEMS | X Number of Line Number 1 6
Items (NO)
PO Detail Group (PODetailGroup) up to 100,000 per document
Detail Record (PODETAIL) 1 per document
CUSTNUMDET X Customer Number | String 1 8
PODATEDET X Purchase Order Dt/Tm 6 6
Date (MMDDYY)
PONUMDET X Purchase Order String 1 22
Number
CUSTPROCODE | X Customer Product String 1 30
Code
UPCCODE X UPC Code String 1 30
UoM Unit of Measure String 0 7
UNITPR Unit Price Number 0 14
(N2)
QTYORD X Quantity Ordered Number 1 9
(NO)
Description Record (PODESC) up to 5 per document
CUSTNUMDESC | X Customer Number | String 1 8

Application Integration ANSI Tutorial Guide
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(Contd) Mand Data Min M ax
Field Name (x=Yes) Description Type Length | Length
PODATEDESC X Purchase Order Dt/Tm 6 6
Date (MMDDYY)
PONUMDESC X Purchase Order String 1 22
Number
DESC Description String 0 80
Allowance/Char ge Record (POALLCHG) up to 10 per document
CUSTNUMAC X Customer Number | String 1 8
PODATEAC X Purchase Order Dt/Tm 6 6
Date (MMDDYY)
PONUMAC X Purchase Order String 1 22
Number
ACIND Allowance or String 0 1
Charge
Indicator
ACMETHAND Allowance or String 0 2
Change
Method of
Handling Code
ACTOTAMT Allowance or Number 0 9
Charge Total (N2)
Amount
Summary Record (POSUMMARY) 1 per document
CUSTNUMSUM X Customer Number | String 1 8
PODATESUM X Purchase Order Dt/Tm 6 6
Date (MMDDYY)
PONUMSUM X Purchase Order String 1 22
Number
NUMLINEITEM X Number of Line Number 1 6
SUM Items (NO)

Application file
definition

The above table contains the minimum information necessary to define your application
fileformat to Sterling Gentran: Server (name, mandatory status, description, datatype, and
field length). Each record contains a group of logically-related application fields. These
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fields contain the information from the EDI file that your system needs to process the
purchase order. The group contains logically-related application records.

Each record contains akey (consisting of three fields) that ensures that the same
identifying information is located at the beginning of each record. Your application
contains arecord key so that each record can be identified individually. The record key for

this purchase order consists of:

»  your partner’s customer number

» the purchase order date
» purchase order number

Record/group  Thistable provides the Record/Group Definitions.
definitions
Record/Group Definition
POHEADER (header) Contains the purchase order type code, shipping and

billing information, delivery and cancel by date
information, and the number of lineitemsin the
purchase order. This header record is mandatory and
occurs once for each purchase order trand ated.

PODetail Group (detail
information)

Contains all the line item information for the order,
including the item, unit of measure, price, quantity
ordered, description, and the allowance and charge
information. Each PODetail Group can occur up to
100,000 times per order translated. This equals a
maximum order of 100,000 items. The information
within the PODetail Group is further segregated by
record.

PODETAIL (detail)

Contains line item code number, unit of measure, price,
and quantity ordered. The PODETAIL record occurs
once per PODetail Group.

PODESC (description)

Contains descriptive information about the line item
ordered. The PODESC record can occur up to fivetimes
per PODetail Group, so multiple descriptive terms can
be used for each item.

Example
If thelineitemisa“dog collar,” the description fields
may be “red,” “large,” and “leather.”

Application Integration ANSI Tutorial Guide
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(Contd)
Recor d/Group Definition
POALLCHG (alowance Contains the allowance or charge indicator, method of
and charge) handling code, and total allowance or charge amount.

The POALLCHG record can occur up to ten times per
PODetail Group, so multiple allowances and/or charges
can be used for each item.

POSUMMARY (summary) | Containsthe total number of line itemsin the purchase
order. The POSUMMARY record occurs once for each
purchase order trandlated.

Next step Now that you have thoroughly analyzed your application file format, the next step isto
determine the requirements of the purchase order that you receive from your partners.
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Analyzing the EDI File

Overview  To analyzethe EDI file, you must first determine what your trading partners are sending
you. You and your partners need to agree on which standard, version, and transaction set
you are using. In thistutorial, we are using the ANSI X 12 standard, version 003030,
transaction set 850 (purchase order). It isimportant to know the information that your
partners are sending you within the purchase order, and what datais contained in each
element used.

It isvery helpful to review the EDI standards that you are using before analyzing the EDI
file. Obtain an EDI standards manual for each standard and version that you are using.
Standards manuals are available from EDI standard agencies.

After discussing with your partners what they are sending, determining which segments

and elements your company requires, and reviewing the EDI standard, you can list the
map components that you need to make available for use (activate).

Map components  Thistablelists the map components that are required for thistutorial, but are not currently

active.
Groups Segment Element
DTM DTMO02
N1 N1 N102
N302
N3 N401
N4 N402
N403
POL1 (aready PO1 PO102
PO104
PO107
PID PID:2 PID:205
ITA:2 ITA:207
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Map components  Note
(contd)  When you activate a conditional group or segment, the mandatory subordinate segments
and elements are automatically activated.

Recommendation

We recommend that you set up aDocument Name for each map, to make the identification
of adocument created by this map easier in Sterling Gentran: Server. This allowsyou to
differentiate between documents in the document browsers in Sterling Gentran: Server.

To set up aDocument Name, you must select an element or field in the map that contains
data that distinguishes the documents translated by this map. Then, the Name field of the
document browsers that contain this document contain the data from the selected element
or field. You can choose any element or field as the Document Name, but we strongly
recommend that you select an element or field that occurs only once in the document and
hasadatatype of “String.” In thistutorial, the document name for the map is the purchase
order number.

After you complete the analysis of the EDI file and your application, the final step in
mapping analysis is correlating the two components.
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Correlating Your Application Fileand the EDI File

Overview

Mapping
operations

To reconcile your application file format with the EDI file, you must identify each
application file with its corresponding element in the EDI file and select a method for
mapping it. To map information to afield, you use linking, standard rules, extended rules,
or acombination of al three.

Linking (simple mapping) enables you to map afield or element from the input side of
the map to afield or element on the output side of the map. The link between two map
components (fields) is visually represented with a line connecting the two fields.

Sandard rules give you access to mapping operation functions that are more complex
than simple linking, but less involved than extended rules.

Extended rules enable you to use a Sterling Gentran: Server proprietary programming
language to perform virtually any mapping operation you require.

Additionally, you may determine that you need to establish temporary storage (work)
areas for the map to handle items such as Ship To and Bill To name and address
information, which is extracted using extended rules from agroup in the EDI data.

Recommendation
We recommend that you determine which mapping operations are required on afield-by-
field basis for your application file.

This table describes the mapping operations (by application field) required for this
tutorial.

Mapping
Field Name Description Operations

Header Record (POHEADER) 1 per document

CUSTNUMHDR | Customer Number Extract Application ID from
Partner record

PODATEHDR Purchase Order Date Link to BEGO5

PONUMHDR Purchase Order Number Link to BEGO3

RECTYPHDR Record Type HDR

POTYPCODE Purchase Order Type Code Link to BEG02

SHIPTONAME Ship To Name Link to N101 using “ST”

(ShipTo) Code

SHIPTOADD1 Ship To Address Line 1 Link to N301 using “ST”
(ShipTo) Code
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(Contd) Mapping
Field Name Description Operations
SHIPTOADD2 Ship To Address Line 2 Link to N302 using “ST”
(ShipTo) Code
SHIPTOCITY Ship To City Link to N401 using “ST”
(ShipTo) Code
SHIPTOSTATE Ship To State Link to N402 using “ST”
(ShipTo) Code
SHIPTOPOSTAL | Ship To Postal Code Link to N403 using “ST”
CODE (ShipTo) Code
BILLTONAME Bill To Name Link to N101 using
“BT"(BillTo) Code
BILLTOADD1 Bill To AddressLine 1 Link to N301 using
“BT”(BillTo) Code
BILLTOADD2 Bill To AddressLine?2 Link to N302 using
“BT”(BillTo) Code
BILLTOCITY Bill To City Link to N401 using
“BT"(BillTo) Code
BILLTOSTATE Bill To State Link to N402 using
“BT"(BillTo) Code
BILLTOPOSTAL | Bill To Postal Code Link to N403 using
CODE “BT”(BillTo) Code
DELDATE Delivery Date Link to DTMO2 using “001"
Code
CANCELDATE Cancel By Date Link to DTMO2 using “002"
Code
NUMLINEITEMS | Number of Line Items Link to CTTO1

Detail Record (PODETAIL) up to 200,000 per document

CUSTNUMDET Customer Number Extract Application ID from
Partner record

PODATEDET Purchase Order Date Extended rule to map from
BEGO05

PONUMDET Purchase Order Number Extended rule to map from
BEGO03

RECTYPDET Record Type DET
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(Contd) Mapping
Field Name Description Operations

CUSTPROCODE | Customer Product Code Link to PO107

UPCCODE UPC Code Extract Partner xref by partner
item from subtable
“PRODCODE"

UOM Unit of Measure Link to PO103

UNITPR Unit Price Link to P0104

QTYORD Quantity Ordered Link to P0102

Description Record (PODESC) up to 5 per document

CUSTNUMDESC | Customer Number Extract Application ID from
Partner record

PODATEDESC Purchase Order Date Extended rule to map from
BEGO05

PONUMDESC Purchase Order Number Extended rule to map from
BEGO3

RECTYPDESC Record Type DES

DESC Description Link to PID:205

Allowance/Charge Record (POALLCHG) up to 5 per document

CUSTNUMAC Customer Number Extract Application ID from
Partner record

PODATEAC Purchase Order Date Extended rule to map from
BEGO05

PONUMAC Purchase Order Number Extended rule to map from
BEGO3

RECTYPAC Record Type AC

ACIND Allowance or Charge Indicator | Link to ITA:201

ACMETHAND Allowance or Change Method | Link to ITA:204

of Handling Code
ACTOTAMT Allowance or Charge Total Link to ITA:207

Amount

Summary Record (POSUMMARY) 1 per document

CUSTNUMSUM

Customer Number

Extract Application ID from
Partner record

Application Integration ANSI Tutorial Guide
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Cross-Reference
tables

(Contd) Mapping
Field Name Description Operations
PODATESUM Purchase Order Date Link to BEGO5
PONUMSUM Purchase Order Number Link to BEGO3
RECTYPSUM Record Type SUM
NUMLINEITEM | Number of Line Items Link to CTTO1
SUM

You must determine whether or not you need to use code tables to convert data for the
map. If you need to use tables, you must decide whether to create a code table in Sterling
Gentran: Server that can only be used with this map, or add the table to either the partner
relationship or the internal system partner in Partner Editor. In this tutorial, you need to
map information from a cross-reference table to translate your partner’s code for a
purchased item and your code for the same item. A cross-reference tableis used when you
and your partner each reference an item by a different name (or number).

Reference
Please see the IBM® Serling Gentran: Server® for Microsoft Windows User Guide for
more information on cross-reference tables.

This table describes the information in the cross-reference table included in this tutorial.

My Value Partner Value Description Reference Data

12345678901234 | 555666411 Large Dog Collar Red

23456789012345 | 555666817 Spring Breeze Cat Litter | 10# Bag

34567890123456 | 555666908 Small Beef Basted Bag of 12

Rawhide Bones
45678901234567 | 555666321 X-Large Food Bowl Black
56789012345678 | 555666287 FatKat Kitty Bed Blue with White Trim

67890123456789 | 555666413 Catnip Mouse Toy

Note
The cross-reference table isincluded in the tutorial data with the PETZONE partner
(PETZONE.PAR)

After you finish correlating your application file format and EDI file on paper, you can
begin creating the map.
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The Export Map

Creating the Export Map

Creating the Export Map

Overview  Thefirgt task in creating anew map is to define the format that is used for the input and
output sides of the map. In this example, you are creating an export map so Sterling
Gentran: Server can translate a purchase order that your partner sends to your application
file. The input side of the map must reflect the ANSI X 12 850 purchase order that you
receive. Instead of defining the 850 document to the system yourself, you want Sterling
Gentran: Server to use the standards database on your system to build the purchase order
according to the standard. The output side of the map must reflect your application file.

Procedure  Usethis procedure to create the export map for the Inbound Purchase Order.

Step

Action

From the File menu, select New.

System response
The system displays the New Map Wizard.

Answer the following questions and then click Next.

» What kind of map are you creating?
Select Export.

» What isthe name of the map?
Type PET_850 as the unique name of the map. The system adds the
.MAP extension.

» Whatisyour name?
Type your nameif it differs from the user name prompted by the
system.

System response
The system displays the New Map Wizard - Input Format dialog box.

Note
You need to complete the format of the Input side of the map. Thisisthe
format of the datathat is translated by the Sterling Gentran:Server system.

From the Create a new data format using this syntax list, select Delimited
EDI and click Customize.

System response
The system displays the New Delimited EDI Wizard.

Click Next.
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Inbound Purchase Order (850)

(Contd)
Sep

Action

5

From the ODBC data source list, select Gentran Sandards (if you
defined your EDI standards data source with another name, select that
name) and click Next.

Select the following:
a.  Select the[X] X12 standards agency,

b. [003030] ANSI X12 VERSION 3 RELEASE 3 version, and
c. [850] PURCHASE ORDER transaction set.

d. Click Next.

Click Finish.

System response
The system loads the selected transaction set and returns to the New Map
Wizard - Input Format dialog box.

Click Next.

System response
The system displays the New Map Wizard - Output Format dialog box.

From the Create a new dataformat using this syntax list, select Positional
and click Next.

System response
The system displays the New Map Wizard.

Click Finish to create the new map (this may take afew seconds).

System response
The system displays the new map in the Application Integration Window.

Note

After you finish creating and saving a new map, you need to define the
Input and Output sides of the map. The steps you take are different,
depending on whether the map is an Import, System Import, Export, or
Turnaround map.
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Creating the Export Map

(Contd)
Sep

Action

9

From the Edit menu, select Details.

System response
The system displays the Translation Object Details dialog box.

- Summary
Authar Drescription Translation Object Function : Uk
|Sterling |PET_&50 |Export 4 re— |

— Flags -
™ System [~ Use Configurable Trimming [ g_ingoa;f;{;géodlyér;de?:gm

—Wersion Cantral

Major version IU Minor version IU

— EDI &szociations

Compiled on I

Irput Clutput
Aigency F I #12 I_ I
Version J003030 | JANSIRT2VERSION ] | |
Transaction  |B50 [PuRCHASE ORDE || | |
Releaze ID_ I—
F Group IF'EI I I I

10

In the Description box, type PET X 3030 850 Export.

11

Complete the Mgjor and Minor boxes to designate a version number for
this translation object. Type“1’ asthe version number in the Major box
and accept the “0” as the release number in the Minor box.

Note

Whenever any major changes are made to your map, increase the version
to the next real number (e.g., 2.0, 3.0). If you make a minor change to the
map, increase the version by a percentage point (e.g., 2.1, 2.2).

12

Click OK to save the trandation object details.
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(Contd)
Sep Action

13 From the File menu, select Save As.

System response
The system displays the Save As dialog box.

Save As HE
Save in: I A Maps j gl
3| Header map Pet_tinv.map
9 Header_t.map Pet_tord.map
9 Pet_810.map

Q] Pet_850.map
9 Pet_eire. map
@ Pet_sord map

File harme: |F'et_850.map

Save as lype: IMaps [*.map) j Cancel |
Help |

14 Verify that the File name box contains pet_850.map.

Note

You allocate afile name to amap when you save the map for the first time
or use the Save As function to save a copy of the map under a different
name. The name of the map must be one to eight unique characters that
define the map in ameaningful way. The default file extensionis“.MAP”.
Using this extension distinguishes map filesfrom other types of files, such
astrand ation objects. The naming conventions in Sterling Gentran: Server
include:

» The source map (map created in Sterling Gentran:Server) should be
named using the file extension .M AP (e.g., HEADER.MAP).

» Thecompiled translation object (translation object that isthe result of
compiling the source map) should be named using the same filename
that was all ocated to the source map, but with the file extension . TPL
(eg., HEADER.TPL).

Recommendation

We recommend that you use these naming conventions to distinguish
source maps and compiled trandlation objects from other types of files. We
also recommend that you use the same file name (different file extension)
for a source map and the translation object that was compiled fromit.

Caution

Be very careful not to overlay the source map with the compiled
translation object. Use the .TPL file extension to distinguish the
translation object.
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Creating the Export Map

(Contd)
Sep

Action

15

Click Save to save the map.

Note

After you complete each section of thistutorial or when you make any
changes to the map, you should save the map by selecting Save from the

File menu.

Next step Now that you’ ve finished creating and saving the new Export map, you need to define the
Input and Output sides of the map.
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Activating EDI Map Components

Overview

This table describes the map components for an EDI File. This table describes the map
components for an EDI File.

Icon Description
= EDI File
' Segment
& Loop (Group)
by Composite Element
) Element

This table describes the map components for a Positional File.

Icon Description
' Positional File

0 Record

G Loop (Group)

") Field

The specific EDI map components that you use depend on the type of map you are
creating, the standard, version, and transaction set (document) selected, and which
segments and elements your company requires. We recommend that you determine which
segments and elements you are using before starting this step.

When Sterling Gentran:Server generates the EDI sides of the map, the system includes all
the groups, segments, composites, and elements that are defined by the standards agency
for the version of the document you selected. The system activates all the groups,
segments, composites, and elements that are defined as “ mandatory” (must be present) by
the standard. The system does not enable you to deactivate the mandatory groups,
segments, composites, and elements. By default, Sterling Gentran: Server displays active
map components with a black font, and inactive map components with a grey (dimmed)
font.
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Overview (contd)  When translating data, the system does not process groups, segments, composites, and
elements (or records and fields) that are not activated. Therefore, you must activate the
groups, segments, composites, and elements that are not defined as mandatory by the
standard, but that you have determined that you need to use in mapping.

Procedure  Usethis procedure to activate the required conditional groups, segments, and elements.

Sep Action
1 Double-click the groups and segments in this table to open them. These
are the groups, subgroups, segments and elements you need to activate.
Opening all the necessary segments and groups before you start to activate
allowsyou to scroll down the map and activate the segments and elements
sequentially.
Groups Segment Element
DTM DTMO02
N1 N1 N102
N3 N302
N4
N401
N402
N403
POL1 (already PO1 PO102
activated)
PO103
PO104
PO107
PID PID:2 PID:205
ITA:2 ITA:207
Note
When you activate a conditional group or segment, the mandatory
subordinate segments and elements are automatically activated.
2 Click the Activate button on the Main Toolbar.
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(Contd)
Sep Action

3 Click each inactive group that you need to use. This activates the groups.
Note
If you accidentally click agroup that you did not mean to activate, click
the group with the right mouse button to access the shortcut menu.

4 Click each inactive segment that you need to use. This activates the
segments.

5 Click each inactive element that you need to use. This activates the
elements.

6 Once you have activated all the necessary groups, segments, and
elements, click the Activate button on the Main Toolbar to turn activation
mode off.

7 From the View menu, select Show Active Only.

Note
This function instructs the system to only display the active map
components.
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Verifying EDI Delimiters

Overview If you are using an EDI standard that contains composite elements or subelements, you
must verify that Sterling Gentran: Server is specifying the correct EDI delimiters.
Delimiters are flags that you define to the system as separating specific EDI components.
Delimiters are necessary for all variable field-length standards, because the datais
compressed (and the leading zeroes and trailing blanks are removed). Since the fields vary
in length, the system needs a flag to determine where one element ends and another
begins. For example, an element delimiter marks the beginning of a new element.

Recommendation

Although verifying EDI delimitersin Sterling Gentran: Server is mandatory only if you are
using a standard with composite elements or subelements (which we are not using in this
tutorial), we recommend that perform this task regardless of which standard you use.

Procedure  Usethis procedure to verify EDI delimiters.

Sep Action

1 Right-click the 850 PURCHASE ORDER EDI fileicon to access the
shortcut menu, and select Properties from the shortcut menu.

System response
The system displays the File Properties dialog box.

2 Select the Delimiters tab.

System response
The system displays the delimiter settings.

File Properties |

Mame Delimiters | Syntax Hecordl Loop Extended Rules |

[ Stieam segments

Tag Delimiter [ SegmentDefmter [
Element Delimiter I"— Sub Element Delimiter l_
Repeating Element Delimiter I—

Release Character I— Decimal Separatar l_

Option

= Default suppression and padding of leading zera on Humerc values

7 Suppress leading zerm on Mumeric B format values (e.q), 025 > 25

= Padiwith leading zero ot Numenc values (2.q., 25> D00025]

ak I Cancel Apply Help
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(Contd)
Sep

Action

3

Verify the required delimitersfor the ANSI X 12 standard. If the delimiters
differ from the default in the table bel ow, type either the character or the
hexadecimal value in the correct box. The default delimiters for ANSI
X12 are the following (the tag delimiter, release character, and decimal
separator are not used for ANS!):

ANSI X12 ANSI X12
Default Default Hex
Box Char acter Value

Tag Delimiter
Element Delimiter * (asterisk) 0x2A
Segment Delimiter ~ (tilde) OX7E
Sub Element Delimiter : (colon) O0x3A
Release Character
Decimal Separator

Click OK to exit the File Properties dialog box.
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Application File Format

Defining Your Application File Format

Overview If either side of your map is positional (fixed-format), you must define your application
file format to Sterling Gentran: Server. In thistutorial, the output side of the map is
positional. Your application file must contain all the information that you need to extract
from your partner’s document, so that your system can accurately process the data.

Before you define your application file format, obtain alayout of the necessary records,
fields, and groups. The records contain related fields and the groups contain related
records. Each map component is arranged sequentially in the order that it is most logical
for the system to process. Therefore, each level of your application file format must be
created sequentially.

For example, your application file format contains records and groups. The records
contain fields and the group contains records. This means that you must create records and
groups before you create the subordinate fields and records.
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Creating the POHEADER Record

Overview  Thefirst record in your application file is generally the header record. The first record is
subordinate to the icon in the application side (output) of the map.

The POHEADER (header) record contains the purchase order type code, shipping and
billing information, delivery and cancel by dateinformation, and the number of line items
in the purchase order. This header record is mandatory and occurs once for each purchase
order trand ated.

Recommendation
We recommend that you include a header record in each application file. The header
record is typically mandatory and repeats only once (not alooping structure).

Procedure  Usethis procedure to create the first application record (POHEADER).

Sep Action

1 Right-click the Positional Fileicon to highlight it (Output for an inbound
map) and select Create Sub\Recor d from the menu.

System Response
The Positional Record Properties dialog box is displayed.

Positional Record Properties [ %]

Hame |Tag | ey Fieldl Special' Loopingl

Flease enter the name :

Fleagze enter a short description :

aK I Cancel | Help |

2 In the Name box, type “POHEADER” as the record identification code.

Caution
Do not use spaces or dashes (-) in the Name box. You can use the
underscore (_) to separate words.
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Creating the POHEADER Record

(Contd)
Sep

Action

3

In the Desc box, type “PO Header Record” as the description of the
record. Thisbox is used to provide a brief explanation of the record that
alows you to differentiate it from similar records.

Select the Tag tab.

In the Tag box, type “HDR” asthe record identification code <TAG>. For
example, arecord is recognized by the system as:

<TAG>[Fi el d_1][Fiel d_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

Recommendation

We recommend that you define the record tag on the Positional Record
Properties dialog box, instead of defining fields with the purpose of
explicitly containing the record tag.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

Select the L ooping tab.
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(Contd)
Sep

Action

8

In the Min Usage box, type “1” to make the header record mandatory.
Thisis the minimum number of times the record must repeat. If you want
the record to repeat (Ioop), type the maximum number of timesit can
repeat in the Max Usage box.

Note
If the Min Usage box contains a0 (zero), the record is conditional. If the
Min Usage box contains a 1 or greater, the record is mandatory.

Recommendation
We recommend that you always accept the default of “1” so it remainsa
record that only occurs once.

Positional Record Properties

Mame | Tag I Key Fieldl Special  Looping |

Min Usage |1 & Nomnal

" Loop Start

Max Uzage |1 ¢~ Loop End

Cancel | Help

Click OK to create the POHEADER record.
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Creating the PODetailGroup

Overview  The PODetail Group (detail information) contains all the line item information for the
order, including the item, unit of measure, price, quantity ordered, description, and the
allowance and charge information. Each PODetail Group can occur up to 100,000 times
per order translated. This equals a maximum order of 100,000 items. The information
within the PODetail Group is further segregated by related records that repeat in sequence
until either the data ends or it reaches the maximum number of times that the loop is
allowed to repeat.

Procedure  Usethis procedure to create the PODetail Group.

Sep Action

1 To create agroup that is at the same level asthe POHEADER record,
highlight the POHEADER and select I nsert from the Edit menu. Select
Group from the submenu.

System Response
The Group Properties dialog box is displayed.

Group Properties [ X]
Narne | Loopingl Loop Extended Hulesl
Flease enter the name :
fi

Fleaze enter a short description :

ak |:I Cancel | Help |

2 In the Name box, type “PODetail Group” to indicate that this group
contains all of the detail records. Thisis the ssgment loop identification
code.

Caution
Do not use spaces or dashes (-) in the Name box. You can use the
underscore (_) to separate words.
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(Contd)
Sep

Action

3

In the Description box, type “PO Detail Group” as the loop description.
Thisbox is used to provide a brief explanation of the loop.

Accept the default of “0” (zero) in the Minimum Usage box. Thisisthe
minimum number of times the loop must be repeated. For a conditional
loop, the minimum usage should always be “0" (zero). For a mandatory
loop, the minimum usage should be “1” or greater.

Select the L ooping tab.

In the Maximum Usage box, type “100000” . Thisindicates that this group
of records can repeat up to 100,000 times.

The Looping tab should now look like this:

Mame Looping I Loop Extended Hulesl

Minimum U sage ID I | Eramote recards boparert
b aximum Uzage |1 00ooa

Cancel Help

Click OK to create the PODetail Group.
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Creating the PODetai

Overview In this tutorial,

Creating the PODetail Group Subordinate Records

|Group Subordinate Records

the PODetail Group contains three subordinate records:

» PODETAIL
» PODESC
» POALLCHG

After you create the first subordinate record (PODETAIL), you can define the subsequent
records at the same level (PODESC and POALLCHG).

Creatingthe  Usethis procedure to create the PODETAIL record.

PODETAIL record

Step

Action

Click the PODetail Group to highlight it and select Create Sub from the
Edit menu. Select Record from the submenu.

System Response
The Positional Record Properties dialog box is displayed.

In the Name box, type “PODETAIL” as the record identification code.

In the Desc box, type “ PO Detail Record” as the description of the record.
Thisbox is used to provide a brief explanation of the record that allows
you to differentiate it from similar records.

Select the Tag tab.

In the Tag box, type “DET” asthe record identification code <TAG>. For
example, arecord is recognized by the system as:

<TAG>[Fi el d_1][Fiel d_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.
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(Contd)
Sep Action
6 In the Position box, accept the default of “1” asthe staring column
position of the tag in the data record.
The Tag tab should now look like this:
Name Tag |Ke_l,J FieIdI Speciall Loopingl
Tag IDET Position I‘I
Cancel | Help
7 Click OK to create the PODETAIL record.
Creatingthe  Usethis procedure to create the PODESC record.
PODESC record
Sep Action
1 Highlight the PODETAIL record. From the Edit menu, select I nsert.

From the submenu, select Record.

System response
The system displays the Positional Record Properties dialog box.

2 In the Name box, type “PODESC” the record identification code.

3 In the Desc box, type “Description Record” as a description of the record.
This box is used to provide a brief explanation of the record that allows
you to differentiate it from similar records.

4 Select the Tag tab.
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(Contd)
Sep

Action

5

In the Tag box, type “DES’ as the record identification code <TAG>. For
example, arecord is recognized by the system as:

<TAG>[ Fiel d_1][Fiel d_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

Select the L ooping tab.

The Looping section of the Positional Record Properties dialog box
enables you to specify the minimum and maximum number of timesthis
record can repeat, and whether arecord is mandatory or conditional. Alter
this section only if the record is alooping structure. Otherwise, accept the
defaults.

Accept the default of “0” in the Min Usage box. Thisis the minimum
amount of times the record must repeat.

In the Max Usage box, type “5” as the maximum amount of times the
record can repeat.

The Looping tab should now ook like this:

Poszitional Record Properties

Marme I Tag I Key Field| Special Looping |Loop Extended Hules'

Wi Usage ID ' Homal

" Loop Start

tax Uzage |5 ¢ Loop End

Cancel Help

Click OK to create the PODESC record.
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Creatingthe  Usethis procedure to create the POALLCHG record:
POALLCHG
record

Sep Action

1 Highlight the PODESC record. From the Edit menu, select Insert. From
the submenu, select Record.

System response
The system displays the Positional Record Properties dialog box.

2 In the Name box, type “POALLCHG” the record identification code.

3 In the Desc box, type “ Allowance/Charge Record” as a description of the
record. Thisbox is used to provide a brief explanation of the record that
allowsyou to differentiate it from similar records.

4 Select the Tag tab.

5 In the Tag box, type“ACG” asthe record identification code <TAG>. For
example, arecord is recognized by the system as:

<TAG>[ Fiel d_1][Fiel d_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

6 In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

7 Select the L ooping tab.
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(Contd)
Sep

Action

8

The Looping section of the Positional Record Properties dialog box
enables you to specify the minimum and maximum number of timesthis
record can repeat, and whether arecord is mandatory or conditional. Alter
this section only if the record is alooping structure. Otherwise, accept the
defaullts.

Accept the default of “0” in the Min Usage box. Thisisthe minimum
amount of times the record must repeat.

In the Max Usage box, type “10" as the maximum amount of times the
record can repeat.

The Positional Record Properties dialog box should now ook like this:

Mame | Tag | Key Field| Special  Looping |Loop Extended Hulesl

T — I—D o Mormal

" Loop Start

tax Usage I‘IEI ¢ Loop End

Cancel | Help

Click OK to create the POALLCHG record.
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Creating the POSUMMARY Record

Overview  Thefinal record you need to create (POSUMMARY) is at the same level asthe
POHEADER record and the PODetail Group.

The POSUMMARY (summary) record contains the total number of lineitemsin the
purchase order. The POSUMMARY record occurs once for each purchase order

trandlated.

Procedure  Usethis procedure to create the POSUMMARY record.

Step

Action

Highlight the PODetail Group. From the Edit menu, select Insert. From
the submenu, select Record.

System response
The system displays the Positional Record Properties dialog box.

Note
Use “Insert” from the Edit menu when you want to create equal records/
groups and use “ Create Sub” to create subordinate groups/records/fields.

In the Name box, type “POSUMMARY” asthe record identification code.

In the Desc box, type “PO Summary Record” as the description of the
record. This box is used to provide a brief explanation of the record that
alowsyou to differentiate it from similar records.

Select the Tag tab.

In the Tag box, type“SUM” asthe record identification code <TAG>. For
example, arecord is recognized by the system as:

<TAG>[Fi el d_1][Fiel d_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

Select the L ooping tab.
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(Contd)
Sep Action

8 Accept the default of “0” in the Min Usage box. Thisisthe minimum
number of times the record must repeat.

Also, accept the default of “1” in the Max Usage box so the summary
record only occurs once (not alooping structure).

The Positional Record Properties dialog box should now look like this:

Poszitional Record Properties

Marme I Tag I Key Field| Special Looping |

Wi Usage ID ' Homal

" Loop Start

tax Uzage |1 ¢ Loop End

Cancel | Help

9 Click OK to create the POSUMMARY record.
The application side of the map (output) should now look like this:

OUTPUT - M - 1
FOHEADER - M - 1 PO Header Record
FPOODetalGroup - C - 100000 PO Detail GroupE
FODETAIL -C - 1 PO Detaill Record
PODESC - C - 5 PO Descrtiption Recaord
POALLCHG - C - 10 Allowance/Charge Record
POSUMMARY -C - 1 PO Summarny Record

Application Integration ANSI Tutorial Guide Sterling Gentran: Server — May 2011




Overview Inbound Purchase Order (850)

Creating the Application Fields

Overview

Introduction Each record you create contains a group of logically-related application fields. These
fields define the structure and content of the data that your system needs to process the
purchase order.

The easiest way to add application fields to arecord isto use the Positional Field Editor.

Generally, you create the fields for the first record in the application file (POHEADER),
and then proceed with each sequential record.

Application fields  This table describes the application fields that you need to create.

Mand Data Min M ax
Field Name (x=Yes) Description Type Length | Length
Header Record (POHEADER) 1 per document
CUSTNUMHDR X Customer Number String 1 8
PODATEHDR X Purchase Order Date Dt/Tm 6 6
(MMDDYY)
PONUMHDR X Purchase Order Number String 1 22
POTYPCODE Purchase Order Type Code String 0 2
SHIPTONAME Ship To Name String 0 35
SHIPTOADD1 Ship To Address Line 1 String 0 35
SHIPTOADD?2 Ship To Address Line 2 String 0 35
SHIPTOCITY Ship To City String 0 30
SHIPTOSTATE Ship To State String 0 2
SHIPTOPOSTAL Ship To Postal Code String 0 9
CODE
BILLTONAME Bill To Name String 0 35
BILLTOADD1 Bill To AddressLine 1 String 0 35
BILLTOADD2 Bill To AddressLine?2 String 0 35
BILLTOCITY Bill To City String 0 30
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(Contd) Mand Data Min M ax
Field Name (x=Yes) Description Type Length | Length

BILLTOSTATE Bill To State String 0 2

BILLTOPOSTAL Bill To Postal Code String 0 9

CODE

DELDATE X Delivery Date Dt/Tm 6 6
(MMDDYY)

CANCELDATE X Cancel By Date Dt/Tm 6 6
(MMDDYY)

NUMLINEITEMS X Number of Line Items Number 1 6
(NO)

PO Detail Group (PODetailGroup) up to 100,000 per document
Detail Record (PODETAIL) 1 per document

CUSTNUMDET X Customer Number String 1 8

PODATEDET X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMDET X Purchase Order Number String 1 22

CUSTPROCODE X Customer Product Code String 1 30

UPCCODE X UPC Code String 1 30

UOM Unit of Measure String 0 7

UNITPR Unit Price Number 0 14
(N2)

QTYORD X Quantity Ordered Number 1 9
(NO)

Description Record (PODESC) up to 5 per document

CUSTNUMDESC X Customer Number String 1 8

PODATEDESC X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMDESC X Purchase Order Number String 1 22

DESC Description String 0 80

Allowance/Char ge Record (POALLCHG) up to 10 per document
CUSTNUMAC X Customer Number String 1 8
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(Contd) Mand Data Min M ax
Field Name (x=Yes) Description Type Length | Length
PODATEAC X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMAC X Purchase Order Number String 1 22

ACIND Allowance or Charge String 0 1
Indicator

ACMETHAND Allowance or Change String 0 2
Method of Handling Code

ACTOTAMT Allowance or Charge Total Number 0 9
Amount (N2)

Summary Record (POSUMMARY) 1 per document

CUSTNUMSUM X Customer Number String 1 8

PODATESUM X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMSUM X Purchase Order Number String 1 22

NUMLINEITEMSUM | X Number of Line Items Number 1 6
(NO)
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How to Create the POHEADER Record Application Fields

Procedure  Usethis procedure to create the application fields for the POHEADER record.

Step

Action

Right-click the POHEADER application record to access the shortcut
menu.

From the Shortcut menu, select Edit Fields to access the Positional Field
Editor dialog box.

oailian: i
rAecod

Mame POHEADER Tap HDA Teo Fos 1

rField D alai Cancs
Mame | I Merdatn

Desclipliml

Dlatal'}pel u Famnal I |i|

StatPos [ | MinLengh [ | Maslengh [0 |

Fiaka

Hare ML Tpe St Legh | LS|

If the field you are creating is the first field in the record, click New. A
highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details section.

In the Name box, type “CUSTNUMHDR”, which is the name of the first
field in the POHEADER record. Each application field must have a
unique name. It is useful to tag the end of the fields that occur in multiple
records with a suffix that identifies the record that containsit. For
example, “HDR” for the Header record.

Select the Mandatory check box to identify it asarequired field. For this
example, the customer number must be present or el se your system cannot
identify who sent the Purchase Order.

In the Description box, type “ Customer Number” as the description of the
box. The description is used to provide a brief explanation of the field that
alows you to differentiate it from similar fields.
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(Contd)
Sep Action

7 From the Data Type list, select “ String” as the type of field to specify that
this field must contain alphanumeric data.

Tip

If you wanted to indicate the exact position of the field in the record, you
would type the starting position of the field in the Start Pos box. You want
to specify field start positionsiif, for example, you are only using afew
fields but you want them positioned exactly in the record.

In thistutorial, you use the aternative to specifying the start position of
each field, which isto add the fields sequentially in the record and then
use the Auto Position function. Please see Step 13 below for more
information on the Auto Position function.

8 If the Data Typeis“Number” or “Dt/Tm,” select the appropriate format
from the Format list.

9 In the Min Length box, type “1” as the minimum field length. If the
minimum length of thefield is“0,” then accept that default in the Min
Length box.

10 In the Max Length box, type “8” as the maximum length of the field.

11 To add thefield and to create the next field positioned after it, press Enter.
A new field with blank values ready for you to identify is positioned
below thefield.

12 Create therest of the fields according to Application fields on page 2 - 40.

Note

If you press ENTER after typing the information for the last field in the
record, ablank field is created. Click Delete and then Yesto delete the
blank field.
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How to Create the POHEADER Record Application Fields

(Contd)
Sep

Action

13

After adding the last field, click Auto Position to automatically position
the fieldsin the record. This automatically calculates the start positionin
the record of each field based on the criteria that each field is positioned
directly after the previousfield and is of the length specified in the Max
Length box. Click Yesto acknowledge the warning message that fields are
sequenced in order.

Caution

Itisonly valid to use the Auto Position function if you define arecord tag
on the Positional Record Properties dialog box, and if you define every
field in the record in the sequence that each field occurs, as you are doing
in thistutorial.

The Positional Field Editor dialog box should now look like the following
(only the last eleven fields in the record are currently visible in the Fields
list):

I'osihanal eld Lditar

-H'SLA.lIJI
-l.',lc-$e
Ham= POHEADER Tan HDA TeaFos 1 -
Cancel I
Fiakd Dalai
Name INIJMLINEITEMS ¥ Mardatn
Dazciplice INu‘nbal of Lira [ tams
DataType [Huwber  [#] Famal [0 2]
Staik Po= |34E I‘r'linLcrdhl'l tlas Lenglh IE
Fiaka —
Name Mi/C_Tupe Stal  Lemgth | i |
SHIFTOSTATE C  Shing wr 2 |+
SHIFTOPOSTALCODE L Sling 173 9
BILLTOMAME T Ehing 128 35
BILLTOAOD C  Sning 23 35 :
BILLTOAD D2 L Sling 258 35
BILLTOCITY C  Shing 293 30
BILLTOSTATE L Sling 323 2
BILLTOPOSTALCODE T Ehing 326 19
DELDATE il DaefTime 334 &
CAMCELDATE M DaeATime 3406 ]
[l _tLI*E ~=h4% b Hom=iz 33 6 5
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When you are finished adding fields to the POHEADER record, click
Close.
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How to Createthe PODETAIL Record Application Fields

Procedure  Complete the following steps to create the application fields for the PODETAIL record.

Step

Action

Right-click the PODETAIL application record to access the shortcut
menu.

From the Shortcut menu, select Edit Fields to access the Positional Field
Editor dialog box.

If the field you are creating is the first field in the record, click New. A
highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details section.

In the Name box, type “CUSTNUMDET”, which is the name of the first
field in the PODETAIL record. Each application field must have a unique
name. It isuseful to tag the end of the fields that occur in multiple records
with a suffix that identifies the record that containsit. For example,
“DET” for the detail record.

Select the Mandatory check box to identify it as arequired field. For this
example, the customer number must be present or el se your system cannot
identify who sent the Purchase Order.

In the Description box, type “ Customer Number” as the description of the
field. The description is used to provide a brief explanation of the field
that allows you to differentiate it from similar fields.

From the Data Type list, select “ String” as the type of the field, to specify
that thisfield must contain a phanumeric data.

If the Data Typeis“Number” or “Dt/Tm,” select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length. If the
minimum length of thefield is“0,” then accept that default in the Min
Length box.

10

In the Max Length box, type “8” as the maximum length of the field.

11

To add thefield and to create the next field positioned after it, press Enter.
A new field with blank values ready for you to identify is positioned
below thefield.
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How to Create the PODETAIL Record Application Fields

(Contd)
Sep

Action

12

Create the rest of the fields according to Application fields on page 2 - 40.

Note

If you press ENTER after typing the information for the last field in the
record, ablank field is created. Click Delete and then Yes to delete the
blank field.

13

After adding the last field, click Auto Position to automatically position
the fieldsin the record. This automatically calculates the start positionin
the record of each field based on the criteria that each field is positioned
directly after the previousfield and is of the length specified in the Max
Length box. Click Yesto acknowledge the warning message that fields are
sequenced in order.

The Positional Field Editor dialog box should now look like the
following:

I"vzitional 1icld Lditor

-HUI.A_ILI
_Uosa
MName FODETAIL Tag OET Tog Fos 1 -
Cancel I
-Fiakd D alai
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Data Tyme INLthI EI Famal INIII |£|
Shak P |121 hr'linL-:rth‘I Hay Lenalh IQ
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Name M Tope St Lemh | Pl |
CUSTHMUMDET M Siing 4 g
PODSTEDET M DasTme 12 6
FOMUMDET L] Eliing 12 22
CUSTPROCODE el Sling 40 30 .
IPCCODE M Sling 04
oM C Sinng RLUUR
LINITFR C Nomec 107 14
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When you are completely finished adding fieldsto the PODETAIL record,
click Close.
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How to Create the PODESC Record Application Fields

Procedure  Usethis procedure to create the application fields for the PODESC record.

Step

Action

Right-click the PODESC application record to access the shortcut menu.

From the Shortcut menu, select Edit Fields to access the Positional Field
Editor dialog box.

If the field you are creating is the first field in the record, click New. A
highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details section.

In the Name box, type “CUSTNUMDESC", which isthe name of the first
field in the PODESC record. Each application field must have a unique
name. It isuseful to tag the end of the fields that occur in multiple records
with a suffix that identifies the record that containsit. For example,
“DESC” for the description record.

Select the Mandatory check box to identify it asarequired field. For this
example, the customer number must be present or el se your system cannot
identify who sent the Purchase Order.

In the Description box, type “ Customer Number” as the description of the
field. The description is used to provide a brief explanation of the field
that allows you to differentiate it from similar fields.

From the Data Type list, select “ String” as the type of the field, to specify
that thisfield must contain a phanumeric data.

If the Data Typeis“Number” or “Dt/Tm,” select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length. If the
minimum length of thefield is“0,” then accept that default in the Min
Length box.

10

In the Max Length box, type “8” as the maximum length of the field.

11

To add thefield and to create the next field positioned after it, press Enter.
A new field with blank values ready for you to identify is positioned
below thefield.

12

Create the rest of the fields according to Application fields on page 2 - 40.

Note

If you press ENTER after typing the information for the last field in the
record, ablank field is created. Click Delete and then Yes to delete the
blank field.
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How to Create the PODESC Record Application Fields

(Contd)
Sep

Action

13

After adding the last field, click Auto Position to automatically position
the fieldsin the record. This automatically calculates the start positionin
the record of each field based on the criteria that each field is positioned
directly after the previousfield and is of the length specified in the Max
Length box. Click Yesto acknowledge the warning message that fields are
sequenced in order.

The Positional Field Editor dialog box should now ook like the

following:

Pusilinnal Field Fililin

-HUIJLILI
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Name PODESC Tag OES Tog Fos 1 -

Cancel I

-Fiakd D alai
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When you are finished adding fiel ds to the PODESC record, click Close.
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How to Createthe POALLCHG Record Application Fields

Procedure  Usethis procedure to create the application fields for the POALLCHG record.

Step

Action

Right-click the POALLCHG application record to access the shortcut
menu.

From the Shortcut menu, select Edit Fields to access the Positional Field
Editor dialog box.

If the field you are creating is the first field in the record, click New. A
highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill the field valuesin the Field Details section.

In the Name box, type “CUSTNUMAC”, which is the name of the first
field in the POALLCHG record. Each application field must have a
unique name. It is useful to tag the end of the fields that occur in multiple
records with a suffix that identifies the record that containsiit. For
example, “AC” for the allowance/charge record.

Select the Mandatory check box to identify it as arequired field. For this
example, the customer number must be present or else your system cannot
identify who sent the Purchase Order.

In the Description box, type “ Customer Number” as the description of the
field. The description is used to provide a brief explanation of the field
that allows you to differentiate it from similar fields.

From the Data Type list, select “ String” asthe type of field, to specify that
this field must contain alphanumeric data.

If the Data Typeis“Number” or “Dt/Tm”, select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length. If the
minimum length of thefield is“0”, then accept the default in the Min
Length box.

10

In the Max Length box, type “8” as the maximum length of the field.

11

To add the field and create the next field positioned after it, pressEnter. A
new field with blank values ready for you to identify is positioned below
the field.
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How to Create the POALLCHG Record Application Fields

(Contd)
Sep

Action

12

Create the rest of the fields according to Application fields on page 2 - 40.

Note

If you press ENTER after typing the information for the last field in the
record, ablank field is created. Click Delete and then Yes to delete the
blank field.

13

After adding the last field, click Auto Position to automatically position
the fieldsin the record. This automatically calculates the start positionin
the record of each field based on the criteria that each field is positioned
directly after the previousfield and is of the length specified in the Max
Length box. Click Yesto acknowledge the warning message that fields are
sequenced in order.

The Positional Field Editor dialog box should now look like the
following:

Piositiral Fielal Tilil
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Cancel I
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When you are completely finished adding fields to the POALLCHG
record, click Close.
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How to Createthe POSUMM ARY Record Application Fields

Procedure  Usethis procedure to create the application fields for the POSUMMARY record.

Sep Action
1 Right-click the POSUMMARY application record to access the shortcut
menu.
2 From the Shortcut menu, select Edit fields to access the Positional Field
Editor dialog box.
3 If the field you are creating is the first field in the record, click New. A

highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details section.

4 In the Name box, type “CUSTNUMSUM”, which is the name of the first
field in the POSUMMARY record. Each application field must have a
unique name. It is useful to tag the end of the fields that occur in multiple
records with a suffix that identifies the record that containsit. For
example, “SUM” for the summary record.

5 Select the Mandatory check box to identify it asarequired field. For this
example, the customer number must be present or el se your system cannot
identify who sent the Purchase Order.

6 In the Description box, type “ Customer Number” as the description of the
field. The description is used to provide a brief explanation of the field
that allows you to differentiate it from similar fields.

7 From the Data Typelist, select “ String” asthe type of field, to specify that
this field must contain alphanumeric data.

8 If the Data Typeis“Number” or “Dt/Tm”, select the appropriate format
from the Format list.

9 In the Min Length box, type “1” as the minimum field length. If the
minimum length of thefield is“0”, then accept that default in the Min
Length box.

10 In the max Length box, type “8” as the maximum length of the field.
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(Contd)
Sep

Action

11

To add thefield and to create the next field positioned after it, press Enter.
A new field with blank values ready for you to identify is positioned
below thefield.

Note

If you press ENTER after typing the information for the last field in the
record, ablank field is created. Click Delete and then Yes to delete the
blank field.

12

Create the rest of the fields according to Application fields on page 2 - 40.

13

After adding the last field, click Auto Position to automatically position
the fieldsin the record. This automatically calcul ates the start position in
the record of each field based on the criteria that each field is positioned
directly after the previousfield and is of the length specified in the Max
Length box. Click Yesto acknowledge the warning message that fields are
sequenced in order.

The Positional Field Editor dialog box should now look like the
following:
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When you are finished adding fields to the POSUMMARY record, click
Close.

Next step  After defining your application file format to Sterling Gentran: Server, you must map the
necessary datafrom the EDI file to your application fields.
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Inbound Purchase Order (850)

Mapping Your Data

Overview

Introduction

Each record contains a group of logically-related application fields. These fields contain
the information from the EDI file that your system needs to process the purchase order.
The group contains logically-related application records.

Each record contains a three-field record key that ensures that the same identifying
information is located at the beginning of each record. Your application file format
contains arecord key so that each record can be identified individually. The record key for
this purchase order consists of:

» your partner’s customer number
» purchase order date
» purchase order number

This section examines each application field sequentially and describes the mapping
operations that you need to perform to map the appropriate data into each field.
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Mapping the POHEADER Record

Overview

Introduction This section describes the actions necessary for you to map to each field in the
POHEADER (header) record. The POHEADER record contains:

» purchase order type code

» shipping and billing information

» delivery information

» cancel by date information

» the number of lineitemsin the purchase order

This header record is mandatory and occurs once for each purchase order trand ated.
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CUSTNUMHDR Field

Overview

Mapping the
customer number

The Application Integration subsystem allows you to use selected information from the
Sterling Gentran:Server Partner database in your maps via a standard rule. You can map
information from your trading partner's profile in the Partner Editor to a selected element
or field in the map. The information that you can use in the map includes any field in a
table (location, lookup, or cross-reference) or data from the partner record.

For this map, you need to pull information from the partner definition to populate the
Customer Number fields on the application side of the map. Since the Customer Number
isapart of the record key for each record, it appears five timesin the application file
format, once in each record (CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC,
CUSTNUMAC, and CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in the application
file format. It identifies which trading partner sent the purchase order. This customer
number is already part of the partner definition for this partner, so you can map it from the
partner definition to each customer number field.

Use this procedure to map the customer number from the document record.

Sep Action
1 Double-click the CUSTNUMHDR field in the POHEADER record to
display the Field Properties dialog box.
2 Select the Sandard Rule tab.
3 From the select standard rule list, choose Select.
4 From the Table and Key list, select “Document record.” This indicates

that the system updates this field with selected information from the
document record.

5 Select the check box to indicate that a compliance error should be
generated if the select does not find avalid entry.

6 From the Map From list on the left, select “Partner Key.” Thisisthefield
that contains the customer number for this partner.
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CUSTNUMHDR Field

(Contd)
Sep

Action

7

From the Map To list on theright, select “CUSTNUMHDR.” Thisisthe
field to which the information from the Partner Editor is mapped.

The Standard Rule tab of the Field Properties dialog box should now look
like this:

Field Properties

Mame I Validationl F'l:usitic-nl Extended Rule  Standard Rule |E0nditinns|

Fleasze select the standard rule to uge : ISelect j

Fleaze chooze the table and key [or group] to uge when selecting data
ID-:u::umenl record ﬂ

Elease ententhie name of thesub:-table o vse (i appreprnate]

¥ FRaise a compliance ermor if matching data iz not found

Y'ou can map the data that was selected. Click on data in the left ist then click the
fieldz in the right lizt that wou would like it to be mapped to. Repeat to map more data.

Application Field 1 ;I CUSTHUMHODRE Customer Mumber
Application Figld 2 PODATEHDR Purchasze Order Date
Application Field 3 FOMUMHDR Purchaze Order Humb
Application Field 4 FOTYPCODE Puchasze Order Type
Application Figld 5 SHIFTOMAKME Ship To Name
Application Field & SHIPTOADD Ship To Address Line
SHIFTOADDZ Ship To Address Line
Contral Mumber - SHIFTOCITY Ship To City ;I

Cancel | Help |

Click OK to add the standard rule to the CUSTNUMHDR field.
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PODATEHDR Field

Inbound Purchase Order (850)

Overview  You can map the PODATEHDR field directly from the BEGO5 (Purchase Order Date)
field, by using the Link function. The Link function allows you to map afield or element
from the Input side of the map to afield or element on the Output side of the map. Thelink
between the two fieldsis visually represented with a line connecting the two fields.

Procedure  Usethis procedure to map the purchase order date.

Step

Action

1

If the Linking function is not currently active, click the Link button on the
Main Toolbar to turn on the Linking function.

Click the BEGO5 element in the BEG record. When you click the element,
the cursor changesto a“Link Arrow”: | |k

Click the application field PODATEHDR in the POHEADER record.

A lineisdisplayed, visually illustrating the link between the BEG05
element and the PODATEHDR field.
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PONUMHDR Field

Overview

Procedure

Setting up the
document name

You can map the PONUMHDR field directly from the BEGO03 (Purchase Order Number)
field, by using the Link function. The Link function allows you to map afield or element
from the Input side of the map to afield or element on the Output side of the map. Thelink
between the two fieldsis visually represented with a line connecting the two fields.

Also, we recommend that you set up a Document Name for each map, to make the
identification of a document created by this map easier in Sterling Gentran:Server. This
allows you to differentiate between documents in the document browsersin Sterling
Gentran: Server.

To set up a Document Name, you must select an element or field in the map that contains
data that distinguishes the documents translated by this map. Then, the Name field of the
document browsers that contain this document contains the data from the selected element
or field.

Recommendation

You can choose any element or field as the Document Name, but we strongly recommend
that you select an element or field that occurs only once in the document and has a data
type of “String.” For a Purchase Order, the document nameistypically the Purchase Order
Number.

Use this procedure to map the purchase order number.

Sep Action

1 If the Linking functionis not currently active, click the Link button on the
Main Toolbar to turn on the Linking function.

2 Click the BEG03 element in the BEG record. When you click the element,
the cursor changesto a“Link Arrow”: | |re

3 Click the application field PONUMHDR in the POHEADER record.

4 A lineisdisplayed, visually illustrating the link between the BEG03
element and the PONUMHDR field.

Use this procedure to set up the Document Name for this Purchase Order.

Sep Action
1 Double-click the BEG03 (0324) element to display the Element Properties
dialog box.
2 Select the Sandard Rule tab.
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Sep Action
3 From the standard rule list, select Update.
4 From the Table list, choose “Document record.” This indicates that you

are updating the document record in Sterling Gentran: Server.

5 From the columnslist, choose “ Document Name.” Thisindicates that you
are updating the Name field in the document browsers with the contents of
this element.

The Standard Rule tab of the Element Properties dialog box should now
look like this:

Element Properties E3

Mame I Validatinnl Extended Rule  Standard Rule |E0nditinns|

Please zelect the standard rule bo uze IUpdate j

Please zelect the table [or group] to update
IDDcument record j

Pleaze zelect the column [or field] to update :
IDocument M ame j

Cancel Help

6 Click OK to set up the document name.
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POTYPCODE Field

Overview  You can map the POTYPCODE field directly from the BEGO2 (Purchase Order Type
Code) field, by using the Link function. The Link function alows you to map afield or
element from the Input side of the map to afield or element on the Output side of the map.
The link between the two fieldsis visually represented with aline connecting the two

fields.

Procedure  Complete the following steps to map the purchase order type code:

Step

Action

1

If the Linking function is not currently active, click the Link button on the
Main Toolbar to turn on the Linking function.

Click the BEG02 element in the BEG record. When you click the element,

the cursor changesto a“Link Arrow”:

LIk,

Click the application field POTY PCODE in the POHEADER record.

A lineisdisplayed, visually illustrating the link between the BEG02

element and the POTY PCODE field.

Application Integration ANSI Tutorial Guide
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Mapping Shipping and Billing Information

Overview

Introduction

Temporary storage
segments and
elements

On the EDI side of the map, the name and address information is contained in a series of
segments that are logically grouped in the N1 group. The N1 group contains shipping and
billing name and address information, and repeats multiple times. If the Entity Identifier
Code (inthe N1 segment) is“ST,” that iteration of the N1 group contains shipping
information. You need to map the shipping information to the Ship To fieldsin the
application header record. If the Entity Identifier Codeis“BT,” that iteration of the N1
group contains billing information. You need to map the hilling information to the Bill To
fieldsin the application header record.

However, to map the correct information (e.g., either bill to or ship to) from the N1 group
to the Bill To and Ship To fieldsin the application header record, you must extract the
billing and the shipping information after determining the type. Also, you have
determined that your partner only sends you one N3 segment (address information), so
you must change the maximum usage allowed for that segment.

To map the shipping and billing information to your application file format, you need to
create temporary storage segments and elements on the EDI side of the map that do not
repeat. You can use an extended rule to extract the shipping and billing information from
the N1 group and move it to the appropriate temporary storage elements. Then, you can
map the shipping and billing information directly from the temporary storage elements to
your application fields.
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Temporary Sorage Segments

Overview  Thistableliststhe temporary storage segments that you are creating.

Min M ax
Name Desc Tag Usage Usage
BillToDet Bill To Details 5% 0 1
ShipToDet Ship To Details 555 0 1

How to createthe  Usethis procedure to create the ShipToDet temporary storage segment.

ShipToDet

segment Step

Action

1

Highlight the N1 group. The two temporary storage segments are located
after the N1 group, at the same level.

From the Edit menu, select I nsert. From the submenu, select Segment.
The EDI Segment Properties dialog box is displayed.

In the Name box, type “ ShipToDet”.

In the Description box, type “ Ship To Details’.

Select the Tag tab.

In the Tag box, type “ $$$”. The system does not read a segment with a
value of “$$3$” in the Tag box. Therefore, it does not flag this temporary
storage segment as an error during compliance checking.

Click OK to create the ShipToDet temporary storage segment.

Application Integration ANSI Tutorial Guide

Sterling Gentran: Server — May 2011



Temporary Storage Segments Inbound Purchase Order (850)

How to createthe  Usethis procedure to create the Bill ToDet temporary storage segment.
BillToDet segment

Sep Action

1 Highlight the ShipToDet segment.

2 From the Edit menu, select I nsert. From the submenu, select Segment.

3 In the Name box, type “Bill ToDet”.

4 In the Description box, type “Bill To Details’.

5 Select the Tag tab.

6 In the Tag box, type “ $$$”. The system does not read a segment with a
value of “$$$” in the Tag box. Therefore, it does not flag this temporary
storage segment as an error during compliance checking.

7 Click OK to create the Bill ToDet temporary storage segment.
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Temporary Storage Elements

Overview

How to create the
ShipToDet
elements

Application Integration ANSI Tutorial Guide

Now, you can add elements to the temporary storage segments you just created. Thistable
lists the temporary storage elements.

M ax
EDI Segment EDI Element Length

ShipToDet SHIPTONAME 35
SHIPTOADDR1 35
SHIPTOADDR2 35
SHIPTOCITY 30
SHIPTOSTATE 2
SHIPTOPCODE 9

Bill ToDet BILLTONAME 35
BILLTOADDR1 35
BILLTOADDR2 35
BILLTOCITY 30
BILLTOSTATE 2
BILLTOPCODE 9

Use this procedure to create the ShipToDet elements.

Sep Action

1 Highlight the ShipToDet segment. From the Edit menu, select Create Sub
to create a subordinate element.

2 From the submenu, select Element. The Element Properties dialog box is
displayed so you can define the characteristics of the new element.

3 In the Name box, type “SHIPTONAME”.

4 Select the Validation tab.

5 In the Maximum box, type “35" as the maximum length.

6 Click OK to create the SHIFTONAME element.

7 Now you can create the remaining Ship To elements. With the
SHIPTONAME element highlighted, select I nsert from the Edit menu.
From the submenu, select Element to display the Element Properties
dialog box.

8 Repeat Steps 3 through 7 to complete the remaining ShipToDet elements

listed in the table above.
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How to createthe  Usethis procedure to create the Bill ToDet €l ements.
BillToDet elements

Sep Action

1 Highlight the Bill ToDet segment. From the Edit menu, select Create Sub
to create a subordinate element.

2 From the submenu, select Element. The Element Properties dialog box is
displayed so you can define the characteristics of the new element.

3 In the Name box, type “BILLTONAME”.

4 Select the Validation tab.

5 In the Maximum box, type “35” as the maximum length.

6 Click OK to create the BILLTONAME element.

7 Now you can create the remaining Bill To elements. With the

BILLTONAME element highlighted, select I nsert from the Edit menu.
From the submenu, select Element to display the Element Properties
dialog box.

8 Repeat Steps 3 through 7 to complete the remaining Bill To elements
listed in the table above.
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Changing the Max Use of the N3 Segment

Overview

Procedure

Using an extended
rule

How to create an
extended rule

Application Integration ANSI Tutorial Guide

You have determined that your partner only sends you one N3 segment (address
information), so you must change the maximum usage allowed for that segment.

Use this procedure to make N3 a non repeating segment.

Sep Action

1 Right-click the N3 segment (in the N1 group) to access the shortcut menu.

2 From the shortcut menu, select Properties to access the EDI Segment
Properties dialog box.

3 Select the L ooping tab.

4 In the Max Usage box, type“1” to make N3 anon repeating segment. This
box is currently setto “2.”

5 Click OK to accept the change to the N3 segment.

Now you can use an extended rule to extract the shipping and billing information from the
N1 group and move it to the appropriate temporary storage elements. The extended rule
should be executed after the system reads an occurrence of the N1 group.

Use this procedure to create the extended rule.

Sep Action
1 Right-click the N1 group to access the shortcut menu.
2 From the shortcut menu, select Extended Rules to display the Group
Properties dialog box.
3 Select the On End option. This specifies that the rule is executed when

the loop terminates. The system loads an occurrence of the N1 group
(containing the billing or shipping information), and then executes this
rule.
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(Contd)
Sep

Action

4

In the Editor list, type the following:

I F #0098 = “BT” THEN

BEG N
$850. #BI LLTONAME = #0093;
$850. #BI LLTOADDR1 = #0166;
$850. #Bl LLTOADDR2 #0166: 2;
$850. #BI LLTOCI TY = #0019;

$850. #Bl LLTOSTATE = #0156;
$850. #BI LLTOPCODE = #0116;
END
I F #0098 = “ST" THEN
BEG N
$850. #SH PTONAME = #0093;
$850. #SH PTOADDR1 = #0166;
$850. #SH PTOADDR2 = #0166: 2;

$850. #SHI PTOCI TY = #0019;

$850. #SHI PTOSTATE = #0156;
$850. #SH PTOPCCDE = #0116;
END
Note

If asegment/record or element/field occurs more than onceinamap, itis
identified by its name <ID>. The second and subsequent occurrences are
identified by <ID>:n, where ‘n’ is the number of occurrences in the map.

Click Compileto validate the syntax of the extended rule. Every rulein
the map is compiled when you compile the translation object, after you
complete the map. However, the system allows you to compile each rule
individually, so that you can verify the accuracy of the rule after you
create it.

Note

This compiles the rule interactively, and allows you to correct any errors
that are generated. Any errors or warnings generated in the compilation
process are displayed in the Errorslist.

Click OK to add the extended rule to the N1 group.
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How to Map the Ship To Name I nfor mation

Overview  After creating the temporary storage segments and elements and adding the extended rule,
you can map the shipping and billing information directly from the temporary storage
elements to your application fields.

Procedure  Usethis procedure to map the Ship To Name.
Sep Action
1 If the Linking function is not currently active, click the Link button on the
Main Toolbar to turn on the Linking function.
2 Click the SHIPTONAME element in the ShipToDet temporary storage
segment. When you click the element, the cursor changesto a*“Link
Arrow.”
LIk,
3 Click the application field SHIPTONAME in the POHEADER record.
4 A lineisdisplayed, visualy illustrating the link between the
SHIPTONAME element and the SHIPTONAME application field.
Mapping other  Thistablelists the application fields in the POHEADER record and the elements they are
application fields ~ mapped to.
and elements
To map POHEADER field You need to link
SHIPTOADD1 the SHIPTOADDRL1 element in the ShipToDet
temporary storage segment to the application field
SHIPTOADD1 in the POHEADER record.
SHIPTOADD2 the SHIPTOADDR2 element in the ShipToDet
temporary storage segment to the application field
SHIPTOADD? in the POHEADER record.
SHIPTOCITY the SHIPTOCITY element in the ShipToDet temporary
storage segment to the application field SHIPTOCITY
in the POHEADER record.
SHIPTOSTATE the SHIPTOSTATE element in the ShipToDet
temporary storage segment to the application field
SHIPTOSTATE in the POHEADER record.
SHIPTPCODE the SHIPTOPCODE element in the ShipToDet
temporary storage segment to the application field
SHIPTOPOSTALCODE in the POHEADER record.

Application Integration ANSI Tutorial Guide
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(Contd)
To map POHEADER field

You need to link

BILLTONAME

the BILLTONAME element in the Bill ToDet temporary
storage segment to the application field BILLTONAME
in the POHEADER record.

BILLTOADD1

the BILLTOADDR1 element in the Bill ToDet
temporary storage segment to the application field
BILLTOADD1 in the POHEADER record.

BILLTOADD2

the BILLTOADDR?2 element in the Bill ToDet
temporary storage segment to the application field
BILLTOADD2 in the POHEADER record.

BILLTOCITY

the BILLTOCITY element in the Bill ToDet temporary
storage segment to the application field BILLTOCITY
in the POHEADER record.

BILLTOSTATE

the BILLTOSTATE element in the Bill ToDet temporary
storage segment to the application field BILLTOSTATE
in the POHEADER record.

BILLTOPCODE

the BILLTOPCODE element in the Bill ToDet
temporary storage segment to the application field
BILLTOPOSTALCODE in the POHEADER record.

Sterling Gentran:Server — May 2011
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Mapping Date Segments and Elements

Overview

Introduction

Temporary storage
segments and
elements

The DTM segment contains all the date information for the purchase order, and repeats
multiple times. If the Date/Time Qualifier (inthe DTM segment) is“001,” that iteration of
the DTM segment contains Delivery Date information. You need to map the delivery
information to the DELDATE field in the application header record. If the Date/Time
Qualifier is“002, that iteration of the DTM segment contains Cancel By Date information.
You need to map the cancel by date information to the CANCELDATE field in the
application header record.

However, you do not know the order in which these dates appear in the EDI data.
Therefore, to map the delivery and cancel by date information to your application file, you
need to create atemporary storage segment and elements on the EDI side of the map. You
can use an extended rule to extract the delivery and cancel by date information from the
DTM segment and move it to the appropriate temporary storage elements. Then, you can
map the delivery and cancel by date information directly from the temporary storage
elements to your application fields.

Application Integration ANSI Tutorial Guide Sterling Gentran: Server — May 2011



How to Create a Temporary Storage Date Segment Inbound Purchase Order (850)

How to Create a Temporary Storage Date Segment

Procedure  Usethis procedure to create the TEMPDATES temporary storage segment.

Sep Action

1 Highlight the DTM segment. The temporary storage segment is located
after the DTM segment, at the same level.

2 From the Edit menu, select I nsert. From the submenu, select Segment.

System response
The EDI Segment Properties dialog box is displayed.

3 In the Name box, type “TEMPDATES".

4 In the Description box, type “ Temporary Storage Dates’.

5 Select the Tag tab.

6 In the Tag box, type “ $$$”. The system does not read a segment with a

value of “$$$” in the Tag box. Therefore, it does not flag this temporary
storage segment as an error during compliance checking.

7 Click OK to create the TEMPDATES temporary storage segment.
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How to Create a Temporary Sorage Date Element

Creatingthe  Usethisprocedure to create the TEM PDATES elements in the temporary storage segment
TEMPDATES  youjust created.

element

Sep Action

1 Highlight the TEMPDATES segment. From the Edit menu, select Create
Sub to create a subordinate element.

2 From the submenu, select Element. The Element Properties dialog box is
displayed and is used to define the characteristics of the new element.

3 In the Name box, type “DELDATE”.

4 In the Description box, type “Delivery Date”.

5 Select the Validation tab.

6 In the Minimum box, type “6” as the minimum length.

7 In the Maximum box, type “6” as the maximum length.

8 From the Typelit, select Date/Time. Thisindicates that thisis a date/time
element. The system may prompt you with a message that changing the
field’s date type will invalidate its format. Click Yesto acknowledge this
message and proceed.

Note

To turn off the message prompt, select Preferences from the Options
menu. Select the Confirmations tab and clear the “ Confirm everything”
check box. From the “ Confirm when I” list, clear the “ Change format or
datatype of afield” check box. Click OK to save.

9 From the Format list, select “YYMMDD,” to indicate that the first two
digits contain the year, the second two digits contain the month, and the
last two digits contain the day.

10 Click OK to create the DELDATE element.

11 Create the CANCELDATE element. Highlight the DELDATE element
and select Insert from the Edit menu. From the submenu, select Element
to display the Element Properties dialog box.

12 In the Name box, type “CANCELDATE".

13 In the Description box, type “Cancel By Date”.

14 Select the Validation tab.

15 In the Minimum box, type “6” as the minimum length.

Application Integration ANSI Tutorial Guide
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(Contd)
Sep Action

16 In the Maximum box, type “6” as the maximum length.

17 From the Typelist, select Date/Time. Thisindicatesthat thisisadate/time
element.

18 From the Format list, select “YYMMDD,” to indicate that the first two
digits contain the year, the second two digits contain the month, and the
last two digits contain the day.

19 Click OK to create the CANCELDATE element.

Using an extended  Use an extended rule to extract the delivery and cancel by date information from the DTM
rule  segment and move it to the appropriate temporary storage elements. The extended rule
should be executed after the system reads the DTMO1 (Date/Time Qualifier).

Use this procedure to create the extended rule.

Sep Action

1 Double-click the DTMO01 element to access the Element Properties dialog
box.

2 Select the Extended Rule tab.

3 In the Rulelist, type the following:

I F #0374: 6=" 002" THEN
BEG N

$850. #DELDATE=#0373: 6;
END
I F #0374: 6="001" THEN
BEG N

$850. #CANCELDATE=#0373: 6;
END

The system loads the DTM 02 element (containing the delivery and cancel
by date information), and then executes this rule.

4 Click Compileto validate the syntax of the extended rule. Every rulein
the map is compiled when you compile the translation object, after you
complete the map. However, the system allows you to compile each rule
individually, so that you can verify the accuracy of the rule after you
createit.

5 Click OK to add the extended rule to the DTMO1 element.
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How to Map the Delivery Date Information

Overview  After creating the temporary storage segment and elements and adding the extended rule,
you can map the delivery and cancel by date information directly from the temporary
storage elements to your application fields.

Map DELDATE  To map the delivery date, link the DELDATE element in the TEMPDATES temporary
storage segment to the application field DELDATE in the POHEADER record.

Map  To map the cancel by date, link the CANCELDATE element in the TEMPDATES
CANCELDATE temporary storage segment to the application field CANCELDATE in the POHEADER
record.

Map You can map the NUMLINEITEMS field directly from the CTTO1 (Number of Line
NUMLINEITEMS  Items) element, by using the Link function to link the CTTO1 element in the CTT segment
to the application field NUMLINEITEMS in the POHEADER record.
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Mapping the PODetail Group Records: PODETAIL Record

Overview

Introduction The PODetailGroup (detail information) contains al the line item information for the
order, including the item, unit of measure, price, quantity ordered, description, and the
allowance and charge information. Each PODetail Group can occur up to 100,000 times
per order trandated. This equals a maximum order of 100,000 items. The information
within the PODetail Group is further segregated by record:

» PODETAIL
» PODESC
» POALLCHG

This section describes the actions necessary for you to map to each field in the

PODETAIL (detail) record. The PODETAIL (detail) record contains line item code
number, unit of measure, price, and quantity ordered. The PODETAIL record occurs once
per PODetail Group.
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CUSTNUMDET Field

Overview  The Application Integration subsystem allows you to use selected information from the
Sterling Gentran: Server Partner Editor in your maps via a standard rule. You can map
information from your trading partner's profile in the Partner Editor to a selected element
or field in the map. The information that you can use in the map includes any fieldin a
table (location, lookup, or cross-reference) or data from the partner key.

For this map, you need to pull information from the partner definition to populate the
Customer Number fields on the application side of the map. Since the Customer Number
isapart of the record key for each record, it appears five timesin the application, once in
each record (CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC, CUSTNUMAC, and
CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in the
application. It identifies which trading partner sent the purchase order. This customer
number is already part of the partner definition for this partner, so you can map it from the
partner definition to each customer number field.

Procedure  Usethis procedure to map the customer number from the partner definition.

Sep Action
1 Double-click the CUSTNUMDET field (in the PODETAIL record) to
display the Field Properties dialog box.
2 Select the Sandard Rule tab.
3 From the standard rule list, choose Select.
4 From the Table and Key list, select “Document record.” This indicates

that the system updates this field with the selected information from the
document record.

5 Select the check box to indicate that a compliance error should be
generated if the select does not find avalid entry.

6 From the Map From list on the left, select “Partner Key.” Thisisthefield
that contains the customer number for this partner.
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(Contd)
Sep

Action

7

From the Map To list on the right, select “CUSTNUMDET.” Thisisthe
field to which the information from the Partner Editor is mapped.

The Standard Rule tab on the Field Properties dialog box should now ook
like this:

Field Properties E

Mame | Validation | Position | Extended Rule  Standard Rule | Conditions |

Pleaze select the standard rule to uge : ISeIect j

Flease choose the table and key [or group] to use when selecting data :
IDocument record j
Hleaze enter the name of the subtable to use (i apprapnate] :

¥ Raise a compliance eror if matching data is nat found

'ou can map the data that wasz zelected. Click on data in the left list then click the
fieldz in the right lizt that vou would like it to be mapped to. Repeat to map more data.

Application Field 1 ;l CUSTMUMDET Custorer Mumber
Application Field 2 PODATEDET Purchase Order Date
Application Field 3 POMUMODET Purchase Order Number
Application Field 4 CUSTPROCODE Customer Product Coc
Application Field 5 UPCCODE UPC Code
Application Field B J0OM Uit of Measure

UMITPR Unit Price
Cantral Nurmber hd ATvORD Quantity Ordered

Cancel | Help |

Click OK to add the standard rule to the CUSTNUMDET field.
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PODATEDET Field

Overview  The BEGO5 (Purchase Order Date) element contains the date of the purchase order. The
BEG segment does not repeat. You need to map the information from the BEGO5 element
to the PODATEDET field. However, the PODATEDET field isincluded in the
PODetail Group, which repeats 100,000 times.

You can only map fields and elements that are at the same level. This means that you
cannot map to a group from a segment that does not repeat. For example, you cannot map
the purchase order date in the BEG segment directly to your application PODATEDET
field.

Using an extended  To map the purchase order date to this application field, you need to use an extended rule
rule toextract the purchase order date from the BEGO5 element and moveiit to the
PODATEDET field.

Use this procedure to create the extended rule.

Sep Action
1 Double-click the PODATEDET field to access the Field Properties dialog
box.
2 Select the Extended Ruletab.
3 In the Rulelist, type the following:

#PODATEDET=$850. #0323;

The “$850.#0323" is the addressing for the BEGO5 element. The system
executes this rule when it processes the PODATEDET field.

4 Click Compile to validate the syntax of the extended rule.

5 Click OK to add the extended rule to the PODATEDET field.
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PONUMDET Field

Overview  The BEGO3 (Purchase Order Number) element contains the purchase order number. The
BEG segment does not repeat. You need to map the information from the BEGO3 el ement
to the PONUMDET field. However, the PONUMDET field isincluded in the
PODetail Group, which repeats 100,000 times.

You can only map fields and elements that are at the same level. This means that you
cannot map to a group from a segment that does not repeat. For example, you cannot map
the purchase order number in the BEG segment directly to your application PONUMDET
field.

Using an extended  To map the purchase order number to this application field, you need to use an extended
rule ruleto extract the purchase order number from the BEG03 element and move it to the
PONUMDET field.

Use this procedure to create the extended rule.

Sep Action
1 Double-click the PONUMDET field to access the Field Properties dialog
box.
2 Select the Extended Ruletab.
3 In the Rulelist, type the following:

#PONUVDET=$850. #0324;

The “$850.#0324" is the addressing for the BEGO3 element. The system
executes this rule when it processes the PONUMDET field.

4 Click Compile to validate the syntax of the extended rule.

5 Click OK to add the extended rule to the PONUMDET field.
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CUSTPROCODE/UPCCODE Fi€ds

Overview  The Application Integration subsystem enables you to use selected information from the
Sterling Gentran: Server partner database in your maps via a standard rule. You can map
information from your trading partner's profile in the Partner Editor to a selected element
or field in the map. The information that you can use in the map includes any fieldin a
table (location, lookup, or cross-reference) or data from the partner record.

For this map, you need to map information from a cross-reference table for the PETZONE
partner profile, to translate your partner’s code for a purchased item and your code for the
same item. Your partner uses a customer product code (CUSTPROCODE) for each item
that is meaningful to him. However, your company uses a UPC code (UPCCODE) for
each item. After you and your partner determine what the equivalent customer product
codeisfor each UPC code, you can create a cross-reference tablein the Partner Editor and
use that information in your map.

A cross-reference table is used when you and your partner each reference an item by a
different name (or number). For example, if your unique namefor a“widget” is“wid” and
your partner’s unique name for the same “widget” is“1234,” the system uses the cross-
reference table to trand ate the two names for the “widget” item.

In this map, you have one code (UPC code) for each item ordered. Your partner refersto
the same item by a different code (customer product code). You need to map the customer
product code from the PO107 element (Product/Service ID) to the customer product code
field (CUSTPROCODE) on the application side of the map. Therefore, you must use a
cross-reference table to trand ate the customer product code to your UPC code. You and
your partner determined what the equivalent customer product code is for each UPC code.
In this tutorial, the cross-reference table is included with the partner (PETZONE.PAR)
you import into Partner Editor later in thistutorial.

Thistable contains the information in the cross-reference table. The “My Valug” field
contains your UPC code for the item. The “Partner Value” field contains your partner’s
customer product code for the item. The “ Description” field contains a description (and
size, if applicable) of theitem, and the Reference Datafield contains additional quantity or
color information.

My Value Partner Value Description Reference Data

12345678901234 | 555666411 Large Dog Collar Red

23456789012345 | 555666817 Spring Breeze Cat Litter | 10# Bag

34567890123456 | 555666908 Small Beef Basted Bag of 12

Rawhide Bones
45678901234567 | 555666321 X-Large Food Bowl Black
56789012345678 | 555666287 FatKat Kitty Bed Blue with White Trim

67890123456789 | 555666413 Catnip Mouse Toy
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Overview Note

(contd)  You do not need to create this cross-reference table—it is included with the PETZONE
partner (PETZONE.PAR) that is provided with the tutorial data when you install Sterling
Gentran:Server.

Finally, you need to use a standard rule to map the translated value from the
CUSTPROCODE field to the UPCCODE field.

Mappingthe  To map the customer product code, link the PO107 element in the PO1 segment (in the
customer product PO1 group) to the application field CUSTPROCODE in the PODETAIL record.

code

Use this procedure to translate your partner’s customer product code to your UPC code for
each item your partner ordered.

Step

Action

1

Double-click the CUSTRPOCODE field (in the PODETAIL record). The
Field Properties dialog box is displayed.

Select the Sandard Rule tab.

From the standard rule list, choose Select.

From the Table and Key box, select “ Partner xref by partner item.” This
indicates that you are using a cross-reference table and translating by your
item.

In the Sub Table box, type “PRODCODE”. Thisisthe name of the cross-
reference table you created.

Select the check box to signal the system that if thistrandation fails, you
want the system to generate an error.

From the Map From list on the left, select “My Item.” Thisisthefield
from which the contents are mapped.
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Inbound Purchase Order (850) CUSTPROCODE/UPCCODE Fields

(Contd)
Sep Action

8 From the Map To list on theright, select “UPCCODE.” Thisisthefield to
which the information from the Partner Editor is mapped.

The Standard Rule tab of the Field Properties dialog box should now look
like this:

Field Properties E

Mame | Walidation | Position | Extended Rule  Standard Rule | Conditions |

Pleaze select the standard rule to uze : ISeIect j

Flease choose the table and key [or group] to use when selecting data :

IF‘artner crozz-reference by partner item j
Fleaze enter the name of the sub-table to uze [if appropriate] :

IPHDDEDDE

V¥ Raise a compliance erar if matching data is not found

Y'ou can map the data that was selected. Click on data in the left list then click the
figlds in the right izt that vou would like it to be mapped to. Repeat to map more data,

CUSTHUMDET Custorer Mumnber
Partrer [kerm POCDATEDET Purchaze Order D ate
Description POMUMODET Purchase Order Mumber
Teut 1 CLUISTPROCODE Custormer Product Coc
Teut 2 IJPCCODE UPC Code

Text 3 JOM Urit of Meazure

Text 4 UMITPR Unit Price

QATYORD Quantity Ordered

Caticel | Help

9 Click OK to map from the cross-reference table.
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UOM Field Inbound Purchase Order (850)

UOM Field

Overview  You can map the UOM (Unit of Measurement) field directly from the PO103 (Unit or
Basis for Measurement) field, by using the Link function.

Procedure  Link the PO103 element in the PO1 segment (in the PO1 group) to the application field
UOM in the PODETAIL record.
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UNITPR Field

Overview  You can map the UNITPR (unit price) field directly from the PO104 element, by using the
Link function.

Procedure  Link the PO104 element in the PO1 segment (in the PO1 group) to the application field
UNITPR in the PODETAIL record.
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QTYORD Field

Overview  You can map the QTY ORD (quantity ordered) field directly from the PO102 element, by
using the Link function.

Procedure  Link the PO102 element in the PO1 segment (in the PO1 group) to the application field
QTYORD in the PODETAIL record.
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Inbound Purchase Order (850) Overview

Mapping the PODetail Group Records. PODESC Record

Overview

Introduction This section describes the actions necessary for you to map to each field in the PODESC
(description) record. The PODESC (description) record contains descriptive information
about the lineitem ordered. The PODESC record can occur up to five times per
PODetail Group, so multiple descriptive terms can be used for each item. For example, if
thelineitemisa“dog collar,” the description fields may be “red,” “large,” and “leather.”
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CUSTNUMDESC Field Inbound Purchase Order (850)

CUSTNUMDESC Field

Overview  The Application Integration subsystem allows you to use selected information from the
Sterling Gentran: Server Partner Editor in your maps via a standard rule. You can map
information from your trading partner's profile in the Partner Editor to a selected element
or field in the map. The information that you can use in the map includes any fieldin a
table (location, lookup, or cross-reference) or data from the partner key.

For this map, you must use information from the partner definition to populate the
Customer Number fields on the application side of the map. Since the Customer Number
isapart of the record key for each record, it appears five timesin the application file
format, once in each record (CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC,
CUSTNUMAC, and CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in the application
file format. It identifies which trading partner sent the purchase order. This customer
number is already part of the partner definition for this partner, so you can map it from the
partner definition to each customer number field.

Procedure  Usethis procedure to map the customer number from the partner definition.

Sep Action
1 Double-click the CUSTNUMDESC field (in the PODESC record) to
display the Field Properties dialog box.
2 Select the Sandard Rule tab.
3 From the standard rule list, choose Select.
4 From the Table and Key list, select “Document record.” This indicates

that the system updates this field with selected information from the
document record.

5 Select the check box to indicate that a compliance error should be
generated if the select does not find avalid entry.

6 From the Map From list on the left, select “Partner Key.” Thisisthefield
that contains the customer number for this partner.
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Inbound Purchase Order (850) CUSTNUMDESC Field

(Contd)
Sep Action

7 From the Map To list on theright, select “CUSTNUMDESC.” Thisisthe
field to which the information from the Partner Editor is mapped.

The Standard Rule tab of the Field Properties dialog box should now look
like this:

Field Properties E3

WEW I Validationl F'Dsitionl Extended Fule  Standard Rule | Conditionsl

Please select the standard rule to use : ISeIe-:t j

Flease chooze the table and key [or group) to uge when zelecting data :

IDDcument record j
Elease erter the name of the sut-tatle touse i apprapriate]

¥ Raise a compliance ermor if matching data is not found

You can map the data that was selected. Click on data in the left list then click the
fields in the right list that pou would like it to be mapped to. Fepeat to map more data.

Application Field 1 ;I CUSTHUMDESC | mer Mumber
Application Field 2 PODATEDESC Purchaze Order Date
Application Field 3 POMNURMDESC Purchasze Order Humber
Application Field 4 DESC Dezcription

Application Field 5

Application Field B

Control Number hd

Cancel | Help |

8 Click OK to add the standard rule to the CUSTNUMDESC field.
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PODATEDESC Field Inbound Purchase Order (850)

PODATEDESC Field

Overview  The BEGO5 (Purchase Order Date) element contains the date of the purchase order. The
BEG segment does not repeat. You need to map the information from the BEGO5 element
to the PODATEDESC field. However, the PODATEDESC field isincluded in the
PODetail Group, which repeats 100,000 times.

You can only map fields and elements that are at the same level. This means that you
cannot map to a group from a segment that does not repeat. For example, you cannot map
the purchase order date in the BEG segment directly to your application PODATEDESC
field.

Using an extended  To map the purchase order date to this application field, you need to use an extended rule
rule toextract the purchase order date from the BEGO5 element and moveiit to the
PODATEDESC field.

Use this procedure to create the extended rule.

Sep Action
1 Double-click the PODATEDESC field to access the Field Properties
dialog box.
2 Select the Extended Ruletab.
3 In the Rulelist, type the following:

#PODATEDESC=$850. #0323;

The system executes this rule when it processes the PODATEDESC field.

4 Click Compile to validate the syntax of the extended rule.

5 Click OK to add the extended rule to the PODATEDESC field.
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PONUMDESC Field

Overview  The BEGO3 (Purchase Order Number) element contains the purchase order number. The
BEG segment does not repeat. You need to map the information from the BEGO3 el ement
to the PONUMDESC field. However, the PONUMDESC field isincluded in the
PODetail Group, which repeats 100,000 times.

You can only map fields and elements that are at the same level. This means that you
cannot map to a group from a segment that does not repeat. For example, you cannot map
the purchase order number in the BEG segment directly to your application
PONUMDESC field.

Using an extended  To map the purchase order number to this application field, you need to use an extended
rule ruleto extract the purchase order number from the BEG03 element and move it to the
PONUMDESC field.

Use this procedure to create the extended rule.

Sep Action
1 Double-click the PONUMDESC field to access the Field Properties
dialog box.
2 Select the Extended Ruletab.
3 In the Rulelist, type the following:

#PONUNVDESC=$850. #0324;

The system executes this rule when it processes the PONUMDESC field.

4 Click Compileto validate the syntax of the extended rule.

5 Click OK to add the extended rule to the PONUMDESC field.
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DESC Field

DESC Field

Overview

Changing the Max
Use of the PID

group

Linking the DESC
field

Inbound Purchase Order (850)

The DESC field is avail able so your partner can describe the item in a free-form format.
You can map the DESC (description) field directly from the PID:205 element, by using the

Link function.

You have determined that your partner only sends you only five PID groups (product/item
descriptions), so you must change the maximum usage allowed for that group.

Use this procedure to change the maximum usage of the PID group.

Sep Action
1 Right-click the PID group (in the PO1 group) to access the shortcut menu.
2 From the shortcut menu, select Properties to access the Group Properties
dialog box.
3 Select the L ooping tab.
4 In the Max Usage box, type “5”. Thisbox is currently set to “1000.”
5 Click OK to accept the change to the PID group.

Link the PID:205 element in the PID:2 segment (in the PID group) to the application field
DESC in the PODESC record.
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M apping the PODetail Group Records. POALLCHG Record

Overview

Introduction This section describes the actions necessary for you to map to each field in the
POALLCHG (alowance/charge) record. The POALLCHG (allowance and charge) record
contains the allowance or charge indicator, method of handling code, and total allowance
or charge amount. The POALL CHG record can occur up to five times per PODetail Group,
so multiple allowances and/or charges can be used for each item.
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CUSTNUMAC Field

Overview  The Application Integration subsystem allows you to use selected information from the
Sterling Gentran: Server Partner Editor in your maps via a standard rule. You can map
information from your trading partner's profile in the Partner Editor to a selected element
or field in the map. The information that you can use in the map includes any fieldin a
table (location, lookup, or cross-reference) or data from the partner key.

For this map, you need to pull information from the partner definition to populate the
Customer Number fields on the application side of the map. Since the Customer Number
isapart of the record key for each record, it appears five timesin the application file
format, once in each record (CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC,
CUSTNUMAC, and CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in the application
file format. It identifies which trading partner sent the purchase order. This customer
number is already part of the partner definition for this partner, so you can map it from the
partner definition to each customer number field.

Procedure  Usethis procedure to map the customer number from the partner definition.

Sep Action
1 Double-click the CUSTNUMAC field (in the POALLCHG record) to
display the Field Properties dialog box.
2 Select the Sandard Ruletab
3 From the standard rule list, choose Select.
4 From the Table and Key list, select “Document record.” Thisindicates

that the system updates this field with selected information from the
document record.

5 Select the check box to indicate that a compliance error should be
generated if the select does not find avalid entry.

6 From the Map From list on the left, select “Partner Key.” Thisisthefield
that contains the customer number for this partner.
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CUSTNUMAC Field

(Contd)
Sep

Action

7

From the Map To list, select “CUSTNUMAC.” Thisisthe field to which
the information from the Partner Editor is mapped.

The Standard Rule tab of the Field Properties dialog should now look like
this:
Field Properties E

Mame I Validationl Positionl Extended Fule  Standard Rule | Eonditionsl

Please select the standard rule ta use : ISeIect j

Flease chooze the table and key [or group] to use when selecting data :

IDocument record j
Elease enter the name of the sub-table touse (i appraprsate] |

¥ Fiaize a compliance erar if matching data is nat found

Y'ou cah map the data that waz zelected. Click on data in the left list then click the
fields in the right lizt that pou would like it to be mapped to. Fepeat to map more data.

Application Field 1 ;l CUSTHUMALC Cugtormer Mumber
Application Field 2 PODATEAL Purchase Order D ate
Application Field 3 POMNUMAL Purchaze Order Mumber
Application Field 4 ACIMND Allowance or Charge Indicator
Application Field 5 ACMETHAMD Allowance or Charge Mel
Application Field 6 ACTOTAMT Allowance or Charge Total

Control Number hd

Cancel | Help |

Click OK to add the standard rule to the CUSTNUMAC field.

Application Integration ANSI Tutorial Guide

Sterling Gentran: Server — May 2011
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PODATEAC Field

Overview  The BEGO5 (Purchase Order Date) element contains the date of the purchase order. The
BEG segment does not repeat. You need to map the information from the BEGO5 element
to the PODATEAC field. However, the PODATEAC field isincluded in the
PODetail Group, which repeats 200,000 times.

You can only map fields and elements that are at the same level. This means that you
cannot map to a group from a segment that does not repeat. For example, you cannot map
the purchase order date in the BEG segment directly to your application PODATEAC
field.

Using an extended  To map the purchase order date to this application field, you need to use an extended rule
rule toextract the purchase order date from the BEGO5 element and moveiit to the
PODATEAC field.

Use this procedure to create the extended rule:

Sep Action
1 Double-click the PODATEAC field to access the Field Properties dialog
box.
2 Select the Extended Ruletab.
3 In the Rulelist, type the following:

#PODATEAC=$850. #0323;

The system executes this rule when it processes the PODATEAC field.

4 Click Compile to validate the syntax of the extended rule.

5 Click OK to add the extended rule to the PODATEAC field.
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PONUMAC Field

Overview  The BEGO3 (Purchase Order Number) element contains the purchase order number. The
BEG segment does not repeat. You need to map the information from the BEGO3 el ement
to the PONUMAC field. However, the PONUMAC field isincluded in the
PODetail Group, which repeats 200,000 times.

You can only map fields and elements that are at the same level. This means that you
cannot map to a group from a segment that does not repeat. For example, you cannot map
the purchase order number in the BEG segment directly to your application PONUMAC
field.

Using an extended  To map the purchase order number to this application field, you need to use an extended
rule ruleto extract the purchase order number from the BEG03 element and move it to the
PONUMAC field.

Use this procedure to create the extended rule.

Sep Action
1 Double-click the PONUMAC field to access the Field Properties dialog
box.
2 Select the Extended Ruletab.
3 In the Rulelist, type the following:

#PONUMAC=$850. #0324;

The system executes this rule when it processes the PONUMAC field.

4 Click Compile to validate the syntax of the extended rule.

5 Click OK to add the extended rule to the PONUMAC field.
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ACIND Fidld

Overview  You can map the ACIND (allowance or charge indicator) field directly from the ITA:201
element, which indicates whether the total amount is an allowance or charge.

Procedure  Link the ITA:201 element in the I TA:2 segment to the application field ACIND in the
POALLCHG record.
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ACMETHAND Field

Overview  You can map the ACMETHAND (allowance or charge method of handling code) directly
from the ITA:204 element, which indicates the method of handling the allowance or
charge.

Procedure  Link the I TA:204 element in the ITA:2 segment to the application field ACMETHAND in
the POALLCHG record.
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ACTOTAMT Field

Overview  You can map the ACTOTAMT (allowance or charge total amount) directly from the
ITA:207 element.

Procedure  Link the ITA:207 element in the I TA:2 segment to the application field ACTOTAMT in
the POALLCHG record.
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Mapping the POSUMMARY Record

Overview

Introduction This section describes the actions necessary for you to map to each field in the
POSUMMARY (summary) record. The POSUMMARY record contains the total number

of line items in the purchase order. The POSUMMARY record occurs once for each
purchase order trandlated.
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CUSTNUMSUM Field

Overview  The Application Integration subsystem allows you to use selected information from the
Sterling Gentran: Server Partner Editor in your maps via a standard rule. You can map
information from your trading partner's profile in the Partner Editor to a selected element
or field in the map. The information that you can use in the map includes any fieldin a
table (location, lookup, or cross-reference) or data from the partner key.

For this map, you need to pull information from the partner definition to populate the
Customer Number fields on the application side of the map. Since the Customer Number
isapart of the record key for each record, it appears five timesin the application file
format, once in each record (CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC,
CUSTNUMAC, and CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in the application
file format. It identifies which trading partner sent the purchase order. This customer
number is already part of the partner definition for this partner, so you can map it from the
partner definition to each customer number field.

Procedure  Usethis procedure to map the customer number from the partner definition.

Sep Action
1 Double-click the CUSTNUMSUM field (in the POSUMMARY record) to
display the Field Properties dialog box.
2 Select the Sandard Rule tab.
3 From the standard rule list, choose Select.
4 From the Table and Key list, select “Document record.” This indicates

that the system updates this field with selected information from the
document record.

5 Select the check box to indicate that a compliance error should be
generated if the select does not find avalid entry.

6 From the Map From list on the left, select “Partner Key.” Thisisthefield
that contains the customer number for this partner.
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CUSTNUMSUM Field

(Contd)
Sep

Action

7

From the Map To list on the right, select “CUSTNUMSUM.” Thisisthe
field to which the information from the Partner Editor is mapped.

The Standard Rule tab of the Field Properties dialog box should now look
like this:

Field Properties E

Mame | Walidation | Position | Extended Rule  Standard Rule | Conditions |

Pleaze select the standard rule to uze : ISeIect j

Flease choose the table and key [or group] to use when selecting data :
ID-:c:urnent record j

Eleaze enter the name of the subt-table to use [ appraprate] :

V¥ Raise a compliance erar if matching data is not found

Y'ou can map the data that was selected. Click on data in the left list then click the
figlds in the right izt that vou would like it to be mapped to. Repeat to map more data,

Application Field 1 ;I CUSTHUMSIIM Custarmer Murnber
Application Field 2 PODATESUM Purchase Order D ate
Application Field 3 POMUMSUM Purchase Order Mumber
Application Field 4 HUMLIMEITEMSUM Mumber of Line lte
Application Field 5

Application Field B

Contral Wumber -

Caticel | Help |

Click OK to add the standard rule to the CUSTNUMSUM field.

Application Integration ANSI Tutorial Guide
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PODATESUM Fidd

Overview  You can map the PODATESUM field directly from the BEGO5 (Purchase Order Date)
field, by using the Link function.

Procedure  Link the BEGO5 element in the BEG record to the application field PODATESUM in the
POSUMMARY record.
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PONUM SUM Field

Overview  You can map the PONUMSUM field directly from the BEG03 (Purchase Order Number)
field, by using the Link function.

Procedure  Link the BEGO3 element in the BEG record to the application field PONUMSUM in the
POSUMMARY record.
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NUMLINEITEMSUM Field

Overview  You can map the NUMLINEITEMSUM field directly from the CTTO1 (Number of Line
Items) field, by using the Link function. The CTTOL element is aready directly linked to
the NUMLINEITEMSfield in the POHEADER record, but Sterling Gentran: Server
allowsyou to link an input element to multiple output fields.

Procedure  Linkthe CTTO1 element inthe CTT record to the application field NUMLINEITEMSUM
in the POSUMMARY record.

After you compl ete the mapping operation for this final application field, the icons
representing each of the application fields should be bisected by ared checkmark. The red
checkmark indicates that a mapping operation has been performed against the field.
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Finalizing the Map

Overview

Introduction  After you create the map, define your application file format, and perform the appropriate

mapping operations, you need to finalize the map. To complete the mapping process, you

need to save the map, compile the translation object, print and review the Sterling
Gentran: Server report, and test the map.
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Inbound Purchase Order (850)

How to Compilethe Map

Overview  The Compile function compiles the map and generates a trand ation object. The map that
you created using Sterling Gentran:Server (PET_850.MAP) is a source map. When that
source map is compiled, the result is a compiled trandation object.

This tranglation object must be registered with the Sterling Gentran: Server system before

you can use it.

Procedure  Usethis procedure to compile a map and generate a translation object.

Step

Action

From the File menu, select Save to save the source map prior to using the
Compile function.

From the File menu, select Compile to display the Run-Time Translation
Object Name dialog box.

Run-Time Tranzlation Object Name EHE
Save jn: |E?l Trans0bi j ﬂ E
Pet_810s.tpl

File name: ~ [PET_850.TFL

Save az ype: ITransIation Objects [~ TFL) j Canicel |

The “File name” box automatically contains “pet_850.tpl.” Thisisthe
name of the transation object, using the default . TPL file extension and
we recommend that you name the translation object (. TPL fil€) the same
file name (1-8 characterslong) as you named the map (MAPfile).
Preserving the same file name (with different file extensions) means that
the rel ationship between the source map and the compiled translation
object remains evident.

Caution
Do not overlay the source map with the compiled translation object. Use
the .TPL file extension to distinguish the tranglation object.

Sterling Gentran:Server — May 2011
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How to Compile the Map

(Contd)
Sep

Action

4

Change the Drive and Folder where the compiled translation object is
stored, if necessary.

Caution

Do not store the compiled tranglation object in the
GENSRVNT\RegTransObj subfolder. This subfolder is reserved for
storing a copy of each translation object you register with Sterling
Gentran: Server.

Click Save and the system compiles the map and generates a trandlation
object. The Compile Error dialog box is displayed. Verify that no errors
occurred (scroll down to the bottom of thelist). Click OK to exit the
dialog box. The date on which the trandation object was compiled is
automatically loaded into the Compiled on box on the Trand ation Object
Details dialog box.

Tranzlation Object Details

w SL,II'HI'ﬂcu_-,I

Author Description Translation Object Function L
|Sterling JPET 3030 850 Evport || [Expant = Cancel |
. Flags ) — Gentran: Server for Windows
[ System [ Use Configurable Trimming [ % el Fuls Eremutn
—Werzion Control
Maijor version I‘I_ Minar version ID_ Compiled on Im

— EDI Aszociations

Input Output
Agency F |><l'|2 I_ I
Wersion [onznan | JANS|R12 VERSION ] | |
Transaction  [950 [PURCHASE ORDE | | | |
Fieleaze ID_ I—
F Group IF'D I I I

From the File menu, select Save to save the source map with the
Compiled on date.

Note
You must register this trandation object with the Sterling Gentran: Server
system before you can useit.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on registering a translation object.

Application Integration ANSI Tutorial Guide
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How to Print the Report

Inbound Purchase Order (850)

How to Print the Report

Overview  The Sterling Gentran:Server report enables you to validate and review the map, and make
modifications as needed. If you review the report and determine that the map is incorrect,
you should refine the mapping process as many times as necessary (make the
modifications, save the map, recompile the trand ation object, and print the report again).

Procedure  Usethis procedure to print the Sterling Gentran: Server report.

Step

Action

1

From the File menu or the Main Toolbar, select Print to access the Print
Options dialog box.

Print Options E

— Repart zections

¥ Print branching diagram = <
¥ Prirt record details Cancel |
¥ Print mapping details
¥ Prirt extended rules
¥ Print code lists

¥ Include anly active objects

Accept the defaults on this dialog box (all options checked), so the report
includes all sections and only the activated map components. Click OK
and the Print dialog box is displayed.

Set the appropriate options. Click OK if you do not need to change Setup
options, and the mapping report is printed.

Click Setup if you need to access printer setup information (to select a
specific printer, paper orientation, or size and source of paper). The Print
Setup dialog box is displayed.

Set the appropriate options. Click OK if you do not need to change Print
Options (dithering, intensity control, or print true type as graphics), and
you return to the Print dialog box. Click OK on the Print dialog box and
the mapping report is printed.

Click Optionsif you need to access printer setup optionsinformation. The
Options dialog box is displayed.

Set the appropriate options. Click OK to return to the Print Setup dialog
box. Click OK on the Print Setup dialog box to return to the Print dialog.
Click OK on the Print dialog box and the mapping report is printed.
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Testing the Trangation Object

Overview  After you compile the map, print and verify the report, and register the translation object
with Sterling Gentran: Server, you should test the trand ation object to verify that the data
istrandated correctly. To test the compiled translation object, you should obtain test data
from your partners and process the data. You should also verify acknowledgement
processing (if applicable) and verify communications with your trading partner.

Procedure  Usethis procedure to test the inbound (Export) trand ation object you just created.

Sep Action
1 Register PET_850.TPL translation object with Sterling Gentran: Server.
2 Import the PETZONE.PAR partner relationship into Sterling

Gentran:Server.

The default full path for the partner fileis:
C: \ GENSRVNT\ TUTORI AL\ PETZONE. PAR

3 Verify (in Partner Editor) that the PET X 3030 850 Export translation
object is selected for the Inbound Relationship.

4 Use the Process File option in Sterling Gentran: Server to process the data
file (PETTEST.INT) through the transl ation object. Thedatafileislocated
inthe TUTORIAL subfolder under the folder where Sterling
Gentran:Server isinstalled.

The default full path for the datafileis:
C: \ GENSRVNT\ TUTORI AL\ PETTEST. | NT

5 After the document istrandlated, it islocated in the In Documentsin
Sterling Gentran: Server. Export the document to ensure that it was
tranglated correctly.

Reference

See the IBM® Serling Gentran: Server® for Microsoft Windows User Guide for more
information on registering a translation object, importing a partner, selecting inbound
translation objects, and exporting files.
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Introduction Outbound Invoice (810)

Overview

| ntroduction

Inthischapter  Thistutorial exercise delineates the step-by-step tasks that are necessary to create a map
that is used to translate your application file to ANSI X12 invoices (810) that you send to
your trading partner.

This chapter explains all the tasks and processes associated with creating a map for an
outbound invaice, including the following:

» Mapping analysis

» Creating the new map

» Defining constants

» Activating groups, segments, and elements
» Defining the application side of the map

» Mapping your data

» Finaizing the map
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Getting Sarted

Overview  Thistutorial exerciseis meant to be completed in its entirety. We recommend that you
complete each task sequentially, without referring to the completed map that is provided
with the installation program (although you may want to verify your completed map with
the model).

The purpose of completing each task in thistutorial in sequential order asif it were your

own scenario, isto teach you not only how to perform the individual mapping tasks, but

also to teach you alogical approach and methods that should be utilized when you create
your own map.

For outbound translation, you must set up a system import map and an import map.
Generally, you create one system import map for each message type and create one import
map for each partner to whom you send messages.

Outbound Inthistutorial exercise, your company isMWT Manufacturing Co., which manufactures a
mapping scenario  wide variety of supplies for pet stores. Your company sells pet supplies directly to large
pet supply retail chains. You need to create a map that enables your company to trandate
your application file to the invoices that you send to one of your trading partners, Pet Zone
(alarge pet supply retailer). After you ship an order to Pet Zone, generate the
corresponding invoice, and once your application fileis trandated into an EDI invoice,
your company can send the invoice to Pet Zone.

You have an existing application file layout from your accounts payable department, that
defines the information your system generates for the invoice. And from discussions with
the Pet Zone, you know the requirements for the EDI invoices that you are sending them.

Mapping analysis  Thefirst step in creating amap is the analysis of the mapping requirements. Thisisthe
most important step in creating a successful map. If the analysis you perform is complete,
you have al the information you need to create the map in an efficient and logical manner.
If you omit this critical step and proceed directly to creating the map, it islikely that
creating the map will be amuch longer and arduous task, and the map may be invalid due
to oversights and omissions.

This table describes the steps used in mapping analysis. These steps apply to translating
both inbound and outbound data.

Sep Action
1 Analyze your application file format.
2 Analyze your partner’s EDI file format.
3 Correlate your application file format and the EDI file.
4 Begin creating the map.
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Outbound Invoice (810)

Analyzing Your Application File Format

Overview

Application file

Thefirst step of mapping analysisis analyzing your application file format, becausethisis
probably the component that is the most familiar to you. For an outbound map, your
application file contains the data that you need to convert to an EDI file so your system
can generate the document correctly. In this tutorial, your application file contains all the
information that you need to generate the invoice that you send your partner, so that your
company can bill your partner correctly for the goods you shipped to them.

You must define your application file to Sterling Gentran:Server. If your company has an
existing application file, asin this tutorial, you should obtain the record layout from the
appropriate person. If you did not have an existing application file layout, you would need
to create one by determining which fields are necessary to process the data correctly, and
then grouping the fields logically under records.

This table provides the application file layout for the system import map in this tutorial.

layout: system
import map Mand Data Min | Max
Field Name (x=Yes) Description Type Length | Length
Header Record (HEADER) 1 per document

PARTNER_ID X Partner Identifier String 1 9
STANDARD X Standard String 1 1
VERSION X Version String 6 6
TRANSACTION_ | X Transaction Set String 1 6
SET

TEST_PROD X Test/Production Flag String 1 1

Application file  Thistable provides the application file layout for the import map in this tutorial.
layout: import
map Mand Data Min | Max
Field Name (x=Yes) Description Type Length | Length
Header Record (HEADER) 1 per document
PARTNER_ID X Partner Identifier String 1 9
STANDARD X Standard String 1 1
VERSION X Version String 6 6
TRANSACTION_ | X Transaction Set String 1 6
SET
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(Contd) Mand Data Min | Max
Field Name (x=Yes) Description Type Length | Length
TEST_PROD X Test/Production Flag String 1 1
Beginning Record (INVBEGIN) 1 per document
BILLTOACCTBEG | X Bill to Acct Number String 1 9
DOCTYPBEG X Document Type String 1 6
INVNUMBEG X Invoice Number String 1 10
INVDATE X Invoice Date Dt/Tm 6 6
(YYMMDD)
PONUM Purchase Order String 0 20
Number
PODATE Purchase Order Date Dt/Tm 6 6
(YYMMDD)

VENDNAME Vendor Name String 0 35
VENDADD1 Vendor Address Line 1 String 0 35
VENDADD?2 Vendor Address Line2 String 0 35
VENDCITY Vendor City String 0 30
VENDSTATE Vendor State String 0 2
VENDPOSTAL Vendor Postal Code String 0 9
CODE

SHIPTONAME Ship To Name String 0 35
SHIPTOADD1 Ship To AddressLinel | String 0 35
SHIPTOADD2 Ship To AddressLine2 | String 0 35
SHIPTOCITY Ship To City String 0 30
SHIPTOSTATE Ship To State String 0 2
SHIPTOPOSTAL Ship To Postal Code String 0 9
CODE

SHIPTOLOC Ship To Store Location String 0 9
SHIPTODEPTNUM Ship To Dept Number String 0 4
REMITTONAME Remit To Name String 0 35
REMITTOADD1 Remit To AddressLine 1l | String 0 35

Application Integration ANSI Tutorial Guide
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(Contd) Mand Data Min | Max
Field Name (x=Yes) Description Type Length | Length
REMITTOADD2 Remit To AddressLine2 | String 0 35
REMITTOCITY Remit To City String 0 30
REMITTOSTATE Remit To State String 0 2
REMITTOPOSTAL Remit To Postal Code String 0 9
CODE
BOLNUM Bill of Lading Number String 0 12
SHIPDATE Ship Date Dt/Tm 6 6
(YYMMDD)
TERMS WHOLE Terms Percent Whole Number (N2) | O 3
TERMSNETDUE Terms Net Due Days Number (NO) | O 3
TERMSDISDUE Terms Discount Due Number (NO) | O 3
Days

Comment Group (INVCommentGroup) 1 per document

Comment Record 1 (INVCOMMENT1) 1 per document
BILLTOACCTCM1 | X Bill To Acct Number String 1 9
DOCTYPCM1 X Document Type String 1 6
INVNUMCM1 X Invoice Number String 1 10
REFNUM X Reference Number String 1 30

Comment Record 2 (INVCOMMENT?2) 10 per document
BILLTOACCTCM2 | X Bill To Acct Number String 1 9
DOCTYPCM2 X Document Type String 1 6
INVNUMCM2 X Invoice Number String 1 10
MESSAGETEXT X Message Text String 1 232

Detail Record (INVDETAIL) up to 200,000 per document
BILLTOACCTDET | X Bill To Acct Number String 1 9
DOCTYPDET X Document Type String 1 6
INVNUMDET X Invoice Number String 1 10
ITEMNUM X Item Number (Our Item) | String 1 6

Sterling Gentran:Server — May 2011

Application Integration ANSI Tutorial Guide




Outbound Invoice (810)

Analyzing Y our Application File Format

(Contd) Mand Data Min | Max
Field Name (x=Yes) Description Type Length | Length
QTYSHIP X Quantity Shipped Number (NO) | 1 5
QTYORD X Quantity Ordered Number (NO) | 1 5
UNITPRICE X Unit Price Number (N2) | 1 7
UOM X Unit of Measure String 1 4
CUSTPROCODE X Customer Product Code | String 1 10
UPCCODE X UPC Code String 1 12
ITEMDESC Item Description String 0 30
TERMSTY PE Terms Type Code String 0 2
TERMSDISP Terms Discount Percent | Number (N2) | O 6
Summary Record (INVSUMMARY) 1 per document
BILLTOACCTSUM | X Bill To Acct Number String 1 9
DOCTYPSUM X Document Type String 1 6
INVNUMSUM X Invoice Number String 1 10
TOTALAMOUNT | X Total Monetary Value Number (N2) | 1 10
Summary
TRANSTOTAL X Transaction Totals Number (NO) | 1 6
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Application file
definition

Outbound Invoice (810)

The above table contains the minimum information necessary to define your application
file to Sterling Gentran: Server (name, mandatory status, description, data type, and field

length). Each record contains a group of logically-related application fields. These fields
contain the information that your system needs to generate the invoice.

Each record (except the HEADER record, which is used for selecting the appropriate
trading relationship) contains a three-field record key that ensures that the same
identifying information is located at the beginning of each record. Your application file
format contains arecord key so that each record can beidentified individually. The record

key for thisinvoice consists of:

» your partner’s bill to account number

» the document type
» theinvoice number.

Record definitions

This table provides the Record Definitions.

Record

Definition

HEADER (header)

Contains the five-field key (partner identifier, standard,
version, transaction set, and test/production flag), which
isused for selecting the appropriate trading rel ationship.
This header record is mandatory and occurs once for
each invoice translated.

INVBEGIN (beginning)

Contains the purchase order number and date; the
vendor, ship to, and remit to address information; and
the bill of lading number, ship date, and term of the
invoice. The beginning record is mandatory and occurs
once for each invoice.

INVCommentGroup
(comment information)

Groups all the comment information for the invoice,
including the reference number and the message text.
The INVCommentGroup occurs once per invoice
translated. The information within the

INV CommentGroup is further segregated by record.

INVCOMMENT1 (first

Contains the reference number. The first comment

comment) record is mandatory and occurs once per invoice
translated (once for each comment line).

INVCOMMENT?2 (second Contains message text. The second comment record is

comment) mandatory and occurs up to ten times per invoice

tranglated (once for each comment line).

Sterling Gentran:Server — May 2011
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Record Definition

INVDETAIL (detail) Contains line item number and description, quantity
shipped, quantity ordered, unit of measure, price,
product code, and invoice terms. The detail record is
mandatory and occurs up to 200,000 times per invoice
translated (once for each line item invoiced).

INVSUMMARY (summary) | Contains the total invoice amount and the total
transaction amount. The summary record is mandatory
and occurs once per invoice trand ated.

Next step Now that you have analyzed your application file, the next step is to determine the
requirements of the invoice that you send to your partners.
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Analyzing the EDI File

Overview

To analyze the EDI file, you must first determine what you need to send your trading
partner and what your partner expects to receive. You and your partners must agree on
which standard, version, and transaction set you are using. In thistutorial, we are using an
ANSI X12 version 003030 810 invoice. It isimportant to know the information that your
partners expects you to send within the invoice, and what datais contained in each
element used.

Before you analyze the EDI file, it is helpful to review the EDI standard(s) that you will
use. Obtain an EDI standards manual for each standard and version that you are using.
Standards manuals are available from EDI standard agencies.

After discussing with your partner what you will send, determining which segments and
elements your partner requires, and reviewing the EDI standard, make a list of the map
components that you must make available for use (activate).

When translating data, the system does not process groups, segments, composites, and
elements (or records and fields) that are not activated. Therefore, you must activate the
groups, segments, composites, and elements that are not defined as mandatory by the
standard, but that you have determined that you need to use in mapping.

Thistable lists and describes the map components required for this tutorial.

Groups Segment Element
BIG BIGO3
(already active) BIG04
REF REF02
N1 N1 N102
N302
N3 N401
N402
N4 N403
REF02
REF:2
ITD ITDO3
ITDO5
ITDO7
DTM DTMO02
N9 N9 N902
MSG
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Defining constants

Analyzing the EDI File

(Contd)
Groups Segment Element
IT1 IT1 T101
IT106
T107
IT108
T109
QTY
PID PID:2 PIDO5
ITD:2 ITDO1
ITDO3
CTT CTTO02
(already active)

Note
When you activate a conditional group or segment, the mandatory subordinate segments
and elements are automatically activated.

Recommendation

We recommend that you set up a Document Name for each map, to make theidentification
of adocument created by this map easier in Sterling Gentran: Server. Thisalowsyou to
differentiate between documents in the document browsers in Sterling Gentran: Server.

To set up a Document Name, you must select an element or field in the map that contains
data that distinguishes the documents translated by this map. Then, the Name field of the
document browsers that contain this document contain the data from the selected element
or field. You can choose any element or field as the Document Name, but we strongly
recommend that you select an element or field that occurs only once in the document and
has a datatype of “ String.” In this tutorial, the document name for the import map in this
tutorial is the invoice number.

You can aso establish a Document Reference for each map, which also assistsyou in
differentiating between documents in the document browsers in Sterling Gentran: Server.
When you set up the Reference in the Application Integration subsystem, the RefData
field of the document browsers that contain this document in Sterling Gentran: Server
contains the data from that mapped field. In this tutorial, the document reference for the
import map in this tutoria is the purchase order number.

Since you are creating an import map to create outbound data, you must define constants
in the qualifier elements on the EDI (output) side of the map. Part of the mapping analysis
for an import map is determining in which elements you must define and use qualifiers,
and determining which elements they qualify. You must use constant values that are
compliant with the EDI standard.
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For thistutorial, you must define the following constants to create the required qualifier

elements:
Element Element
Using Constant it

Constant Constant ID Value Qualifies
REFO1 BILL_OF LADING BM REF02
N101 VENDOR VN N102
(N1_Vendor) (N1 Vendor)
N101 SHIP_TO ST N102
(N21_ShipTo) (N1 _ShipTo)
REFO1 DEPT_NUMBER DP REF02
(N1_ShipTo) (N1_ShipTo)
REFO1 STORE_NUMBER SN REF02
(N1_ShipTo) (N1 _ShipTo)
N101 REMIT_TO RI N102
(N1_RemitTo) (N1 _RemitTo)
DTMO1 DATE DTM DTMO02
N901 VENDOR_NUMBER v N902
IT106 UPC_CODE ul IT107
IT108 BUYER_CODE BP IT109
QTYO1 ORIGINAL_QUANTITY | OR QTYO02
PIDO1 FREE_FORM F PIDO5

Next step  After you complete the analysis of the EDI file and your application file format, the final
step in mapping analysisis correlating the two components.
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Correlating Your Application Fileand the EDI File

Overview  When you are trandlating data outbound, you need to build an import map and a system
import map. The system import map is used by Sterling Gentran: Server to find the partner
relationship for a document, to determine which import map is used to translate the data.
The system import map builds the key that the translator uses to find the partner
relationship. The sole function of the system import map is to identify the appropriate
partner relationship; the system import map does not map any data.

There are two ways to build the key in a system import map:
» thefivefield key (six-field for TRADACOMS standard)
» thethree-field key

The method that we recommend, and demonstrate in this tutorial, requires six EDI-
specific fields in the header record:

» partner key
» standard
» version

» transaction set
» release (for TRADACOMS only)
» test/production status

The combination of these six fields defines a unique key that identifies the appropriate
partner relationship. We recommend using this method because it is very flexible.
Typically, you use this method when you are defining your application from scratch and
can easily add the EDI-specific fields that are not already present in the header record.

The second method is easier to build because it only requires three fields in the header
record (partner key, application 1D, and application alias value). Please note that an empty
string isavalid vaue in the application ID and application alias value fields. The
combination of these three fields defines a unique key that identifies the appropriate
partner relationship. However, because only three fields are combining to build the key,
thismethod is not asflexible as the preferred method. Typically, you use this method when
you are using alegacy (existing) application definition, and you do not want to add EDI-
specific information.

To reconcile your application file with the EDI file, for each application field you must
determine which EDI element you need to populate with that information, and how you
can map that information to the EDI file. To map information to an element, you can use
linking, standard rules, extended rules, or a combination of the three.

Linking (simple mapping) enables you to map afield or element from the input side of
the map to afield or element on the output side of the map. The link between two map
components (hereafter referred to asfields) is visually represented with aline connecting
the two fields.

Sandard rules give you access to functions that are necessary for mapping operations
that are more complex than simple linking, but less involved than extended rules.
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Extended rules enable you to use a Sterling Gentran: Server proprietary programming
language to perform virtually any mapping operation you require.

Recommendation
We recommend that you determine which mapping operations are required on afield-by-
field basis for your application file.

Mapping This table lists and describes the mapping operations (by application field) that are
operations: system  required for the system import map in this tutorial.
import map

Mapping
Field Name Description Operations

Header Record (HEADER) 1 per document

PARTNER_ID Partner Identifier Select standard rule to match
the EDI Code in the Partner
record (Partner by EDI Code)

STANDARD Standard Update standard rule to update
the Agency field on the
Document record

VERSION Version Update standard rule to update
the Version field on the
Document record

TRANSACTION_SET Transaction Set Update standard rule to update
the Transaction Set ID field on
the Document record

TEST_PROD Test/Production Flag Update standard rule to update
the Test Mode field on the
Document record

Mapping  Thistablelists and describes the mapping operations (by application field) that are
operations. import required for the import map in this tutorial.

map
Mapping
Field Name Description Operations
Header Record (HEADER) 1 per document
PARTNER_ID Partner Identifier No mapping required
STANDARD Standard No mapping required
VERSION Version No mapping required

Sterling Gentran:Server — May 2011 Application Integration ANSI Tutorial Guide



Outbound Invoice (810)

Correlating Y our Application File and the EDI File

(Contd) Mapping
Field Name Description Operations
TRANSACTION_SET Transaction Set No mapping required
TEST_PROD Test/Production Flag No mapping required

Beginning Record (INVBEGIN) 1 per document

BILLTOACCTBEG Bill to Acct Number No mapping required
DOCTYPBEG Document Type No mapping required
INVNUMBEG Invoice Number Link to BIG02

INVDATE Invoice Date Link to BIGO1

PONUM Purchase Order Number | Link to BIG04

PODATE Purchase Order Date Link to BIGO3
VENDNAME Vendor Name Link to (N1 Vendor) N102
VENDADD1 Vendor AddressLine 1 Link to (N1 Vendor) N301
VENDADD?2 Vendor Address Line2 Link to (N1 _Vendor) N302
VENDCITY Vendor City Link to (N1 Vendor) N401
VENDSTATE Vendor State Link to (N1 Vendor) N402
VENDPOSTALCODE Vendor Postal Code Link to (N1 _Vendor) N403
SHIPTONAME Ship To Name Link to (N1 _ShipTo) N102
SHIPTOADD1 Ship To AddressLinel | Linkto (N1 ShipTo) N301
SHIPTOADD2 Ship To Address Line2 Link to (N1 _ShipTo) N302
SHIPTOCITY Ship To City Link to (N1_ShipTo) N401
SHIPTOSTATE Ship To State Link to (N1_ShipTo) N402

SHIPTOPOSTALCODE

Ship To Postal Code

Link to (N1_ShipTo) N403

SHIPTOLOC

Ship To Store Location

Link to (N1 _ShipTo) REFO2

SHIPTODEPTNUM

Ship To Dept Number

Link to (N1_ShipTo) REF02

REMITTONAME

Remit To Name

Link to (N1 _RemitTo) N102

REMITTOADD1

Remit To Address Line 1

Link to (N1 RemitTo) N301

REMITTOADD?2

Remit To Address Line2

Link to (N1_RemitTo) N302

REMITTOCITY

Remit To City

Link to (N1 _RemitTo) N401

Application Integration ANSI Tutorial Guide

Sterling Gentran: Server — May 2011



Correlating Y our Application File and the EDI File

Outbound Invoice (810)

(Contd) Mapping
Field Name Description Operations
REMITTOSTATE Remit To State Link to (N1_RemitTo) N402

REMITTOPOSTALCODE

Remit To Postal Code

Link to (N1 _RemitTo) N403

BOLNUM Bill of Lading Number Link to REFO2
SHIPDATE Ship Date Link to DTMO02
TERMS WHOLE Terms Percent Whole Link to ITDO3
TERMSNETDUE Terms Net Due Days Link to ITDO7
TERMSDISDUE Terms Discount Due Link to ITDO5

Days

Comment Group (INVCommentGroup) 1 per document

Comment Record 1 (INVCOMMENT1) 1 per document

BILLTOACCTCM1 Bill To Acct Number No mapping required
DOCTYPCM1 Document Type No mapping required
INVNUMCM1 Invoice Number No mapping required
REFNUM Reference Number Link to N902

Comment Record 2 (INVCOMMENT?2) 10 per document

BILLTOACCTCM2 Bill To Acct Number No mapping required
DOCTYPCM2 Document Type No mapping required
INVNUMCM2 Invoice Number No mapping required
MESSAGETEST Message Text Link to MSGO01

Detail Record (INVDETAIL) up to 200,000 per document

BILLTOACCT Bill To Acct Number No mapping required
DOCTYPDET Document Type No mapping required
INVNUMDET Invoice Number No mapping required
ITEMNUM [tem Number (Our Item) | Link to 1T101
QTYSHIP Quantity Shipped Link to 1T102
QTYORD Quantity Ordered Link to QTY02
UNITPRICE Unit Price Link to IT104

Sterling Gentran:Server — May 2011
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Next step

Correlating Y our Application File and the EDI File

(Contd) Mapping
Field Name Description Operations
UoM Unit of Measure Link to 1T103
CUSTPROCODE Customer Product Code | Link to IT107
UPCCODE UPC Code Link to IT109
ITEMDESC Item Description Link to PIDO5
TERMSTY PE Terms Type Code Link to ITDO1
TERMSDISP Terms Discount Percent | Link to ITDO3

Summary Record (INVSUMMARY) 1

per document

BILLTOACCTSUM Bill To Acct Number No mapping required

DOCTYPSUM Document Type No mapping required

INVNUMSUM Invoice Number No mapping required

TOTALAMOUNT Total Monetary Vaue Link to TDS01
Summary

TRANSTOTAL Transaction Totals Link to CTTO1

After you finish correlating your application file and EDI file on paper, you can begin

creating the system import and import maps.
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The System Import Map

How to Create the System Import Map

Overview  For outbound translation, you must set up a system import map and an import map.
Generally, you create one system import map for each document type, and set up an
import map for each partner you are sending documents to.

A system import map is used by the system to find the partner relationship for adocument
(flat file definition), to determine which import map is used to translate the data. The
system import map builds the key that the trandlator uses to find the partner relationship.
The sole function of the system import map is to identify the appropriate partner
relationship; the system import map does not map any data.

Procedure  Usethis procedure to create the system import map.

Sep

Action

From the File menu, select New.

System response
The system displays the New Map Wizard.

Answer the following questions and then click Next.

» What kind of map are you creating?
Select System Import Header.

» What isthe name of the map?
Type HEADER as the unique name of the map. The system adds the
.MAP extension.

» Whatisyour name?
Type your nameif it differs from the user name prompted by the
system.

System response
The system displays the New Map Wizard - Input Format dialog box.

Note
You need to compl ete the format of the Input side of the map. Thisisthe
format of the datathat is trandated by the Sterling Gentran:Server system.

From the Create a new dataformat using this syntax list, select Positional
and click Next.

System response
The system displays the New Map Wizard - Output Format dialog box.

Sterling Gentran:Server — May 2011
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(Contd)
Sep

Action

4

From the Create a new dataformat using this syntax list, select Positional
and click Next.

System response
The system displays the New Map Wizard.

Click Finish to create the new map (this may take afew seconds).

System response
The system displays the new map in the Application Integration Window.

From the Edit menu, select Details.

System response
The system displays the Tranglation Object Details dialog box.

Translation Object Details E2
— Summary
Suathar Dezcription Tranzlation Object Function 0k
ISterIing IHE!'-‘\DEH ISystem Import Header j Carcel |
—Flag

Gentrar: Server for Windows

[~ System [™ Use Configurable Trimming [ 2 et Bl Ersaulian

—Werzion Control

b ajor verzion IU Mimor version IEI Compiled on I

— EDI Associations

Input Clutput
—— [
‘Yergion I I I I
Tranzaction I I I I
Release I— I_
F Group | I I I

In the Description field, type “ System Import HDR”. For system import
maps, we recommend that you type “ System Import*”, where the “*” is
the identifier for this system import map. The Importstab of the System
Configuration program describes which system import translation object
will be used to begin tranglation during the import process.

Reference

Please see the IBM® Serling Gentran: Server® for Microsoft Windows
Administration Guide for more information about how your system
administrator will need to modify the system configuration program.
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(Contd)
Sep Action

8 Complete the Mgjor and Minor fields to designate a version number for
this translation object. Type“1’ asthe version number in the Mgjor field
and accept the “0” asthe release number in the Minor field.
Note
Whenever any major changes are made to your map, increase the version
to the next real number (e.g., 2.0, 3.0). If you make a minor change to the
map, increase the version by a percentage point (e.g., 2.1, 2.2).

9 Click OK to save the trandation object details.

10 From the File menu, select Save.

System response
The system displays the Save As dialog box.

Save As ﬂ E
Save jn: Ia Maps j ﬁl
; Pet_tord.map

] _tmap
=] Pet_s10.map
] Pet_s50map
@ Pet_einv.map
@ Pet_eord mag
@ Pet_tinv.map

File name: IHeader.map Save
Save as hupe; I taps [* map) j Cancel

Help |
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(Contd)
Sep

Action

11

Verify that the File name box contains Header.map.

Note

You alocate a field name to a map when you save the map for the first
time or use the Save As function to save a copy of the map under a
different name. The name of the map must be one to eight unique
characters that define the map in ameaningful way. The default file
extensionis“.MAP’. Using this extension distinguishes map files from
other types of files, such as trand ation objects. The naming conventionsin
Sterling Gentran: Server include:

» Thesource map (map created in Sterling Gentran: Server) should be
named using the file extension .M AP (e.g., HEADER.MAP).

» Thecompiled trand ation object (translation object that is the result of
compiling the source map) should be named using the same filename
that was all ocated to the source map, but with the file extension .TPL
(e.g., HEADER.TPL).

Recommendation

We recommend that you use these naming conventions to distinguish
source maps and compiled trandl ation objects from other types of files. We
also recommend that you use the same file name (different file extension)
for a source map and the translation object that was compiled fromit.

Caution

Be very careful not to overlay the source map with the compiled
tranglation object. Use the .TPL file extension to distinguish the
translation object.

12

Click Saveto save the map.

Note

After you complete each section of thistutorial or when you make any
changes to the map, you should save the map by selecting Save from the
File menu.

Next step After creating the system import map, you need to define the header record for the system
import map. You use the six-field key (thisis the preferred method) in this tutorial.
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How to Createthe HEADER Record

Overview  Theonly record that you define for the system import map is the header record. The
header record is subordinate to the icon on the input side of the map.

The HEADER (header) record contains the five fields that comprise the system import
map key. This header record is mandatory and occurs only once.

Procedure  Usethis procedure to create the HEADER record.

Sep Action
1 Click the Positional Fileicon on the input side of the map to highlight it.
2 From the Edit menu, select Create Sub. From the submenu, select
Record.

The Positional Record Properties dialog box is displayed.
MNarme |Tag | Fey Fieldl Speciall Loopingl

Please enter the name :

Pleaze enter a short description :

5
QK. I Cancel | Help |

3 In the Name box, type “HEADER” as the record identification code.

Caution
Do not use spaces or dashes (-) in the Name box. You can use the
underscore (_) to separate words.

4 In the Desc box, type “Header Record” as the description of the record.
Thisbox is used to provide a brief explanation of the record that allows
you to differentiate it from similar records.

5 Select the Tag tab.
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(Contd)
Sep

Action

6

In the Tag box, type “HDR” as the record identification code <TAG>. For
example, arecord is recognized by the system as:

<TAG>[ Fiel d_1][Fiel d_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

Note

You must define the record tag on the Positional Record Properties dialog
box for outbound maps, instead of defining fields with the purpose of
explicitly containing the record tag.

In the Position box, accept the default of “1” for the starting column
position of the tag in the data record.

Select the L ooping tab.

In the Min Usage box, type “1” to make the header record mandatory.
Thisis the minimum number of times the record must repeat.

Note
if the Min Usage box containsa“0” (zero), therecord isconditional. If the
Min Usage box containsa“1” or greater, the record is mandatory.

The Positional Record Properties dialog box should now look like this:

Positional Record Properties

Name | Tag I Key FieIdI Special  Looping I

Min Usage |1 ' Homal

" Loop Start

Max Uzage |1 " Loop End

Cancel Help

10

Click OK to create the HEADER record.

Next step Now you have to define the five fields that make up the system import key.
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How to Definethe HEADER Fidlds

Overview

Record Layout
Table

Procedure

To use the preferred method of building the system import key, you need to define at |east
five fields for the header record (partner key, standard, version, transaction, and test/
production status). These fields do not have to be in any order or sequence, but they must
be part of the header record.

After you define the header record and fields, you must set up the mapping operations that
define the key that the trandator uses to find the partner relationship.

The easiest way to add fieldsto arecord is to use the Positional Field Editor. Thistable
describes the fields that you need to create.

Mand Data Min M ax
Field Name (x=Yes) Description Type | Length | Length

Header Record (HEADER) 1 per document

PARTNER_ID X Partner Identifier String | 1 9
STANDARD X Standard String | 1 1
VERSION X Version String | 6 6
TRANSACTION_SET | X Transaction Set String | 1 6
TEST_PROD X Test/Production Flag | String | 1 1

Use this procedure to create the fields for the HEADER record.

Sep Action
1 Right-click the HEADER record to access the shortcut menu.
2 From the shortcut menu, select Edit Fields to access the Positional Field
Editor dialog box.
3 Thefield you are creating isthe first field record. Click New. A highlight

bar is displayed in the Fields section where the new field is positioned.
You need to fill in thefield valuesin the Field Details section.

4 In the Name box, type “PARTNER_ID”, which is the name of the first
field in the HEADER record. Each field must have a unique name.

5 Select the Mandatory check box to identify it asarequired field. For the
system import map, each field in the key is mandatory.
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(Contd)
Sep Action

6 In the Description box, type “Partner identifier” as the description of the
field. The description is used to provide a brief explanation of the field
that allows you to differentiate it from similar fields.

7 From the Data Type list, select “ String” asthe type of field, to specify that
this field must contain alphanumeric data.

8 If the Data Typeis“Number” or “Dt/Tm,” select the appropriate format
from the Format list.

9 In the Min Length box, type “1” as the minimum field length.

10 In the max Length box, type “9” as the maximum length of the field.

11 To add thefield and to create the next field positioned after it, press Enter.
A new field with blank values ready for you to identify is positioned
below thefield.

12 Create the rest of the fields according to the Record Layout Table on
page 3 - 26.

Note

If you press ENTER after typing the information for the last field in the
record, ablank field is created. Click Delete and then Yesto delete the
blank field.
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(Contd)
Sep Action

13 After adding the last field, click Auto Position to automatically position
thefield in the record. Thisautomatically calculates the start position in
the record of each field based on the criteria that each field is positioned
directly after the previousfield and is of the length specified in the Max
Length field. Click Yes to acknowledge the warning message that fields
are sequenced in order.

Caution

Please note that it is only valid to use the Auto Position function if you
define arecord tag on the Positional Record Properties dialog box, and if
you define every field in the record in the sequence that each field occurs,
asyou are doing thistutorial.

The Positional Field Editor dialog box should now look like this:

Positional Field E ditor
—Record
0K, |
Mame HEADER Tag HOR TagPos 1
Cancel |
— Field Detail
Name |PARTHER_ID ¥ Mandatary

Description |F'artner |dentifier

Data Type Farmat IX

Start Poz I-’i tin Length {1 tdax Length IE\ %
—Fields

Mame M/C Tupe Start  Len New

PARTNER_ID g

STANDARD M Shing 13 1 Ditsiz |

VERSIOM ] Shing 14 E

TRAMSACTIOM_SET ] Shrirg 20 E Auto Position |

TEST_PROD 1] Shing 2B 1

14 When you are completely finished adding fields to the HEADER record,
click Close.
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How to Definethe Key

Overview  After you define the header record and fields, you can set up the mapping operations that
define the key that the translator usesto find the partner relationship. This section provides
the procedures to define the:

» Partner key
» Standardfield
» Versionfield
» Transaction field
» Test/Production field
Definingthe  Usethis procedure to define the partner key.
partner key
Sep Action

1 Double-click the PARTNER_ID field to display the Field Properties
dialog box.

2 Select the Sandard Rule tab.

3 From the standard rule list, choose Select.

4 From the Table and Key list, select “Partner by EDI Code.” Thisindicates
that the system looks up the indicated partner key in the partner database
and updates thisfield.

The Standard Rule tab of the Field Properties dialog box should now |ook
like this:
Field Properties [ X]
Mame | Walidation | Fosition | Extended Rule  Standard Rule |Eonditi0ns|

Flease select the standard rule to use : ISeIect j

Pleaze chooze the kable and key [or group] to uge when selecting data :

IPartner by EDI code j

Elease efiter the name ofthe sub-tatle touse i appropniate]

|

™ Raize a compliance emor if matching data is nat found

“r'ou can map the data that was selected. Click on data in the left list then click, the

figlds i the right list that you would like it ta be mapped to. Repeat ta map mare data.

Mame P&RTHER_ID Partner [dentifier -

Edi Code STANDARD Standard j

Alternate Code WERSION Version
TRAMSACTIOM_SET Tranzaction 5
TEST_PROD Test/Production Flag
BILLTOACCTEEG Bill To Acct Mumk
DOCTYPEEG Document Tupe
INVHNUMBEDG Irveoice Mumber ;I

Cancel | Help I
5 Click OK to add the standard rule to the partner key field.
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Defining the EDI Use this procedure to define the EDI standard field.

standard field

Step

Action

1

Double-click the STANDARD field to display the Field Properties dialog
box.

Select the Sandard Rule tab.

From the standard rule list, select Update.

From the table list, choose “Document record.” Thisindicates that you
wish to store an item of data in the Sterling Gentran: Server tracking
database for the document.

From the column list, choose “Agency.” Thisindicates that you are
updating the agency (standard) field in the system buffer.

The Standard Rule tab of the Field Properties dialog box should now look
like this:

Field Properties

Mame | Validationl Positionl Extended Rule  Standard Rule | Eonditionsl

Flease select the standard rule to use IUpdate j

Flease zelect the table [or group) to update :
I Document record ﬂ

Flease select the column [or field) to update :

IAgenc_l,l j

Q Cancel | Help |

Click OK to add the standard rule to the STANDARD field.
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Definingthe  Usethis procedure to define the version.

version

Step

Action

1

Double-click the VERSION field to display the Field Properties dialog
box.

Select the Sandard Rule tab.

From the standard rule list, select Update.

From the table list, choose “Document record.” Thisindicates that you
wish to store an item of data in the Sterling Gentran: Server tracking
database for the document.

From the column list, choose “Version.” Thisindicates that you are
updating the standard version field in the system buffer.

The Standard Rule tab of the Field Properties dialog box should now look
like this:
Field Properties

Mame I Validation' Position' Estended Rule  Standard Rule I Eonditionsl

Please select the standard ile to use : IUpdate j

Flease select the table [or group] to update :
I Document record j

Please select the column [or field] to update :

IVersion - I

Cancel | Help |

Click OK to add the standard rule to the VERSION field.

Definingthe  Usethis procedure to define the transaction set (document).

transaction set

Sep

Action

Double-click the TRANSACTION_SET field to display the Field
Properties dialog box.

Select the Sandard Rule tab.

Application Integration ANSI Tutorial Guide

Sterling Gentran: Server — May 2011



How to Define the Key Outbound Invoice (810)

(Contd)
Sep Action

3 From the standard rule list, select Update.

4 From the table list, choose “ Document record.” Thisindicates that you
wish to store an item of datain the Sterling Gentran: Server tracking
database for the document.

5 From the column list, choose “ Transaction Set ID.” Thisindicatesthat you
are updating the transaction set field in the system buffer.

The Standard Rule tab of the Field Properties dialog box should now ook
likethis:
Field Properties %]
Mame | Validationl Positionl Eutended FRule  Standard Rule I Eonditionsl
Pleaze select the standard ile to use : IUpdate j
Fleaze select the table [or group) to update :
I Document record j
Pleaze select the column [or field] to update :
ITransaction SetlD j
Cancel | Help |
6 Click OK to add the standard rule to the TRANSACTION_SET field.

Defining thetest/  Usethis procedure to define the test/production status field.
production status

field
Sep Action

1 Double-click the TEST_PROD field to display the Field Properties dialog
box.

2 Select the Sandard Ruletab.

3 From the standard rule list, select Update.

4 From the table list, choose “Document record.” Thisindicates that you
wish to store aitem of datain the Sterling Gentran: Server tracking
database for the document.
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Sep Action
5 From the column list, select “ Test Mode.” Thisindicates that you are
updating the release field in the system buffer.
The Standard Rule tab of the Field Properties dialog box should now |ook
like this:
Field Properties
Mame | Validationl F'ositionl Extended Rule  Standard Rule | Eonditionsl
Pleaze select the standard rule to uze : IUpdate j
Flease select the table [or group) to update
I Document record j
Pleaze select the column [or field) to update :
ITest Mode j
Cancel | Help |
6 Click OK to add the standard rule to the TEST_PROD field.
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How to Compilethe Map

Overview  The Compile function compiles the map and generates a trand ation object. The map that
you created using the Application Integration subsystem (HEADER.MAP) is a source
map. When that source map is compiled, the result is a compiled translation object.

After you save the tranglation object, you must register it with Sterling Gentran: Server
before you can useit.

Procedure  Usethis procedure to compile a map and generate a translation object.

Sep Action

1 From the File menu, select Save to save the source map, prior to using the
Compile function.

2 From the File menu, select Compile to display the Run-Time Translation
Object name dialog box.
Run-Time Translation Object Hame HE
Save in: Ia Trans0kbj j gl &

File name:  [HEADER.TFL |
Save as lupe: ITransIation Objects [ TFL] j Cancel |
3 The File name box automatically contains “header.tpl.” Thisisthe name

of the translation object, using the default . TPL extension and we
recommend that you name the translation object (.TPL file) the samefile
name (1-8 characterslong) as you named the map (.MAP) file. Preserving
the same file name (with different extensions) means that the relationship
between the source map and the compiled translation object remains
evident.

Caution

Do not overlay the source map with the compiled translation object. Use
the .TPL file extension to distinguish the translation object.

4 Change the Drive and Folder where the compiled translation object is
stored, if necessary.
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(Contd)
Sep

Action

5

Click Save and the system compiles the map and generates atrandation
object. The Compile Error dialog box is displayed.

Verify that no errors occurred and click OK to exit the dialog box. The
date on which the transl ation object was compiled is automatically loaded
into the Compiled on box on the Translation Object Details dialog box.

Translation Dbject Details

— Summary
Author Dezcription Translation Object Function
ISterIing IS_l,lstem Import HOR ISystem Import Header j Cancel |
—Flag -
. o Gentram Server for Windows
[~ System [ Use Configurable Trimming [~ 2.+ Compatible Rl Execution

— Wergion Control
Major verzion I‘I Minar verzion ID

— EDI Aszsociation

Compiled on |1E-Mar-2DDD

|nput Output
p—— [
Wersion | I I |
Trahzaction I I I I
Releaze I_ I—
F Group I I I I

From the File menu, select Save to save the source map with the
Compiled on date.

Note
You must register this translation object with the Sterling Gentran: Server
system before you can use it.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for information on registering a translation object.
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How to Print the Report

Overview  The Sterling Gentran:Server report enables you to validate and review the map, and make
modifications as needed. If you review the report and determine that the map is incorrect,
you should refine the mapping process as many times as necessary (make the
modifications, save the map, recompile the trand ation object, and print the report again).

Procedure  Usethis procedure to print the Sterling Gentran: Server report.

Step

Action

1

From the File menu or Main Toolbar, select Print to access the Print
Options dialog box.

— Report gectionz

¥ Frirtt branching diagram = -
¥ Print record details Cancel |
¥ Print mapping details
¥ Prirt extendad rules

™ Prirt code lists

¥ Include anly active objects

Accept the defaults on this dialog box (all options checked), so the report
includes all sections and only the activated map components. Click OK
and the Print dialog box is displayed.

Set the appropriate options. Click OK if you do not need to change Setup
options, and the mapping report is printed.

Click Setup if you need to access printer setup information (to select a
specific printer, paper orientation, or size and source of paper). The Print
Setup dialog box is displayed.

Set the appropriate options. Click OK if you do not need to change Print
Options (dithering, intensity control, or print true type as graphics), and
you return to the Print dialog box. Click OK on the Print dialog box and
the mapping report is printed.

Click Optionsif you need to access the printer setup optionsinformation.
The Options dialog box is displayed.

Set the appropriate options. Click OK to return to the Print Setup dialog
box. Click OK on the Print Setup dialog box to return to the Print dialog
box. Click OK on the Print dialog box and the mapping report is printed.
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Testingthe  After you compile the map, print and verify the report, and register the translation object
trandation object  with Sterling Gentran:Server, you should test the translation object to verify that the data
istrandated correctly. You test the system import trandation object (HEADER.TPL)
when you test the import translation object (on 3 - 147).
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How to Createthelm

Overview  Thefirsttask i

Outbound Invoice (810)

port Map

n creating anew map is to define the format that is used for the input and

output sides of the map. In this example, you are creating an import map so Sterling
Gentran: Server can translate your application file to an invoice that you are sending to
your partner. Therefore, the input side of the map needs to reflect your application file.
The output side of the map needs to reflect the ANSI X12 810 invoice that you send to
your partner. Instead of defining the 810 document to the system yourself, you want
Sterling Gentran: Server to use the standards database on your system to build the invoice
according to the standard.

Procedure  Usethis procedure to create the import map for the outbound invoice.

Sep

Action

From the File menu, select New.

System response
The system displays the New Map Wizard.

Answer the following questions and then click Next.

» What kind of map are you creating?
Select Import.

» What isthe name of the map?
Type PET_810 as the unique name of the map. The system adds the
.MAP extension.

» Whatisyour name?
Type your nameif it differs from the user name prompted by the
system.

System response
The system displays the New Map Wizard - Input Format dialog box.

Note
You need to compl ete the format of the Input side of the map. Thisisthe
format of the datathat is trandated by the Sterling Gentran:Server system.

From the Create a new dataformat using this syntax list, select Positional
and click Next.

System response
The system displays the New Map Wizard - Output Format dialog box.
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(Contd)
Sep Action

4 From the Create a new data format using this syntax list, select Delimited
EDI and click Customize.

System response
The system displays the New Delimited EDI Wizard.

5 Click Next.

6 From the ODBC data source list, select Gentran Standards (if you
defined your EDI standards data source with another name, select that
name) and click Next.

7 Select the following:
a.  Select the [X] X12 standards agency,

b. [003030] ANSI X12 VERSION 3 Release 3 version,
c. {810] INVOICE transaction set, and

d. 9release (for TRADACOMS only).

Click Next.

5 Click Finish.

System response
The system loads the selected transaction set and returns to the New Map
Wizard - Output Format dialog box.

6 Click Next.

System response
The system displays the New Map Wizard.

7 Click Finish to create the new map (this may take afew seconds).

System response
The system displays the new map in the Application Integration Window.

Note

After you finish creating and saving a new map, you need to define the
Input and Output sides of the map. The steps you take are different,
depending on whether the map is an Import, System Import, Export, or
Turnaround map.
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(Contd)
Sep

Action

8

From the Edit menu, select Details.

System response
The system displays the Translation Object Details dialog box.

Translation Dbject Details

— Summary
Authar Dezcription Translation Object Function : K
[5terling [FET_&10 {impert =l Cancel |

" Flag . . Gentrar Server for Windows
[~ System [ Use Configurable Trimming [~ 2.+ Compatible Rl Execution

— Wersion Cantral
Major verzion ID_ Minaor verzion ID— Compiled on I—

— EDI Aszociation

Input Output
T [ [z
Wersion [ | Joozosn | fansix12 VERSION
Transaction | | |Gl [nes0iCE
Relzase l— IU—
F Group I I IIN I

In the Description field, type PET X 3030 810 I mport.

10

Complete the Mg or and Minor fields to designate a version number for
this translation object. Type“1’ asthe version number in the Mgor field
and accept the “0” as the release number in the Minor field.

Note

Whenever any major changes are made to your map, increase the version
to the next real number (e.g., 2.0, 3.0). If you make a minor change to the
map, increase the version by a percentage point (e.g., 2.1, 2.2).

11

Click OK to save the tranglation object details.
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(Contd)
Sep

Action

12

From the File menu, select Save.

System response
The system displays the Save As dialog box.

Save in: IaMaDS j ﬁl

cii_test.map PET_B850.map RuleD ermo.map
HEADER.map Pet_eirw.map RuleDiemo3.map
Header_t.map Pet_eord. map zitest.map
Pet_210.map Pet_tiny.map test.map
Pet_8102.map Pet_tord.map wmitest. map

Pet_810u.map RuleDermal.map

File name: IF'ET_81 O.rap

Save as fupe: IMaps [*.map] j Cancel |
Help |

13

Verify that the File name box contains pet_810.map.

Note

You allocate afield name to a map when you save the map for the first
time or use the Save As function to save a copy of the map under a
different name. The name of the map must be one to eight unique
characters that define the map in ameaningful way. The default file
extension is“.MAP”. Using this extension distinguishes map files from
other types of files, such astrand ation objects. The naming conventionsin
Sterling Gentran: Server include:

» Thesource map (map created in Sterling Gentran: Server) should be
named using the file extension .M AP (e.g., PET_810.MAP).

» Thecompiled translation object (translation object that isthe result of
compiling the source map) should be named using the same filename
that was all ocated to the source map, but with the file extension . TPL
(eg., PET_810.TPL).

Recommendation

We recommend that you use these naming conventions to distinguish
source maps and compiled trand ation objects from other types of files. We
aso recommend that you use the same file name (different file extension)
for a source map and the translation object that was compiled fromiit.

Caution

Be very careful not to overlay the source map with the compiled
translation object. Use the .TPL file extension to distinguish the
translation object.

Application Integration ANSI Tutorial Guide
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(Contd)
Sep Action

14 Click Save to save the map.

Note

After you complete each section of thistutorial or when you make any
changes to the map, you should save the map by selecting Save from the
File menu.

Next step Now that you’ ve finished creating and saving the new Export map, you need to define the
Input and Output sides of the map.
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How to Activate the EDI Map Components

Overview  Thistable describes the map components for an EDI File.

Icon Description
= EDI File
' Segment
G Loop (Group)
by Composite Element
P Element

This table describes the map components for a Positional File.

Icon Description
‘. Positional File
0 Record
G Loop (Group)
2 Field

The specific EDI map components that you use depend on the type of map you are
creating, the standard, version, and transaction set (document) selected, and which
segments and elements your company requires. We recommend that you determine which
segments and elements you are using before starting this step.

When Sterling Gentran: Server generates the EDI sides of the map, the system includes al
the groups, segments, composites, and elements that are defined by the standards agency
for the version of the document you selected. The system activates all the groups,
segments, composites, and elements that are defined as “ mandatory” (must be present) by
the standard. The system does not enable you to deactivate the mandatory groups,
segments, composites, and elements. By default, Sterling Gentran: Server displays active
map components with a black font, and inactive map components with a grey (dimmed)
font.

When translating data, the system does not process groups, segments, composites, and
elements (or records and fields) that are not activated. Therefore, you must activate the
groups, segments, composites, and elements that are not defined as mandatory by the
standard, but that you have determined that you need to use in mapping.
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Procedure  Usethis procedure to activate the required conditional groups, segments, and elements.

Sep Action
1 Double-click the segments and groups in the table below to open them.
These are the groups, subgroups, segments and el ements that you must
activate. Opening al the necessary segments and groups before you start
to activate allows you to scroll down the map and activate the segments
and elements sequentially.
Groups Segment Element
BIG BIGO3
(already active) BIG04
REF REFO2
N1 N1 N102
N3 N302
N4 N401
N402
N403
REF:2 REF02
ITD ITDO3
ITDO5
ITDO7
DTM DTMO2
N9 N9 N902
MSG
IT1 IT1 17101
1T106
1T107
IT108
17109
QTY
PID PID:2 PID0O5
ITD:2 ITDO1
ITDO3
CTT CTTO02
(already active)
Note
When you activate a group or segment, the mandatory subordinate
segments and elements are automatically activated.
2 Click the Activate button on the Main Toolbar.
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(Contd)
Sep

Action

3

Click each inactive group that you need to use. This activates the groups.

Note

If you click a group, segment, or element that you did not mean to
activate, click it with the right mouse button to access the shortcut menu.
From the shortcut menu, select Deactivate from the shortcut menu.

Click each inactive segment that you need to use. This activates the
segments.

Click each inactive element that you need to use. This activates the
elements.

Once you have activated all the necessary groups, segments, and
elements, click the Activate button on the Main Toolbar to turn activation
mode off.

From the View menu, select Show Active Only.

Note
This function instructs the system to only display the active map
components.

Application Integration ANSI Tutorial Guide

Sterling Gentran: Server — May 2011



How to Define Literal Constants Outbound Invoice (810)

How to Define Literal Constants

Overview

Literal constants are used by the system as a repository to store information that is used
later in the map. For an outbound map, constants are typically used to define qualifying
relationships. A qualifying relationship establishes a relationship between an element and
itsqualifier. A qualifier contains a code that further defines the element or the elements
with which it is associated. Qualifying relationships are typically defined in outbound
maps. Qualifying relationships are defined using an standard rule, as explained later in this
tutorial.

Since you are creating an import map to translate outbound data, you must define
constants to define the qualifying relationships on the EDI (output) side of the map. After
you determine which constants are used in amap, it saves time later in the map creation
process if you define all the constants at one time.

Thistable lists the constants you must define for this tutorial.

Constant Constant
Constant ID Type Value

BILL_OF LADING String BM
VENDOR String VN
SHIP_TO String ST
DEPT_NUMBER String DP
STORE_NUMBER String SN
REMIT_TO String RI

DATE String DTM
VENDOR_NUMBER String v
UPC_CODE String Ul
BUYER_CODE String BP
ORIGINAL_QUANTITY String OR
FREE_FORM String F
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How to Define Literal Constants

Procedure  Usethis procedure to create the literal constants that are used in the import map for this

tutorial.

Step

Action

1

From the Edit menu, select Constantsto display the Map Constants
dialog box.

Click New to access the Edit Constant dialog box.

Fdit Constant
1D Type
| 3 ==

Inthe ID box, type “BILL_OF_LADING”, which isthefirst literal
constant identifier in the table. Thisistypically a description of thefield
or element in which the constant is used.

From the Type list, select “String” as the category of thisliteral constant.

In the Value box, type “BM” asthe actual constant expression. Thisisthe
value of the literal constant.

Click OK to add the constant to the system.

Repeat steps 2 — 6 to create the rest of the constants, according to the table
on page 3 - 46.

Click Close to exit the Map Constants dialog box.

Application Integration ANSI Tutorial Guide
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How to Verify EDI Delimiters

Overview

Procedure

If you are using an EDI standard that contains composite elements or subelements, you
must verify that Sterling Gentran: Server is specifying the correct EDI delimiters.
Delimiters are flags that you define to the system as separating specific EDI components.
Delimiters are necessary for all variable field-length standards, because the datais
compressed (and the leading zeroes and trailing blanks are removed). Since the fields vary
in length, the system needs a flag to determine where one element ends and another
begins. For example, an element delimiter marks the beginning of a new element.

Recommendation

Although verifying EDI delimitersin Sterling Gentran: Server is mandatory only if you are
using a standard with composite elements or subelements, we recommend that perform
this task regardless of which standard you use.

Use this procedure to verify EDI delimiters.

Sep Action
1 Right-click the 810 INV OICE file icon to access the shortcut menu. From
the shortcut menu, select Propertiesto display the File Properties dialog
box.
2 Select the Delimiterstab.

System response
The system displays the delimiter settings.

File Properties

Mame Delimiters | Syntax Hecordl Loop Extended Rules |

v Specify defaults [ Stream seqments

Tag Delimiter I Segment D elimiter I"
Element Delimiter I“ Sub Element Delimiter I:
Release Character I Decimal 5eparator I

Cancel Lppli Help

Sterling Gentran:Server — May 2011 Application Integration ANSI Tutorial Guide



Outbound Invoice (810)

Next step

Application Integration ANSI Tutorial Guide

How to Verify EDI Delimiters

(Contd)
Sep Action
3 Verify the required delimitersfor the ANSI X 12 standard. If the delimiters
differ from the default in thistable, type either the character or the
hexadecimal valuein the correct box.
The default delimitersfor ANSI X12 are listed and described in thistable
(the tag delimiter, release character, and decimal separator are not used for
ANSI).
ANSI X12
Default ANSI X12 Default Hex
Box Character Value
Tag Delimiter
Element Delimiter * (asterisk) 0x2A
Segment Delimiter ~ (tilde) OX7E
Sub Element Delimiter : (colon) O0x3A
Release Character
Decimal Separator
4 Click OK to exit the File Properties dialog box.

Now you can define your application file layout to Sterling Gentran: Server.
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Application File Format

Defining the Rest of Your Application File For mat

Overview At thispoint, you have already defined the header record (in the system import map) that
you can copy and use in your import map. Now you must define the rest of your
application file to Sterling Gentran:Server. In the import map, the input side of the map is
positional. Your application file must contain all the information that you need to generate
the EDI document that you are sending to your partner.

Before you define your application file format, you should obtain alayout of the necessary
records, fields, and groups. The records contain related fields and the groups contain
related records. Each level of your application file format must be created sequentially.

For example, your application file format contains records and groups. The records
contain fields and the group contains records. This means that you must create records and
the group before you create the subordinate fields and records.
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How to Copy the HEADER Record

Overview

Procedure

Removing the
HEADER
standard rules

Procedure

Since you have aready defined the header record for your application file format in the
system import map, you can copy that header record to the import map. The copied record
contains subordinate fields, which is also be copied. Copied map componentsretain all the
information of the original map component, so you must remove the standard rules you
created for the fields in the header record for the system import map.

Use this procedure to copy the HEADER record from the system import map to the import
map.

Sep Action

1 Open the HEADER.MAP system import map, if it is not already open.

2 Highlight the HEADER record.

3 Click the Copy button on the Main Toolbar.

4 Open the PET_810.MAP import map, if it is not already open.

5 Highlight the INPUT positional file icon that you want the copied record
pasted after.

6 From the Main Toolbar, click Paste to past the contents of the Clipboard.
The HEADER record is pasted as a subordinate map component to the
INPUT positional fileicon.

The HEADER record that you just copied from the system import map contains five
fields. Thefirst field (PARTNER_ID) has a Select standard rule applied to it in the system
import map. The remaining four fields in the copied HEADER record in the import map
(STANDARD, VERSION, TRANSACTION_SET, and TEST_PROD) have Update
standard rules applied to them in the system import map. These standard rules are not
applicable to the import map, so you must remove them.

Use this procedure to remove the standard rules from the HEADER record in the import
map.

Sep Action
1 Double-click the PARTNER_ID field in the HEADER record to display
the Field Properties dialog box.
2 Select the Sandard Rule tab.
3 From the standard rule list, select <none>.
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Sep Action

4 Depending on how you set the confirmation options on the Preferences
dialog box (Confirmations tab), the system may prompt you to confirm
removal of the standard rule from the field. If so, click Yesto remove the

standard rule.
5 Click OK to save the changeto the field.
6 Repeat steps 1 - 5 for the STANDARD, VERSION,

TRANSACTION_SET, and TEST_PROD fields.
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How to Createthe INVBEGIN Record

Overview  The second record in your application file format you need to create INVBEGIN is at the
same level asthe HEADER record.

The INVBEGIN (beginning) record contains the purchase order number and date; the
vendor, ship to, and remit to address information; and the bill of lading number, ship date,
and terms of the invoice. The beginning record is mandatory and occurs once for each

invoice.

Procedure  Usethis procedure to create the INVBEGIN record.

Step

Action

Highlight the HEADER record. From the Edit menu, select Insert. From
the submenu, select Record to display the Positional Record Properties
dialog box.

Note

Use “Insert” from the Edit menu when you want to create equal records/
groups and to use “ Create Sub” to create subordinate groups/records/
fields.

In the Name box, type “INVBEGIN” as the record identification code.

Caution
Do not use spaces or dashes (-) in the Name box. You can use the
underscore (_) to separate words.

In the Desc box, type “Beginning Record” as the description of the record.
Thisbox is used to provide a brief explanation of the record that allows
you to differentiate it from similar records.

Select the Tag tab.

In the Tag box, type “BEG” asthe record identification code <TAG>. For
example, arecord is recognized by the system as:

<TAG>[ Fi el d_1][Fiel d_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

Note

You must define the record tag on the Positional Record Properties dialog
box for outbound maps, instead of defining fields with the purpose of
explicitly containing the record tag.

In the Position box, accept the default of “1” for the staring column
position of the tag in the data record.

Application Integration ANSI Tutorial Guide
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(Contd)
Sep Action
7 Select the L ooping tab.
8 In the Min Usage box, type “1” to make the record mandatory. This box
contains the minimum number of times the record must repeat.
Note
If the Min Usage box containsa“0” (zero), therecord is conditional. If the
Min Usage box containsa‘1” or greater, the record is mandatory.
Accept the default of “1” in the Max Usage box so the beginning record
only occurs once (not alooping structure).
The Positional Record Properties dialog box should now look like this:
Mame | Tag | Kep Fieldl Special  Looping I
Min Ugage I'l— & Nomal
" Loop Start
b ax Uzage I‘I ' (Ll
Cancel | Help
9 Click OK to create the INVBEGIN record.
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How to Create the INVCommentGroup

Overview  The INVCommentGroup (comment information) groups all the comment information for
the invoice, including the reference number and the message text. The
INV CommentGroup occurs once per invoice tranglated. The information within the
INVCommentGroup is further segregated by related records.

Procedure  Usethis procedure to create the INV CommentGroup.

Step

Action

1

To create agroup that is at the same level asthe INVBEGIN record,
highlight the INVBEGIN record. From the Edit menu, select I nsert. From
the submenu, select Group.

System response
The Group Properties dialog box is displayed.

In the Name box, type “INV CommentGroup” to indicate that this group
contains all of the comment records. This is the segment loop
identification code.

In the Description box, type “Comment Group” as the loop description.
This box is used to provide a brief explanation of the loop.

Select the L ooping tab.

In the Minimum Usage box, type“1” to make the loop mandatory. Thisis
the minimum number of times the loop must be repeated. For a
conditional loop, the minimum usage should always be “0” (zero). For a
mandatory |oop, the minimum usage should be “1" or greater.

Accept the default of “1” in the Maximum Usage box. This indicates that
this group of records occurs only once.

Click OK to create the INV CommentGroup.

Application Integration ANSI Tutorial Guide
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How to Create the INVCommentGroup Subordinate
Records

Overview In thistutorial, the INVCommentGroup contains two subordinate records:
» INVCOMMENT1
» INVCOMMENT2.

After you create the first subordinate record (INVCOMMENTL1), you can define the
subsequent record at the same level INVCOMMENT?2).

Creatingthe = The INVCOMMENT1 (first comment) record contains the reference number. The first
INVCOMMENT1  comment record is mandatory and occurs once per invoice translated (once for each
record comment line).

Procedure  Usethis procedure to create the INVCOMMENT1 record.

Sep Action

1 Click the INV CommentGroup to highlight it. From the Edit menu, select
Create Sub. From the submenu, select Record.

System response
The Positional Record Properties dialog box is displayed.

2 In the Name box, Type “INVCOMMENTL1” asthe record identification
code.
3 In the Desc box, type “Header Comment Record 1" as the description of

the record. This box is used to provide a brief explanation of the record
that allows you to differentiate it from similar records.

4 Select the Tag tab.

5 In the Tag box, type“CM1” astherecord identification code <TAG>. For
example, arecord is recognized by the system as:

<TAG>[Fi el d_1][Fiel d_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

6 In the Position box, accept the default of “1” for the starting column
position of the tag in the data record.

7 Select the L ooping tab.
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(Contd)
Sep Action

8 In the Min Usage box, type “1” to make the record mandatory. This box
contains the minimum number of timesthe record must repeat. Accept the
default of “1” in the Max Usage box so this record only occurs once.

The Positional Record Properties dialog box should now look like this.

Positional Record Properties E

Mame | Tag | Key FieIdI Special Looping I

in Usage I'I & Norml

 Loop Start

Max Uzage I'I " LoopEnd

Cancel | Help

9 Click OK to create the INVCOMMENT1 record.

Creatingthe  The INVCOMMENT?2 (second comment) record contains message text. The second
INVCOMMENT?2 comment record is mandatory and occurs up to ten times per invoice translated (once for
record each comment line).

Procedure  Usethis procedure to create the INVCOMMENT2 record.

Sep Action

1 Highlight the INVCOMMENT1 record. From the Edit menu, select
Insert. From the submenu, select Record to display the Positional
Properties dialog box.

2 In the Name box, type “INVCOMMENT?2" as the record identification
code.
3 In the Desc box, type “Header Comment 2" as a description of the record.

Thisbox is used to provide a brief explanation of the record that allows
you to differentiate it from similar records.

4 Select the Tag tab.
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(Contd)
Sep Action

5 In the Tag box, type “CM2" asthe record identification code <TAG>. For
example, arecord is recognized by the system as:
<TAG>[Field_1][Field_2]
The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

6 In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

7 Select the L ooping tab.

8 In the Min Usage box, type “1” to make the record mandatory. This box
contains the minimum number of times the record must repeat.

9 In the Max Usage box, type “10” as the maximum number of times the
record can repeat.

10 Click OK to create the INVCOMMENT2 record.
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How to Createthe INVDETAIL Record

Overview  TheINVDETAIL (detail) record is at the same level asthe HEADER and INVBEGIN
records and the INV CommentGroup.

The INVDETAIL record contains line item number and description, quantity shipped,
guantity ordered, unit of measure, price, product code, and invoice terms. The detail
record is mandatory and occurs up to 200,000 times per invoice trandated (once for each
lineitem invoiced).

Procedure  Usethis procedure to create the INVDETAIL record.

Step

Action

1

Highlight the INVCommentGroup. From the Edit menu, select Insert.
From the submenu, select Record to display the Positional Record
Properties dialog box.

In the Name box, type “INVDETAIL” asthe record identification code.

In the Desc box, type “Detail Record” as a description of the record. This
box is used to provide a brief explanation of the record that allows you to
differentiate it from similar records.

Select the Tag tab.

In the Tag box, type “DET” as the record identification code <TAG>. For
example, arecord is recognized by the system as:

<TAG>[Fi el d_1][Fiel d_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

Select the L ooping tab.

In the Min Usage box, type “1” to make the record mandatory. This box
contains the minimum number of times the record must repeat.

In the Max Usage box, type “200000” as the maximum number of times
the record can repeat.

10

Click OK to create the INVDETAIL record.
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How to Createthe INVSUMMARY Record

Overview  Thefinal record that you need to create is the INVSUMMARY (summary) record, which
is at the same level asthe INVDETAIL record.

The INVSUMMARY (summary) record contains the total invoice amount and the total
transaction amount. The summary record is mandatory and occurs once per invoice

trandlated.

Procedure  Usethis procedure to create the INVSUMMARY record.

Step

Action

1

Highlight the INVDETAIL record. From the Edit menu, select Insert.
From the submenu, select Record to display the Positional Record
Properties dialog box.

In the Name box, type “INVSUMMARY” as the record identification
code.

In the Desc box, type “ Summary Record” as a description of the record.
Thisbox is used to provide a brief explanation of the record that allows
you to differentiate it from similar records.

Select the Tag tab.

In the Tag box, type “SUM” asthe record identification code <TAG>. For
example, arecord is recognized by the system as:

<TAG>[Fi el d_1][Fiel d_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

Select the L ooping tab.

In the Min Usage box, type “1” to make the record mandatory. This box
contains the minimum number of times the record must repeat.

Accept the default of “1” in the Max Usage box. Thisisthe maximum
number of times the record can repeat.

10

Click OK to create the INVSUMMARY record.

Now that you have created the record structure of the application file, you can define the
application fields.
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Current map  Theapplication side of the map (input) should now look like this:
structure

THINPUT -M - 1 Input Record
::HEﬁ«DEH -M - 1 Header Fiecord
IMYBEGIM - b - 1 Beginning Record
— (& |MYCommentGroup - M - 1 Comrment Group
'::IN"-J'EEIMMENT'I - - 1 Header Comment Record 1
IMYVCOMMEMTZ - M - 10 Header Comment Record 2
:zINVDET.-'-‘-.IL - - 200000 Detal Record
[MYSUMMARY - M - 1 Summary Record
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Creating the Application Fields

Overview

Introduction Each record you create contains a group of logically-related application fields. These
fields define the structure and content of the data that your system needs to process the
invoice.

The easiest way to add application fields to arecord isto use the Positional Field Editor.

Generally, you create the fields for each sequential record, starting with the INVBEGIN
record.

Record Layout  Thistable lists and describes the application fields that you need to create.

Table
Mand Data Min M ax
Field Name (x=Yes) Description Type Length | Length
Header Record (HEADER) 1 per document
PARTNER_ID X Partner Identifier String 1 9
STANDARD X Standard String 1 1
VERSION X Version String 6 6
TRANSACTION_SET | X Transaction Set String 1 6
TEST_PROD X Test/Production Flag String 1 1
Beginning Record (INVBEGIN) 1 per document
BILLTOACCTBEG X Bill to Acct Number String 1 9
DOCTYPBEG X Document Type String 1 6
INVNUMBEG X Invoice Number String 1 10
INVDATE X Invoice Date Dt/Tm 6 6
(YYMMDD)
PONUM Purchase Order Number String 0 20
PODATE Purchase Order Date Dt/Tm 6 6
(YYMMDD)

VENDNAME Vendor Name String 0 35
VENDADD1 Vendor Address Line 1 String 0 35
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Overview
(Contd) Mand Data Min M ax
Field Name (X=Yes) Description Type Length | Length

VENDADD2 Vendor Address Line2 String 0 35
VENDCITY Vendor City String 0 30
VENDSTATE Vendor State String 0 2
VENDPOSTALCODE Vendor Postal Code String 0 9
SHIPTONAME Ship To Name String 0 35
SHIPTOADDL1 Ship To Address Line 1 String 0 35
SHIPTOADD2 Ship To Address Line2 String 0 35
SHIPTOCITY Ship To City String 0 30
SHIPTOSTATE Ship To State String 0 2
SHIPTOPOSTAL Ship To Postal Code String 0 9
CODE

SHIPTOLOC Ship To Store Location String 0 9
SHIPTODEPTNUM Ship To Dept Number String 0 4
REMITTONAME Remit To Name String 0 35
REMITTOADD1 Remit To AddressLine 1 String 0 35
REMITTOADD?2 Remit To AddressLine 2 String 0 35
REMITTOCITY Remit To City String 0 30
REMITTOSTATE Remit To State String 0 2
REMITTOPOSTAL Remit To Postal Code String 0 9
CODE

BOLNUM Bill of Lading Number String 0 12
SHIPDATE Ship Date Dt/Tm 6 6

(YYMMDD)

TERMS WHOLE Terms Percent Whole Number (N2) | O 3
TERMSNETDUE Terms Net Due Days Number (NO) | O 3
TERMSDISDUE Terms Discount Due Days | Number (NO) | O 3

Comment Group (INVCommentGroup) 1 per document

Comment Record 1 (INVCOMMENT1) 1 per document
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(Contd) Mand Data Min M ax
Field Name (X=Yes) Description Type Length | Length
BILLTOACCTCM1 X Bill To Acct Number String 1 9
DOCTYPCM1 X Document Type String 1 6
INVNUMCM1 X Invoice Number String 1 10
REFNUM X Reference Number String 1 30
Comment Record 2 (INVCOMMENT?2) 10 per document
BILLTOACCTCM2 X Bill To Acct Number String 1 9
DOCTYPCM2 X Document Type String 1 6
INVNUMCM2 X Invoice Number String 1 10
MESSAGETEXT X Message Text String 1 232
Detail Record (INVDETAIL) up to 200,000 per document
BILLTOACCTDET X Bill To Acct Number String 1 9
DOCTYPDET X Document Type String 1 6
INVNUMDET X Invoice Number String 1 10
ITEMNUM X [tem Number (Our Item) String 1 6
QTYSHIP X Quantity Shipped Number (NO) | 1 5
QTYORD X Quantity Ordered Number (NO) | 1 5
UNITPRICE X Unit Price Number (N2) | 1 7
UoM X Unit of Measure String 1 4
CUSTPROCODE X Customer Product Code String 1 10
UPCCODE X UPC Code String 1 12
ITEMDESC Item Description String 0 30
TERMSTY PE Terms Type Code String 0 2
TERMSDISP Terms Discount Percent Number (N2) | O 6
Summary Record (INVSUMMARY) 1 per document

BILLTOACCTSUM X Bill To Acct Number String 1 9
DOCTYPSUM X Document Type String 1 6
INVNUMSUM X Invoice Number String 1 10
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(Contd) Mand Data Min M ax
Field Name (X=Yes) Description Type Length | Length
TOTALAMOUNT X Total Monetary Value Number (N2) | 1 10
Summary
TRANSTOTAL X Transaction Totals Number (NO) | 1 6
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How to Createthe INVBEGIN Record Application Fields

Overview  You dready created the fields for the HEADER record in the system import map, and then
copied the fields to the import map and removed the standard rules from those fields.
Therefore, the first record for which you need to define fields, is the INVBEGIN record.

Procedure  Usethis procedure to create the application fields for the INVBEGIN record.

Step

Action

Right-click the INVBEGIN application record to access the shortcut
menu.

From the shortcut menu, select Edit Fields to access the Positional Field
Editor dialog box.

If the field you are creating is the first field in the record, click New. A
highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field valuesin the Field Details section.

In the Name box, type “BILLTOACCTBEG”, which is the name of the
first field in the INVBEGIN record. Each application field must have a
unique name. It is useful to tag the end of the fields that occur in multiple
records with a suffix that identifies the record that containsiit. For
example, “BEG” for the Beginning record.

Select the Mandatory check box to identify it asarequired field.

In the Description box, type “Bill To Account Number” as the description
of the field. The description is used to provide a brief explanation of the
field that allows you to differentiate it from similar fields.

From the Data Type list, select “ String” as the type of the field, to specify
that thisfield must contain a phanumeric data.

Note

If you wanted to indicate the exact position of the field in the record, you
would type the starting position of the field in the Start Pos box. You want
to specify field start positionsif, for example, you are only using afew
fields but you want them positioned exactly in the record.

In this tutorial, you use the alternative to specifying the start position of
each field, which isto add the fields sequentially in the record and then
use the Auto Position function. Please see step 14 below for more
information about the Auto Position function.

If the Data Typeis“Number” or “Dt/Tm,” select the appropriate format
from the Format list.

Sterling Gentran:Server — May 2011
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How to Create the INVBEGIN Record Application Fields

(Contd)
Sep

Action

9

In the Min Length box, type “1” as the minimum field length. If the
minimum length of the field is“0,” then accept that default in the Min
length box.

10

In the Max Length box, type“9” as the maximum length of the field.

11

To add the field and create the next field positioned after it, press Enter. A
new field with blank values ready for you to identify is positioned below
thefield.

12

Create the rest of the fields according to the Record Layout Table on
page 3 - 62.

Note

If you press ENTER after typing the information for the last field in the
record, ablank field is created. Click Delete and then Yesto delete the
blank field.
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(Contd)
Sep

Action

13

After adding the last field, click Auto Position to automatically position
the fieldsin the record. This automatically calculates the start position in
the record of each field based on the criteria that each field is positioned
directly after the previousfield and is of the length specified in the Max
Length box. Click Yesto acknowledge the warning message that fields are
sequenced in order.

Caution

Please note that it is only valid to use the Auto Position function if you
define arecord tag on the Positional Record Properties dialog box, and if
you define every field in the record in the sequence that each field occurs,
asyou are doing in thistutorial.

The Positional Field Editor dialog box should now look like the
following:

Positional Field Editor [ %]
 Record
Mame [NWBEGIM Tag BEG Tag Poz 1
Cancel |
— Field Details
MName IBILLTDAEETBEG ¥ Mardatar
Deseription IBiII To Acct Mumber
Diata Type IString 'I Farmat IX
Start Poz |4 tin Length |1 tax Length IS
-~ Fields
Mame M/AC Tupe Stat  Len Mew
BILLTOACCTREG 3 Del
DOCTYPREG k4 Sting 13 [3 iz |
INWNUMEEG I Sting 19 10
INWDATE M Date/Time 29 5 Auto Position |
PONLUM C  Sting 35 20
PODATE C  Date/Time 55 G
WENDMAME C  Sting E1 35
WENDADD1 C  Sting 96 35
WENDADD 2 C  Sting 131 3
WENDCITY C  Sting 166 30
WENDSTATE C  Sting 196 2 ﬂ
MCRIMDOCTAL SONE [ [ PHePY 0o a

14

When you are completely finished adding fieldsto the INVBEGIN record,
click Close.
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How to Create the INVCOMMENT1 Record Application Fields

How to Createthe INVCOMMENT 1 Record Application

Fields

Procedure  Usethis procedure to create the application fields for the INVCOMMENT1 record.

Step

Action

Right-click the INVCOMMENT?1 application record to access the
shortcut menu.

From the shortcut menu, select Edit Fields to access the Positional Field
Editor dialog box.

If the field you are creating is the first field in the record, click New. A
highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details section.

In the Name box, type “BILLTOACCTCM?1”, which is the name of the
first field in the INVCOMMENT?1 record. Each application field must
have a unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that containsit. For
example, “CM1” for the first comment record.

Select the Mandatory check box to identify it asarequired field.

In the Description box, type “Bill To Account Number” as the description
of the field. The description is used to provide a brief explanation of the
field that allows you to differentiate it from similar fields.

From the Data Type list, select “ String” as the type of the field, to specify
that thisfield must contain a phanumeric data.

If the Data Typeis“Number” or “Dt/Tm,” select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length. If the
minimum length of thefield is“0,” then accept that default in the Min
Length box.

10

In the Max Length box, type“9” as the maximum length of the field.

11

To add thefield and to create the next field positioned after it, press Enter.
A new field with blank values ready for you to identify is positioned
below thefield.
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(Contd)
Sep Action
12 Create the rest of the fields according to the Record Layout Table on
page 3 - 62.
Note

If you press ENTER after typing the information for the last field in the
record, ablank field is created. Click Delete and then Yesto delete the
blank field.

13 After adding the last field, click Auto Position to automatically position
the fieldsin the record. This automatically calcul ates the start position in
the record of each field based on the criteria that each field is positioned
directly after the previousfield and is of the length specified in the Max
Length box. Click Yesto acknowledge the warning message that fields are
sequenced in order.

14 When you are completely finished adding fields to the INVCOMMENT1
record, click Close.
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How to Create the INVCOMMENT2 Record Application Fields

How to Createthe INVCOMMENT2 Record Application

Fields

Procedure  Usethis procedure to create the application fields for the INVCOMMENT2 record.

Step

Action

Right-click the INVCOMMENT?2 application record to access the
shortcut menu.

From the shortcut menu, select Edit Fields to access the Positional Field
Editor dialog box.

If the field you are creating is the first field in the record, click New. A
highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details section.

In the Name box, type “BILLTOACCTCM?2", which is the name of the
first field in the INVCOMMENT?2 record. Each application field must
have a unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that containsit. For
example, “CM2” for the second comment record.

Select the Mandatory check box to identify it asarequired field.

In the Description box, type “Bill To Account Number” as the description
of the field. The description is used to provide a brief explanation of the
field that allows you to differentiate it from similar fields.

From the Data Type list, select “ String” as the type of the field, to specify
that thisfield must contain a phanumeric data.

If the Data Typeis“Number” or “Dt/Tm,” select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length. If the
minimum length of thefield is“0,” then accept that default in the Min
Length box.

10

In the Max Length box, type“9” as the maximum length of the field.

11

To add thefield and to create the next field positioned after it, press Enter.
A new field with blank values ready for you to identify is positioned
below thefield.
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(Contd)
Sep Action
12 Create the rest of the fields according to the Record Layout Table on
page 3 - 62.
Note

If you press ENTER after typing the information for the last field in the
record, ablank field is created. Click Delete and then Yesto delete the
blank field.

13 After adding the last field, click Auto Position to automatically position
the fieldsin the record. This automatically calcul ates the start position in
the record of each field based on the criteria that each field is positioned
directly after the previousfield and is of the length specified in the Max
Length box. Click Yesto acknowledge the warning message that fields are
sequenced in order.

14 When you are completely finished adding fields to the INVCOMMENT2
record, click Close.
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How to Createthe INVDETAIL Record Application Fields

Procedure  Usethis procedure to create the application fields for the INVDETAIL record.

Step

Action

Right-click the INVDETAIL application record to access the shortcut
menu.

From the shortcut menu, select Edit Fields to access the Positional Field
Editor dialog box.

If the field you are creating isthe first field in the record, click New. A
highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details section.

In the Name box, type “BILLTOACCTDET”, which is the name of the
first field in the INVDETAIL record. Each application field must have a
unique name. It is useful to tag the end of the fields that occur in multiple
records with a suffix that identifies the record that containsit. For
example, “DET” for the detail record.

Select the Mandatory check box to identify it as arequired field.

In the Description box, type “Bill To Account Number” as the description
of the field. The description is used to provide a brief explanation of the
field that allows you to differentiate it from similar fields.

From the Data Type list, select “ String” as the type of the field, to specify
that this field must contain a phanumeric data.

If the Data Typeis“Number” or “Dt/Tm,” select the appropriate format
from the Format list.

In the Min Length box, type“1” asthe minimum field length. If the
minimum length of thefield is“0,” then accept that default in the Min
Length box.

10

In the Max Length box, type “9” as the maximum length of the field.

11

To add thefield and to create the next field positioned after it, press Enter.
A new field with blank values ready for you to identify is positioned
below thefield.

12

Create the rest of the fields according to the Record Layout Table on
page 3 - 62.

Note

If you press ENTER after typing the information for the last field in the
record, ablank field is created. Click Delete and then Yes to delete the
blank field.
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(Contd)
Sep Action

13 After adding the last field, click Auto Position to automatically position
the fieldsin the record. This automatically calculates the start position in
the record of each field based on the criteria that each field is positioned
directly after the previousfield and is of the length specified in the Max
Length box. Click Yesto acknowledge the warning message that fields are
sequenced in order.

14 When you are completely finished adding fields to the INVDETAIL
record, click Close.
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How to Createthe INVSUMMARY Record Application

Fields

Procedure  Usethis procedure to create the application fields for the INVSUMMARY record.

Step

Action

Right-click the INVSUMMARY application record to access the shortcut
menu.

From the shortcut menu, select Edit Fields to access the Positional Field
Editor dialog box.

If the field you are creating is the first field in the record, click New. A
highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field valuesin the Field Details section.

In the Name box, type “BILLTOACCTSUM”, which is the name of the
first fieldinthe INVSUMMARY record. Each application field must have
aunigque name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that containsit. For
example, “SUM” for the summary record.

Select the Mandatory check box to identify it asarequired field.

In the Description box, type “Bill To Account Number” as the description
of thefield.

From the Data Type list, select “ String” as the type of the field, to specify
that thisfield must contain al phanumeric data.

If the Data Typeis“Number” or “Dt/Tm,” select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length. If the
minimum length of thefield is“0,” then accept that default in the Min
Length box.

10

In the Max Length box, type“9” as the maximum length of the field.

11

To add thefield and to create the next field positioned after it, press Enter.
A new field with blank values ready for you to identify is positioned
below thefield.

12

Create the rest of the fields according to the Record Layout Table on
page 3 - 62.

Note

If you press ENTER after typing the information for the last field in the
record, ablank field is created. Click Delete and then Yes to delete the
blank field.
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(Contd)
Sep Action

13 After adding the last field, click Auto Position to automatically position
the fieldsin the record. This automatically calculates the start position in
the record of each field based on the criteria that each field is positioned
directly after the previousfield and is of the length specified in the Max
Length box. Click Yesto acknowledge the warning message that the fields
are sequenced in order.

14 When you are completely finished adding fields to the INVSUMMARY
record, click Close.
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Overview

Mapping Your Data

Overview

Introduction

HEADER record

BILLTOACCTBE
G field

DOCTYPBEG
field

Each record in the import map contains a group of logically-related application fields.
These fields contain the information that your system needs to generate the invoice. The
group contains |logically-related application records.

Each record (except the HEADER record that you defined for the system import map
using an explicit six-field key) contains athree-field record key that ensures that the same
identifying information is located at the beginning of each record. Your application file
format contains arecord key so that each record can beidentified individually. The record
key for thisinvoice consists of your partner’s hill to account number, the document type,
and the invoice number.

This section examines each application field sequentially and describes the mapping
operations that you need to perform to map the appropriate data from each field.

For the import map, you will not map from any of the fieldsin the HEADER (header)
record. This record contains the five fields that comprise the key in the system import
map. However, since this header record isapart of your application file, it must be defined
in the import map, aswell. You did this when you copied the HEADER record from the
system import map to thisimport map. This header record is mandatory and occurs only
once.

The BILLTOACCTBEG field is part of the application file format key, but does not
contain data that the system needs to use to generate the invoice. Therefore, you do not
perform any mapping operations on this field.

The DOCTYPBEG field is part of the application file format key, but does not contain
data that the system needs to use to generate the invoice. Therefore, you do not perform
any mapping operations on thisfield.
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How to Map the INVBEGIN Record
Overview

Introduction This section describes the actions necessary for you to map from each field in the
INVBEGIN (beginning) record. The INVBEGIN record contains the purchase order
number and date; the vendor, ship to, and remit to address information; and the bill of

lading number, ship date, and term of the invoice. The beginning record is mandatory and
occurs once for each invoice.
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How to Map the INVNUMBEG Field

How to Map the INVNUMBEG Fidld

Overview

Mapping the
invoice number

Setting up the
document name

Procedure

You can map the INVNUMBEG field directly to the BIG02 (Invoice Number) field, by
using the Link function. The Link function alows you to map afield or element from the
Input side of the map to afield or element on the Output side of the map. The link between
the two fieldsis visually represented with aline connecting the two fields.

Also, we recommend that you set up a Document Name for each map, to make the
identification of a document created by this map easier in Sterling Gentran:Server. This
allowsyou to differentiate between documents in the document browsersin Sterling
Gentran: Server.

Recommendation

We strongly recommend that you select an element or field that occurs only oncein the
document and has a data type of “ String.” For an Invoice, the document nameis typically
the Invoice Number.

Link the application field INVNUMBEG in the INVBEGIN record to the BIG02 element
in the BIG segment.

To set up aDocument Name, you must select an element or field in the map that contains
data that distinguishes the documents translated by this map. Then, the Namefield of the
document browsers that contain this document contains the data from the selected element
or field.

Use this procedure to set up the Document Name for this Invoice.

Sep Action
1 Double-click the BIG02 (0076) element to display the Element Properties
dialog box
2 Select the Sandard Rule tab.
3 From the standard rule list, select Update.
4 From thetablelist, choose “ Document record.” Thisindicatesthat you are
updating the document record in Sterling Gentran: Server.
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(Contd)
Sep

Action

5

From the column list, select “Document Name.” This indicates that you
are updating the Name field in the document browsers with the contents of
this element.

The Standard Rule tab of the Element Properties dialog box should now
look like this:

Element Properties [ %]

Mame | Validation | Extended Rule  Standard Rule I Conditions |

Flease select the standard rule to use : IUpdate j

Pleaze zelect the table [or group) to update :
I D ocument record j

Flease select the colurnn [or field) to update :
I Document Mame j

Cancel Help

Click OK to set up the document name.
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How to Map the INVDATE Field

Overview  You can map the INVDATE field directly to the BIGO1 (Invoice Date) field, by using the
Link function.

Procedure  Link the application field INVDATE in the INVBEGIN record to the BIG01 element in
the BIG segment.
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How to Map the PONUM Field

Overview  You can map the PONUM field directly to the BIG04 (Purchase Order Number) field, by
using the Link function. The Link function alows you to map afield or element from the
Input side of the map to afield or element on the Output side of the map. The link between
the two fieldsis visually represented with aline connecting the two fields.

Also, we recommend that you set up a Document Reference for each map, to make the
identification of a document created by this map easier in Sterling Gentran:Server. This
allows you to differentiate between documents in the document browsersin Sterling
Gentran: Server.

Recommendation

You can choose any element or field as the Document Reference, but we strongly
recommend that you select an element or field that occurs only once in the document and
has a data type of “ String.” For an Invoice, the document reference is typically the
Purchase Order Number.

Procedure  Link the application field PONUM in the INVBEGIN record to the BIG04 element in the
BIG segment.
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How to Set Up the Document Reference

Overview  To set up aDocument Reference, you must select an element or field in the map that
contains data that distinguishes the documents translated by this map. If you set up the
Reference in the Application Integration subsystem, the RefData field of the document
browsersthat contain this document in Sterling Gentran: Server contains the data from that

mapped field.

Procedure  Usethis procedure to set up the Document Reference for thisinvoice.

Step

Action

1

Double-click the BIG04 (0324) element to display the Element Properties
dialog box.

Select the Sandard Rule tab.

From the standard rule list, select Update.

From thetablelist, choose “ Document record.” Thisindicatesthat you are
updating the document record in Sterling Gentran: Server.

From the column list, select “Reference Data.” Thisindicatesthat you are
updating the RefData field in the document browsers with the contents of
this element.

Click OK to set up the document reference.
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How to Map the PODATE Field

Overview  You can map the PODATE field directly to the BIGO3 (Purchase Order Date) field, by
using the Link function.

Procedure  Link the application field PODATE in the INVBEGIN record to the BIGO03 element in the
BIG segment.
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Mapping Shipping and Billing Information

Overview

Introduction

A loop isagroup of two or more segments that repeat, in sequence, more than once. The
N1 group contains vendor, shipping, and billing name and address information, and
repeats multiple times. Your application file contains Vendor, Ship To, and Remit To
information that you need to map to the N1 group. However, you can only map fields and
elementsthat are at the same level. This means that you cannot map from a non-repeating
record to a group. Specifically, you cannot map the vendor, shipping, and remittance
information in the INVBEGIN record directly to the N1 group, because the INVBEGIN
record does not repeat. Also, you cannot map to the N3 (address information) repeating
segment from your application file Ship To fields (which arein the INVBEGIN record that
does not repeat).

Therefore, to map vendor, shipping, and remittance information from your application file
format, you must create three single iterations of the N1 group, so that the links between
the application fields in the INVBEGIN record and the N1 groups are valid. The Split
function extracts the specified number of iterations (instances) of a group (or repeating
segment). This enables you to map unique data from your application file and enter a
specialized definition for each N1 group (N1 _Vendor, N1 _ShipTo, and N1_RemitTo).

You can then map a constant to the Entity Identifier Code (in the N1 segment) for each
iteration of the N1 group. If the Entity Identifier Codeis“VN,” that iteration of the N1
group contains shipping information. You need to map the Vendor name and addressfields
in your application file format to the N1 _Vendor group. If the Entity Identifier Codeis
“ST,” that iteration of the N1 group contains shipping information. You need to map the
Ship To name and addressfieldsin your application file format to the N1_ShipTo group. If
the Entity Identifier Codeis“RI,” that iteration of the N1 group contains remittance
information. You need to map the remittance name and address fieldsin your application
file format to the N1_RemitTo group.
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How to Change the Max Use of the N3 Segment

Overview  You cannot map from your application file format Vendor, Ship To, and Remit To fields
(which arein the INVBEGIN record that does not repeat) to the N3 (address information)
repeating segment. Therefore, before you split the N1 group, you need to change the
maximum usage of the N3 segment from “2” to “1” (to make the N3 a non-repeating
segment for each iteration of the group).

Procedure  Usethis procedure to make the N3 a non-repeating segment.

Sep Action
1 Right-click the N3 segment (in the N1 group) to access the shortcut menu.
2 From the shortcut menu, select Properties to access the EDI Segment

Properties dialog box.

3 Select the L ooping tab.

4 In the Max Usage box, type “1” to make the N3 a non-repeating segment.
Thisbox is currently set to “2.”

5 Click OK to accept the change to the N3 segment.
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How to Split the N1 Group

Overview  You cannot map from anon-repeating record (INVBEGIN) to agroup (N1). Therefore, to
map vendor, shipping, and remittance information from your application file format, you
must split three single iterations of the N1 group, so that the links between the application
fieldsin the INVBEGIN record and the N1 groups are valid.

Procedure  Usethis procedure to map to split threeiterations of the N1 group and add specialized

definitions.

Step

Action

1

Highlight the N1 group.

Click the Split button on the Main Toolbar. The Split dialog box is
displayed.
Split ]

First Loop Entries |0

Cancel |

In the First Loop Entries box, type “1” to indicate the sequential number
of iterations where you want the group or repeating segment split.

Click OK to exit the Split dialog box.

From the Edit menu, select Properties to access the Group Properties
dialog box for the new group.

In the Name box, type “N1_Vendor”, which is a specialized definition to
identify this group as containing vendor information.

Click OK to save the change and exit the Group Properties dialog box.

Highlight the original N1 group (that now repeats 199 times) again.

Click the Split button on the Main Toolbar to extract another single
instance of the N1. The Split dialog box is displayed.

10

In the First Loop Entries box, type “1” to indicate the sequential number
of iterations where you want the group or repeating segment split.

11

Click OK to exit the Split dialog box.

12

From the Edit menu, select Properties to access the Group Properties
dialog box for the new group.

13

In the name box, type “N1_ShipTo”, which is a specialized definition to
identify this group as containing shipping information.

Application Integration ANSI Tutorial Guide
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(Contd)
Sep

Action

14

Click OK to save the change and exit the Group Properties dialog box.

15

Highlight the original N1 group (that now repeats 198 times) again.

16

Click the Split button on the Main Toolbar to extract another single
instance of the N1. The Split dialog box is displayed.

17

In the First Loop Entries box, type “1” to indicate the sequential number
of iterations where you want the group or repeating segment split.

18

Click OK to exit the Split dialog box.

19

From the Edit menu, select Properties to access the Group Properties
dialog box for the new group.

20

In the Name box, type “N1 RemitTo”, which is the specialized definition
to identify this group as containing remittance information.

21

Click OK to save the change and exit the Group Properties dialog box for
the new group.

22

Click the Deactivate button on the Main Toolbar and then click the
original N1 group (that now repeats 197 times), so the system does not
processit.

23

Click the REF:6 segment (in the N1_Vendor group) so the system does
not processit.

24

Click the Deactivate button on the Main Toolbar again to turn the
Deactivation mode off.

25

Double-click the N1_RemitTo group to open it.

26

Click the Deactivate button.

27

Click the REF:8 segment (in the N1_RemitTo group) so the system does
not processit.

28

Click the Deactivate button on the Main Toolbar again to turn the
Deactivation mode off.
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How to Set the Entity Identifier Code

Overview

Setting the entity
identifier code for
N1 _Vendor group

Setting the entity
identifier code for
N1 ShipTogroup

Application Integration ANSI Tutorial Guide

You need to set the Entity Identifier Code for the N1_Vendor, N1_ShipTo, and
N21_RemitTo groups, so the system is able to distinguish the type of hame and address
information each N1 group should contain.

You already defined all the constants that you are using in this map, so now you can map
the appropriate constant to each Entity |dentifier Code element.

Use this procedure to set the Entity Identifier Code for the N1_Vendor group.

Sep Action

1 Double-click the N1:301 element (Entity Identifier Code) in the N1:3
segment to access the Element Properties dialog box.

2 Select the Standard Rule tab.

3 From the standard rule list, select Use Constant.

4 From the Constants list, select the“VN” constant, to identify thisiteration
of the N1 group as containing vendor name and address information.

5 From the Qualifieslist, select the “0093:5 NAME,” to set up aqualifying
relationship with the Name element.
Note
The Qualifieslist contains only the other active el ements in the same
segment as the qualifying element.

6 Click OK and the“VN" codeisloaded to the Entity Identifier Code
element and the qualifying relationship between the N1:301 and N1:302
elementsiis established.

Use this procedure to set the Entity Identifier Code for the N1_ShipTo group.

Sep Action
1 Double-click the N1:401 element (Entity Identifier Code) in the N1:4
segment to access the Element Properties dialog box.
2 Select the Sandard Rule tab.
3 From the standard rule list, select Use Constant.
4 From the Constants list, select the “ST” constant, to identify thisiteration
of the N1 group as containing shipping name and address information.
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(Contd)
Sep Action
5 From the Qualifieslist, select the“0093:21 NAME,” to set up aqualifying
relationship with the Name element.
6 Click OK and the“ST” codeisloaded in the Entity Identifier Code
element and the qualifying relationship between the N1:401 and N1:402
elementsis established.

Setting theentity  Usethis procedure to set the Entity Identifier Code for the N1_RemitTo group.
identifier code for

N1 _RemitTo group Step Action
1 Double-click the N1:501 element (Entity Identifier Code) in the N1:5
segment to access the Element Properties dialog box.
2 Select the Sandard Rule tab.
3 From the standard rule list, select Use Constant.
4 From the Constants list, select the “RI” constant, to identify thisiteration

of the N1 group as containing vendor name and address information.

5 From the Qualifieslist, select “0093:85 NAME,” to set up aqualifying
relationship with the Name element.

6 Click OK and the“RI” code isloaded in the Entity Identifier Code
element and the qualifying relationship between the N1:501 and the
N1:502 elements is established.
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How to Map the Vendor Application Fields

Overview  Now you can link the elements in your Vendor application fields in the single occurrence
of the INVBEGIN record to the appropriate single occurrence of the N1 that contains
vending information (N1_Vendor). You can link the elementsin your Ship To application
fieldsin the single occurrence of the INVBEGIN record to the appropriate single
occurrence of the N1 that contains shipping information (N1_ShipTo). And, you can link
the elementsin your RemitTo application fields in the single occurrence of the
INVBEGIN record to the appropriate single occurrence of the N1 that contains remittance
information (N1_RemitTo).

Application fields  Thistable liststhe application fieldsin the INVBEGIN record and the elements they are
and elements  mapped to.

To map the
application field Link thefield tothe
VENDNAME N1:302 element in the N1:3 segment (N1_Vendor group).
VENDADD1 N3:301 element in the N3:3 segment (N1_Vendor group).
VENDADD?2 N3:302 element in the N3:3 segment (N1_Vendor group).
VENDCITY N4:301 element in the N4:3 segment (N1_Vendor group).
VENDSTATE N4:302 element in the N4:3 segment (N1_Vendor group).

VENDPOSTALCODE | N4:303 element in the N4:3 segment (N1_Vendor group).

SHIPTONAME N1:402 element in the N1:4 segment (N1_ShipTo group).
SHIPTOADD1 N3:401 element in the N3:4 segment (N1_ShipTo group).
SHIPTOADD?2 N3:402 element in the N3:4 segment (N1_ShipTo group).
SHIPTOCITY N4.401 element in the N4:4 segment (N1_ShipTo group).
SHIPTOSTATE N4:40 element in the N4:4 segment (N1_ShipTo group).
SHIPTOPOSTAL N4:403 element in the N4:4 segment (N1_ShipTo group).
CODE
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Overview

Introduction  The SHIPTOLOC (ship to location) and the SHIPTODEPTNUM (ship to department
number) fields both contain additional reference information about the Ship To address.
Both fields are in the INVBEGIN record that occurs once. To map both these fields to the
REF:7 (reference) segment inthe N1_ShipTo group, which repeats twelve times, you must
promote asingleinstance of the REF segment, so that two target fields exists to which you
can map the SHIPTOLOC and SHIPTODEPTNUM. And, because the original REF
segment (REF:7) still repeats eleven times, you must change the maximum usage to one.
Therefore, alink between the INVHEADER and the origina REF segment (REF:7) is
valid.

You must also map a constant to the Reference Number Qualifier (REFO1 element) and
define a qualifying relationship with the Reference Number (REF02 element), for both
instances of the REF segment (REF:9 and REF:7). If the Reference Number Qualifier is
“DP" (department number), that iteration of the REF segment contains the ship to
department number. If the Reference Number Qualifier is“ST” (store number), that
iteration of the REF segment contains the ship to location.
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How to Promote the REF Segment

Overview  To map both the SHIPTOLOC and SHIPTODEPTNUM fields to the REF (reference)
segment in the N1_ShipTo group, which repeats twelve times, you must promote asingle
instance of the REF segment, so that two target fields exists to which you can map the
SHIPTOLOC and SHIPTODEPTNUM.

Procedure  Usethis procedure to map to promote a single instance of the REF segment.

Sep Action
1 Highlight the REF:7 segment in the N1_ShipTo group.
2 Click the Promote button on the Main Toolbar to extract a single instance
of the REF segment.
The REF:9 segment that only occurs once is extracted.
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How to Change the Max Use of the REF:7 Segment

Overview  Theorigina REF segment (REF:7) still repeats eleven times, so you need to change the
maximum usage to one. Therefore, alink between the INVHEADER and the original REF
segment (REF:7) isvalid.

Procedure  Usethis procedure to make the REF:7 a non-repeating segment.

Sep Action

1 Right-click the REF:7 Segment (in the N1_ShipTo group) to access the
shortcut menu.

2 From the shortcut menu, select Properties to access the EDI Segment
Properties dialog box.

3 Select the L ooping tab.

4 In the Max Usage box, type“1” to make the REF:7 a non-repeating
segment. This box is currently set to “11.”

5 Click OK to accept the change to the REF.7 segment.
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How to Set the Reference Number Qualifier

Overview  You must map aconstant to the Reference Number Qualifier (REFO1 element) and define
aqualifying relationship with the Reference Number (REFO02 element), for both instances
of the REF segment (REF:9 and REF:7).

You already defined all the constants that you are using in this map, so now you can map
the appropriate constant to each Reference Number Qualifier element.

Procedure  Usethis procedure to set the Reference Number Qualifier for the REF:9 segment.

(for REF:9)
Step

Action

1

Double-click the REF:901 element (Reference Number Qualifier) in the
REF:9 segment in the N1_ShipTo group, to access the Element Properties
dialog box.

Select the Sandard Rule tab.

From the standard rule list, select Use Constant.

From the Constants list, select the “DP” constant, to identify thisiteration
of the REF segment as containing the ship to department number.

From the Qualifieslist, select “0127:12 REFERENCE NUMBER,” to set
up aqualifying relationship with the Reference number element.

Click OK andthe“DP” codeisloaded in the Reference Number Qualifier
element and the qualifying relationship between REF:901 and REF:902
eementsis established.

Procedure  Usethis procedure to set the Reference Number Qualifier for the REF:7 segment.

(for REF:7)

Step

Action

Double-click the REF: 701 element (Reference Number Qualifier) in the
REF:7 segment in the N1_ShipTo group, to access the Element Properties
dialog box.

Select the Sandard Rule tab.

From the standard rule list, select Use Constant.

From the Constants list, select the “SN” constant, to identify thisiteration
of the REF segment as containing the store number.

From the Qualifieslist, select the “0127:10 REFERENCE NUMBER,” to
set up a qualifying relationship with the Reference Number element.

Application Integration ANSI Tutorial Guide
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(Contd)
Sep Action
6 Click OK andthe“SN” codeisloaded in the Reference Number Qualifier

element and the qualifying relationship between the REF:701 and
REF:702 elements is established.
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How to Map the Shipping Reference I nfor mation

Overview  After promoting the REF segment, changing the maximum usage, mapping constants to
the Reference Number Qualifier elements, and establishing the appropriate qualifying
relationship, you can map the SHIPTOLOC and SHIPTODEPTNUM fields.

Mapping the  Usethis procedure to map the SHIPTOLOC and SHIPTODEPTNUM fields.
SHIPTOLOC and .
SHIPTODEPT Sep Action

NUM fields 1 | Link the application field SHIPTOLOC in the INVBEGIN record to the
REF7:02 element in the REF:7 segment (N1_ShipTo group).

2 Link the application field SHIPTODEPTNUM in the INVBEGIN record
to the REF9:02 element in the REF:9 segment (N1_ShipTo group).

Mapping other  Thistable liststhe application fieldsin the INVBEGIN record and the elements they are
application fields ~ mapped to.

and elements
To map application field You must link

REMITTONAME N1:502 element in the N1:5 segment (N1_RemitTo
group).

REMITTOADD1 N3:501 element in the N3:5 segment (N1_RemitTo
group).

REMITTOADD?2 N3:502 element in the N3:5 segment (N1_RemitTo
group).

REMOTTOCITY N4:501 element in the N4:5 segment (N1_RemitTo
group).

REMITTOSTATE N4:502 element in the N4:5 segment (N1_RemitTo
group).

REMITTOPOSTALCODE N4:503 element in the N4:5 segment (N1_RemitTo
group).
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Mapping the Bill of Lading Number

Overview

Introduction You know that you only send one header REF segment to your trading partner (typically
the REF segment repeats up to 12 times). Therefore, after you change the max usage of the
REF segment to “1,” the BOLNUM (bill of lading number) field can be directly mapped
to the REFO2 element. However, you must map a constant to the Reference Number
Qualifier (REFO01 element) and define a qualifying relationship with the Reference
Number (REF02 el ement) to indicate that the REF02 contains the bill of lading number.
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How to Change the Max Use of the REF Segment

Overview  You have determined that you only send your partner one header REF segment (reference
information), so you must change the maximum usage allowed for that segment from “12”
to “ 1."

Procedure  Usethis procedure to make the REF a non-repeating segment.

Sep Action
1 Right-click the REF segment (in the header) to access the shortcut menu.
2 From the shortcut menu, select Properties to access the EDI Segment

Properties dialog box.

3 Select the L ooping tab.

4 In the Max Usage box, type “1” to make the REF a non-repeating
segment. This box is currently set to “12.”

5 Click OK to accept the change to the REF segment.
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How to Set the Reference Number Qualifier

Overview  You aready defined all the constants that you are using in this map, so now you can map
the appropriate constant to the Reference Number Qualifier element.

Procedure  Usethis procedure to set the Reference Number Qualifier for the REF segment.

Step

Action

1

Double-click the REF:01 element (Reference Number Qualifier) in the
REF segment to access the Element Properties dialog box.

Select the Sandard Rule tab.

From the standard rule list, select Use Constant.

From the Constantslist, select the“BM” constant, to identify thisiteration
of the REF segment as containing the bill of lading number.

From the Qualifieslist, select the“ 0127 REFERENCE NUMBER,” to set
up aqualifying relationship with the Reference Number element.

Click OK and the “BM” code is |oaded in the Reference Number
Qualifier element and the qualifying relationship between the REFO1 and
REFO02 elements is established.
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How to Map the BOLNUM Field

Overview  After mapping the constant to the Reference Number Qualifier element and establishing
the appropriate qualifying relationship, you can map the BOLNUM field.

Procedure  Link the application field BOLNUM in the INVBEGIN record to the REF02 element in
the REF segment.
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Mapping the Ship Date

Overview

Introduction  You know that you only send one header DTM segment to your trading partner (typically
the DTM segment repeats up to 10 times). Therefore, after you change the max usage of
the DTM segment to “1,” the SHIPDATE field can be directly mapped to the DTM02
element (in the DTM header segment). However, you must map a constant to the Date/
Time Qualifier (DTMO01 element) and define a qualifying relationship with the Date
(DTMO02 element) to indicate that the DTM02 contains the ship date.
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How to Changethe Max Use of the DTM Segment

Overview  You have determined that you only send your partner one header DTM segment (date/time
information), so you must change the maximum usage allowed for that segment from “10”
to “ 1."

Procedure  Usethis procedure to make the DTM a non-repeating segment.

Sep Action
1 Right-click the DTM segment (in the header) to access the shortcut menu.
2 From the shortcut menu, select Properties to access the EDI Segment

Properties dialog box.

3 Select the L ooping tab.

4 In the Max Usage box, type “1” to make the DTM a non-repeating
segment. This box is currently set to “10.”

5 Click OK to accept the change to the DTM segment.
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How to Set the Ship Date Qualifier

Overview  You aready defined all the constants that you are using in this map, so now you can map
the appropriate constant to the Date/Time Qualifier element.

Procedure  Usethis procedure to set the Date/Time Qualifier for the DTM segment.

Sep Action
1 Double-click the DTM:01 element (Date/Time Qualifier) in the DTM
segment to access the Element Properties dialog box.
2 Select the Sandard Rule tab.
3 From the standard rule list, select Use Constant.
4 From the Constants list, select the “DTM” constant, to identify this

iteration of the DTM segment as containing the bill of lading number.

5 From the Qualifieslist, select the “0373:6 DATE,” to set up aqualifying
relationship with the Date element.

6 Click OK and the “DTM” code is loaded in the Date/Time Qualifier
element and the qualifying relationship between the DTMO01 and DTM02
eementsis established.
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How to Map the SHIPDATE Field

Overview  After mapping the constant to the Date/Time Qualifier element and establishing the
appropriate qualifying relationship, you can map the SHIPDATE field.

Procedure  Link the application field SHIPDATE in the INVBEGIN record to the DTMO02 element in
the DTM segment.
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Mapping the Item Detail Information

Overview

Introduction You know that you only send one header ITD segment to your trading partner (typically
the ITD segment repeats up to 5 times). Therefore, after you change the max usage of the
ITD segment to “1,” the TERMS WHOLE field can be directly mapped to the ITDO3
element (in the ITD header segment).
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How to Changethe Max Use of the ITD Segment

Overview  You have determined that you only send your partner one header ITD segment (terms of
sale/deferred terms of sale), so you must change the maximum usage allowed for that
segment from “5” to “1.”

Procedure  Usethis procedure to make the ITD segment non-repeating.

Sep Action
1 Right-click the ITD segment (in the header) to access the shortcut menu.
2 From the shortcut menu, select Properties to access the EDI Segment

Properties dialog box.

3 Select the L ooping tab.

4 In the Max Usage field, type “1” to make the ITD anon-repeating
segment. Thisfield is currently set to “5.”

5 Click OK to accept the change to the ITD segment.
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How to Map the Terms Fields

Mappingthe  Link the application field TERMS_WHOLE in the INVBEGIN record to the ITD03
TERMS WHOLE  elementinthelTD segment (in the header).
field

Mappingthe Link the application field TERMSNETDUE in the INVBEGIN record to the ITDO7
TERMSNETDUE  elementinthelTD segment.
field

Mapping the  Link the application field TERMSDISDUE in the INVBEGIN record to the ITD05
TERMSDISDUE  elementinthe | TD segment.
field
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The INVComment Group: INVCOMMENT1 Record

Overview

Introduction The INVCommentGroup (comment information) groups all the comment information for
the invoice, including the reference number and the message text. The
INV CommentGroup occurs once per invoice translated. The information within the
INV CommentGroup is further segregated by record.

This section describes the actions necessary for you to map from each field in the
INVCOMMENTL (first comment) record. The INVCOMMENT1 record contains the
reference number. The first comment record is mandatory and occurs once per invoice
translated (once for each comment line).

Thesefields are part of the application file format key, but do not contain data that the
system needs to use to generate the invoice. Therefore, you do not perform any mapping
operations on these fields:

» BILLTOACCTCMI,
» DOCTYPCM1, and
» INVNUMCML
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How to Map the REFNUM Field

Overview  TheREFNUM field can be directly mapped to the N902 element (in the N9 segment in the
N9 group). However, you must map a constant to the Reference Number Qualifier (N901
element) and define a qualifying relationship with the Reference Number (N902 element)
to indicate that the N902 contains the reference number.

Settingthe  You dready defined al the constants that you are using in this map, so now you can map
reference number the appropriate constant to the Reference Number Qualifier element.

qualifier

Procedure  Usethis procedure to set the Reference Number Qudlifier for the N9 segment.

Sep Action
1 Double-click the N901 element (Reference Number Qualifier) in the N9
segment (N9 group), to access the Element Properties dialog box.
2 Select the Sandard Ruletab.
3 From the standard rule list, select Use Constant.
4 From the Constants list, select the“1V” constant, to identify thisiteration

of the REF segment as containing the reference number (related vendor
order number). This number isin addition to the primary order number.

5 From the Qualifieslist, select the “0127 REFERENCE NUMBER,” to set
up aquaifying relationship with the Reference Number element.

6 Click OK andthe“1V” codeisloaded in the Reference Number Qualifier
element and the qualifying relationship between the N901 and N902
elementsis established.

Mappingthe  After mapping the constant to the Reference Number Qualifier element and establishing
reference number the appropriate qualifying relationship, you can map the REFNUM field.

Link the application field REFNUM in the INVCOMMENT1 record to the N902 element
in the REF segment.
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The INVCommentGroup: INVCOMMENT?2 Record

Overview

Introduction This section describes the actions necessary for you to map from each field in the
INVCOMMENT2 (second comment) record. The INVCOMMENT?2 record contains
message text. The second comment record is mandatory and occurs up to ten times per
invoice translated (once for each comment line).

Thesefields are part of the application file format key, but do not contain data that the
system needs to generate the invoice. Therefore, you do not perform any mapping
operations on these fields:

» BILLTOACCTCMZ,
» DOCTYPCM2, and
» INVNUMCM2.
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How to Map the MESSAGETEXT Field

Procedure  Link the application field MESSAGETEXT in the INVCOMMENT?2 record to the
MSGO01 element in the MSG segment (N9 group).
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The INVCommentGroup: INVDETAIL Record

Overview

Introduction This section describes the actions necessary for you to map from each field in the
INVDETAIL (detail) record. The INVCOMMENT?2 record contains line item number and
description, quantity shipped, quantity ordered, unit of measure, price, product code, and
invoice terms. The detail record is mandatory and occurs up to 200,000 times per invoice
translated (once for each line item invoiced).

Thesefields are part of the application file format key, but do not contain data that the
system needs to generate the invoice. Therefore, you do not perform any mapping
operations on these fields:

» BILLTOACCDET
» DOCTYPDET
» INVNUMDET
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How to Map the Item Number

Overview  The I TEMNUM field can be directly mapped to the IT101 Assigned I dentification
element in the IT1 segment (IT1 group). However, you also need to calculate an
incremental count of the number of line items, and you want to use that total value in the
Number of Line Items Total field.

Procedure  Usethis procedure to count line items and generate a control total.

Step

Action

Double-click the IT101 element (in the IT1 segment in the IT1 group).
Thisisthefield that you typically use to count the line items. The Element
Properties dialog box is displayed.

Select the Sandard Rule tab.

From the standard rule list, select Use Accumulator.

Click New to access the Edit Accumulator Entry dialog box to create a
new calculation for this element.

Edit Accumulatar Emtry

Primany Acqumuistee | [=] Hamal | i |
peralione lm
Frsl | [2] semate Accu | (=]

sesnd H

Thid | B

Foulh | 2]

From the Primary Accumulator list, select “0.” Before any calculations
are performed on an accumulator, its content is“0” (zero). When you use
an accumulator, the system adds a new accumulator to the bottom of this
list.

Note

There isonly one set of accumulators for each map. This means that the
accumulator “0,” whether it is used in the Primary Accumulator or
Alternate Accum box is the same accumulator with the same contents. If
you assign calculations to accumulator “0” at the beginning of the map
and then use accumulator “0” again later in the map, the content of that
accumulator isthe result of the earlier calculation. Any additional
calculations you assign to that accumulator are performed on the contents
resulting from an earlier calculation.

In the Name box, type“Line Item Number.” Thisisadescriptive alias that
enables you to differentiate what the accumulators you create are used for.
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How to Map the Item Number

(Contd)
Sep

Action

7

From the First list, select “Increment primary.” Thisisthe first operation
that the system performs. This specifies that the system increments the
value in the accumulator by one for each iteration of the IT1 group.

Note
The First box is active only after you select a Primary Accumulator.

Click OK to add the accumul ator.

The Standard Rule tab of the Element Properties dialog box should now
look like this:

%]

Element Properties

Mame | Validation | Extended Rule  Standard Rule I Conditions |

I Use Accumulator j
Op2 0Op3 Opd

Uze

Pleass select the standard ule to use :

Op1
Inc

Primary Accumulator

0-Line Item Mumber Mew...
Change...

Delete

i

Cancel | Help |

Click OK onthe Element Properties dialog box to add the standard rule to
the IT101 element.

10

Double-click the CTTO1 element (in the CTT segment). Thisisthe field
that typically contains the total number of line items. The Element
Properties dialog box is displayed.

11

Select the Sandard Rule tab.

12

From the standard rule list, select Use Accumulator.

13

Click New to access the Edit Accumulator Entry dialog box to create a
new calculation for this element.

14

From the Primary Accumulator list, select primary accumulator “0.” This
accumulator currently contains the total number of line items.

Application Integration ANSI Tutorial Guide
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Outbound Invoice (810)

(Contd)
Sep

Action

15

From the First list, select “Use primary.” This specifiesthat the system
loads the current value of the accumulator into the CTTO1 (Number of
Line Items Total) element.

The Edit Accumulator Entry dialog box should now look like this:

Primar, dequruiser [0 [2] M ILinaIlJemNu'nbet | i |
peralices Im
Frsl  [Use may [2] Hiemate Aczum | [z

secnd | g
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16

Click OK to add the accumul ator.

17

Click OK onthefield Properties dialog box to add the standard rule to the

CTTO1 element.

The CTTO1 element now contains the total number of lineitemsin the

invoice.
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How to Map the I TEMNUM Field

Overview  After using an accumulator to calculate the incremental count of the number of lineitems,
you can map the ITEMNUM field directly to the IT101 element.

Procedure  Link the application field ITEMNUM in the INVDETAIL record to the IT101 element in
the IT1 segment (IT1 group).
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Outbound Invoice (810)

How to Map the Quantity Shipped

Overview

The QTY SHIPfield can be directly mapped to the I T102 Quantity Invoiced element in the

IT1 segment (IT1 group). However, you a so need to count the quantity invoiced for each
lineitem and load the total quantity in the CTTO02 (Hash Total) field.

Procedure

Use this procedure to count the quantity invoiced and generate a hash total.

Step

Action

Double-click the IT102 element (in the IT1 segment in the IT1 group).
Thisisthefield that you typically use to count the quantity invoiced. The
Element Properties dialog box is displayed.

Select the Sandard Rule tab.

From the standard rule list, select Use Accumulator.

Click New to access the Edit Accumulator Entry dialog box to create a
new calculation for this element.

From the Primary Accumulator list, select “1.” Before any calculations
are performed on an accumulator, its content is“0” (zero). When you use
an accumul ator, the system adds a new accumulator to the bottom of this
list.

In the Name box type “Total Quantity.” Thisis a descriptive alias that
enables you to differentiate what the accumulators you create are used for.

Fromthe First list, select “ Sum in primary.” Thisisthefirst operation that
the system performs. This specifiesthat the system adds the numeric value
(takes the positive or negative sign of the numbers into account) of the
field to the contents of the Primary Accumulator for each iteration of the
POL1 group.

The Edit Accumulator Entry dialog box should now look like this:

Priman Acourulstee |1 [2] Mama IToIaIE!uanlil_u | Dk |
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Click OK to add the accumulator.
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How to Map the Quantity Shipped

(Contd)
Sep

Action

9

Click OK onthe Element Properties dialog box to add the standard rule to
the 1T102 element.

10

Double-click the CTT02 element (in the CTT segment). Thisisthe field
that typically contains the total quantity of the purchase order. The
Element Properties dialog box is displayed.

11

Select the Sandard Rule tab.

12

From the standard rule list, select Use Accumulator.

13

Click New to access the Edit Accumulator Entry dialog box to create a
new calculation for this element.

14

From the Primary Accumulator list, select primary accumulator “1.” This
accumulator currently contains the total quantity.

15

From the First list, select “Use primary.” This specifies that the system
loads the current value of the accumulator into the CTTO02 (Hash Total)
element.

The Edit Accumulator Entry dialog box should now look like this:

Edit Aecumulatar Entry [
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16

Click OK to add the accumul ator.

17

Click OK on the Field Properties dial og box to add the standard rule to the
CTTO2 element.

The CTT02 element now contains the total quantity of the purchase order.
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How to Map the QTYSHIP Field

Overview  After mapping the using an accumulator to calculate the quantity invoiced for each line

item and generate a hash total, you can map the QTY SHIP field directly to the IT102
element.

Procedure  Link the application field QTY SHIP in the INVDETAIL record to the IT102 element in
the IT1 segment (IT1 group).
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How to Map the Quantity Ordered

Overview  You know that you only send one QTY segment (in the I T1 group) to your trading partner
(typicaly the QTY segment repeats up to 5 times). Therefore, after you change the max
usage of the QTY segment to “1,” the QTY ORD (quantity ordered) field can be directly
mapped to the QTY 02 element. However, you must map a constant to the Quantity
Qualifier (QTY 01 element) and define a qualifying relationship with the Quantity
(QTYO02 element) to indicate that the QTY 02 contains the quantity ordered.

Changingthemax  You have determined that you only send your partner one QTY segment (quantity), so you
useof theQTY must change the maximum usage allowed for that segment from “5” to “1.”

segment

Makingthe QTY  Usethis procedure to make the QTY a non-repeating segment.

segment non- -
repeatlng Sep Action

1 Right-click the QTY segment (in the IT1 group) to access the shortcut
menu.

2 From the shortcut menu, select Properties to access the EDI Segment
Properties dialog box.

3 Select the L ooping tab.

4 In the Max Usage box, type “1” to make the QTY anon-repeating

segment. This box is currently set to “5.”

5 Click OK to accept the change to the QTY segment.

Settingthe  You aready defined al the constants that you are using in this map, so now you can map
quantity qualifier  the appropriate constant to the Quantity Qualifier element.

Procedure  Usethis procedure to set the Quantity Qualifier for the REF segment.

Sep Action
1 Double-click the QTY 01 element (Quantity Qualifier) in the QTY
segment (I T1 group), to access the Element Properties dialog box.
2 Select the Sandard Ruletab.
3 From the standard rule list, select Use Constant.
4 From the Constants list, select the “OR” constant, to identify the Quantity

segment as containing the quantity ordered.
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(Contd)
Sep Action
5 From the Qualifieslist, select the “0380 QUANTITY,” toset up a
qualifying relationship with the Quantity element.
6 Click OK and the “OR” codeisloaded in the Quantity Qualifier element
and the qualifying relationship between the QTY 01 and QTY 02 elements
is established.
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How to Map the QTYORD Field

Overview  After mapping the constant to the Quantity Qualifier element and establishing the
appropriate qualifying relationship, you can map the QTY ORD field.

Procedure  Link the application field QTYORD in the INVDETAIL record to the QTY 02 element in
the QTY segment (IT1 group).
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How to Map the Unit Price

Overview

The UNITPRICE field can be directly mapped to the IT104 Unit Price element in the IT1

segment (1T1 group). However, you also need to multiply the quantity invoiced for each
lineitem by the unit price to obtain the extended price. You also need to generate a
running total of the extended price and load the final total in the TDSO01 (Total Invoice
Amount) element.

Obtaining the
extended price

Use this procedure to multiply the quantity invoiced for each line item by the unit price to
obtain the extended price.

Step

Action

1

Double-click the IT102 element (in the IT1 segment in the IT1 group).
Thisisthefield that you typically use to count the quantity invoiced. The
Element Properties dialog box is displayed.

Select the Sandard Rule tab.

Note
The Standard Rule list already shows that Use Accumulator is selected.

Click New to access the Edit Accumulator Entry dialog box to create a
new calculation for this element.

From the Primary Accumulator list, select “2.” This number isaname by
which the accumulator isreferred. Before any calculations are performed
on an accumulator, its content is“0” (zero). When you use an
accumulator, the system adds a new accumulator to the bottom of thislist.

In the Name box, type “Extended Price.” Thisis adescriptive aias that
enables you to differentiate what the accumulators you create are used for.

From the First list, select “Load primary.” Thisisthe first operation that
the system performs. This specifies that the system loads the contents of
the element group into the Primary Accumulator for each iteration of the
IT1 group

The Edit Accumulator Entry dialog box should now look like this:
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How to Map the Unit Price

(Contd)
Sep

Action

7

Click OK to add the accumul ator.

8

Click OK on the Element Properties dialog box to add the standard rule to
the 1T102 element.

Double-click the IT104 element (in the IT1 segment in the IT1 group).
Thisisthe field that contains the unit price for each lineitem. The
Element Properties dialog box is displayed.

10

Select the Sandard Rule tab.

11

From the standard rule list, select Use Accumulator.

12

Click New to access the Edit Accumulator Entry dialog box to create a
new calculation for this element.

13

From the list, select primary accumulator “2."

14

From the First list, select “Multiply with primary.” Thisisthefirst
operation that the system performs. This specifies that the system
multiplies the value of the IT104 (Unit Price) element with the contents of
the primary accumulator, and stores the result in the primary accumulator
for each iteration of the IT1 group.

The Edit Accumulator Entry dialog box should now look like this:

Ldit Accumulatar Lntry E3
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15

Click OK to add the accumulator.

16

Click OK on the Element Properties dialog box to add the standard rule to
the 1T104 element.

Tip

If there is an extended price element in your EDI file, you could load the
total from the extended price calculation into that element. To do this, you

need to use an accumulator on that extended price element that specifies
“Use primary” for accumulator 2.
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Generating a
running total

Outbound Invoice (810)

Use this procedure to generate a running total of the extended price.

Step

Action

Thisisthefield that contains the unit price for each line item. The

Double-click the IT104 element (in the IT1 segment in the IT1 group).

Element Properties dialog box is displayed.

The Standard Rule list already showsthat Use Accumulator is selected.

Select the Sandard Rule tab.

Note

Click New to access the Edit Accumulator Entry dialog box to create
another calculation for this element.

From the Primary Accumulator list, select primary accumulator “3.”

In the Name box, type “Running Total.”

the system adds the contents of the primary accumulator to the contents of

From the First list, select “Add primary to alternate.” This specifies that

the alternate accumul ator, and stores the result in the primary accumul ator
for each iteration of the IT1 group.

From the Alternate Accum list, select “2.” This operation specifies that
the system add the value of accumulator “2” (which contains the extended
price for aline item) to the value of accumulator “3.” The system stores
the sum in accumulator “3,” which therefore contains a running total of
the extended price with each iteration of the IT1 group.

The Edit Accumulator Entry dialog box should now look like this:

I-_dlt Acoumulatar Entry
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Click OK to add the accumul ator.

Click OK onthe Element Properties dialog box to add the standard rule to
the 1T104 element.
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Loading the
running total

How to Map the Unit Price

Use this procedure to load the running total of the extended price into the TDS01 (Total
Invoice Amount) element.

Step

Action

1

Double-click the TDS01 element (in the TDS segment). Thisisthe field
that contains the unit price for each line item. The Element Properties
dialog box is displayed.

Select the Sandard Rule tab.

From the standard rule list, select Use Accumulator.

Click New to access the Edit Accumulator Entry dialog box to create a
new calculation for this element.

From the list, select primary accumulator “3.”

From the First list, select “Use primary.” This specifiesthat the system
|oads the contents of the primary accumulator into the TDS01 (Total
Invoice Amount) element.

The Edit Accumulator Entry dialog box should now look like this:

Edit Accumulatar Entry =]
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Click OK to add the accumulator.

Click OK onthe Element Properties dialog box to add the standard rule to
the TDS01 element.
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How to Map the UNITPRICE Field

Overview  After using accumulators to multiply the quantity invoiced for each line item by the unit

price to obtain the extended price and generate a running total of the extended price, you
can map the UNITPRICE field directly to the IT104 element.

Procedure  Link theapplication field UNITPRICE inthe INVDETAIL record to the IT104 element in
the IT1 segment (IT1 group).
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How to Map the UOM Field

Procedure  Link theapplicationfield UOM inthe INVDETAIL record to the IT103 element inthe I T1
segment (1T1 group).
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Mapping the Customer Product Code and Your UPC Code

Overview

Introduction  You can map the CUSTPROCODE (customer product code) and UPCCODE (your UPC
code) fields directly to two Product/Service ID elements I T1 segment. However, you must
map a constant to each Product/Service ID Qualifier and establish a qualifying
relationship with the Product Service ID. This enables you to specify which Product/
Service ID element contains your partner’s product code, and which contains your UPC
code.
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How to Set the Product/Service ID Qualifier

Overview  You must map aconstant to the Product/Service ID Qualifier (IT106 and 1T108 elements)
and define a qualifying relationship with the Product/Service ID (1IT107 and 1T109

elements).

You aready defined all the constants that you are using in this map, so now you can map
the appropriate constant to each Product/Service ID Qualifier el ement.

Procedure  Usethis procedure to set the Product/Service ID Qualifiers for the IT1 segment.

Step

Action

1

Double-click the IT106 element (Product/Service ID Qualifier) inthelT1
segment in the IT1 group, to access the Element Properties dialog box.

Select the Sandard Rule tab.

From the standard rule list, select Use Constant.

From the Constantslist, select the“BP” constant (buyer’s part number), to
identify the IT107 element as containing the customer product code.

From the Qualifieslist, select the “0234 PRODUCT/SERVICE ID,” to set
up aqualifying relationship with the Product/Service ID element.

Click OK andthe“BP” codeisloaded in the Product/Service ID Qualifier
element and the qualifying relationship between the IT106 and 1T107
eementsis established.

Double-click the IT108 element (Product/Service ID Quadlifier) inthelT1
segment in the IT1 group, to access the Element Properties dialog box.

Select the Sandard Rule tab.

From the standard rule list, select Use Constant.

10

From the Constants list, select the “UI” constant (UPC identification), to
identify the IT109 element as containing the UPC code.

11

From the Qualifieslist, select the “0234:2 PRODUCT/SERVICE ID,” to
set up aqualifying relationship with the Product/Service ID element.

12

Click OK and the“UI” codeisloaded in the Product/Service ID Qualifier
element and the qualifying relationship between the IT108 and 1T109
eementsis established.
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How to Map the CUSTPROCODE and UPCCODE Fields

Overview  After establishing the appropriate qualifying relationships, you can map the
CUSTPROCODE and UPCCODE fields.

Procedure  Usethis procedure to map the product code information.

Sep Action

1 Link the application field CUSTPROCODE in the INVDETAIL record to
the IT107 element in the IT1 segment (IT1 group).

2 Link the application field UPCCODE in the INVDETAIL record to the
IT109 element in the IT1 segment (IT1 group).
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How to Map the Item Description

Overview  You know that you only send one PID:2 segment (in the PID subgroup in the I T1 group) to
your trading partner (typically the PID subgroup repeats up to 1,000 times). Therefore,
after you change the max usage of the PID subgroup to “1,” the ITEMDESC (item
description) field can be directly mapped to the PID:205 element. However, you must map
a constant to the Item Description Type (PID:201 element) and define a qualifying
relationship with the Description (PID:205 element) to indicate that the PID2:05 contains
afree-form item description.
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How to Change the Max Use of the PID Subgroup

Overview  You have determined that you only send your partner one PID:2 segment (in the PID
subgroup in the IT1 group), so you must change the maximum usage allowed for that
subgroup from “1,000” to “1.”

Procedure  Usethis procedure to change the maximum usage of the PID subgroup.

Sep Action

1 Right-click the PID subgroup (in the IT1 group) to access the shortcut
menu.

2 From the shortcut menu, select Properties to access the Group Properties
dialog box.

3 Select the L ooping tab.

4 In the Maximum Usage box, type “1” to make the PID subgroup a non-
repeating group. Thisbox is currently set to “1,000.”

5 Click OK to accept the change to the PID subgroup.
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How to Set the Item Description Type

How to Set the Item Description Type

Overview  You must map aconstant to the Item Description Type (PID:201 element) and define a
qualifying relationship with the Description (PID:205 element).

You already defined all the constants that you are using in this map, so now you can map
the appropriate constant to Item Description Type element.

Procedure  Usethis procedure to set the Item Description Type (in the PID:2 segment in the PID
subgroup in the IT1 group).

Step

Action

1

Double-click the PID:201 element (Item Description Type) in the PID:2
segment in the PID subgroup in the IT1 group, to access the Element
Properties dialog box.

Select the Sandard Rule tab.

From the standard rule list, select Use Constant.

From the Constantslist, select the“F’ constant (free-form), to identify the
PID:201 element as containing the free-form item description.

From the Qualifieslist, select the “0352 DESCRIPTION,” to set up a
qualifying relationship with the Description element.

Click OK and the“F” code isloaded in the Item Description Type
element and the qualifying relationship between the PID:201 and PID:205
elementsis established.
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How to Map the TEMDESC Field

Procedure  Link the application field ITEMDESC in the INVDETAIL record to the PID:205 element
in the PID:2 segment (PID subgroup, 1T1 group).

Note
If the system prompts you with a confirmation message, click OK.
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How to Map the Terms Type Code

Overview  You know that you only send one I TD:2 segment (in the I T1 group) to your trading partner
(typicaly the ITD:2 segment repeats up to 2 times). Therefore, after you change the max
usage of the ITD:2 segment to “1,” the TERMSTY PE (terms type code) field can be
directly mapped to the ITD:201 element.
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How to Changethe Max Use of the I TD:2 Segment

Overview  You have determined that you only send your partner one I TD:2 segment (quantity), so
you must change the maximum usage allowed for that segment from “2” to “1.”

Procedure  Usethis procedure to make the ITD:2 a non-repeating segment.

Step

Action

1

Right-click the ITD:2 segment (in the I T1 group) to access the shortcut
menu.

From the shortcut menu, select Properties to access the EDI Segment
Properties dialog box.

Select the L ooping tab.

In the Max Usage field, type “1” to make the ITD:2 anon-repeating
segment. Thisfield is currently set to “2.”

Click OK to accept the change to the I TD:2 segment.
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How to Map the TERMS Fields

How to Map the TERM S Fields

Map the
TERMSTYPE
field

Map the
TERM SDISP field

Link the application field TERMSTY PE in the INVDETAIL record to the ITD:201
element inthe ITD:2 segment (IT1 group).

Link the application field TERMSDISP in the INVDETAIL record to the ITD:203
element inthe ITD:2 segment (IT1 group).
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INVSUMMARY Record

Mapping Totals

Overview  This section describes the actions necessary for you to map from each field in the
INVSUMMARY (summary) record. The INVSUMMARY record contains the total
invoice amount and the total transaction amount. The summary record is mandatory and
occurs once per invoice trans ated.

Thesefields are part of the application file format key, but do not contain data that the
system needs to use to generate the invoice. Therefore, you do not perform any mapping
operations on these fields.

» BILLTOACCTSUM
» DOCTYPSUM
» INVNUMSUM
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How to Map the TOTALAMOUNT Field

Overview  For the system to create output segments, there must be at least one explicit link to an
element in that segment, and data to support that link. Therefore, even though you are
mapping the total amount with accumulators, you must add an explicit link with an
application field that contains data.

Procedure  Link the application field TOTALAMOUNT inthe INVSUMMARY record to the TDS01
element in the TDS segment.
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How to Map the TRANSTOTAL Field

Overview  For the system to create output segments, there must be at least one explicit link to an
element in that segment, and data to support that link. Therefore, even though you are
mapping the transaction total with accumulators, you must add an explicit link with an
application field that contains data.

Procedure  Link the application field TRANSTOTAL in the INVSUMMARY record to the CTTO1
element inthe CTT segment.
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Finalizing the Map

Overview

Introduction  After you create the import map, define your application file format, and perform the

appropriate mapping operations, you need to finalize the map. To complete the mapping

process, you heed to save the map, compile the translation object, print and review the
Sterling Gentran: Server report, and test the map.
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Outbound Invoice (810)

How to Compilethe Map

Overview  The Compile function compiles the map and generates a trand ation object. The map that
you created using the Application Integration subsystem (PET_810.MAP) isasource
map. When that source map is compiled, the result is a compiled translation object.

After you save the tranglation object, you must register it with Sterling Gentran: Server
before you can useit.

Procedure  Usethis procedure to compile a map and generate a translation object.

Step

Action

From the File menu, select Save to save the source map, prior to using the
Compile function.

From the File menu, select Compile to display the Run-Time Translation
Object Name dialog box.

Run-Time Tranzlation Object Hame EHE

Save in: Ia Trans0bj j gl IEE_

File name: — |PET_810.TFL

Save as hpe: ITransIatinn Objects [~ TPL) j Cancel |

The File name box already contains “PET_810.TPL.” Thisisthe name of
the trandlation object, using the default .TPL file extension. We
recommend that you name the translation object (.TPL file) the samefile
name (1-8 characterslong) as you named the map (MAPfile). Preserving
the same file name (with different file extensions) means that the
relationship between the source map and the compiled translation object
remains evident.

Caution
Do not overlay the source map with the compiled translation object. Use
the .TPL file extension to distinguish the trand ation object.
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How to Compile the Map

(Contd)
Sep

Action

4

Change the Drive and Folder where the compiled translation object is
stored, if necessary.

Caution

Do not store the compiled translation object in the
GENSRVNT\RegTransObj subfolder. This subfolder is reserved for
storing a copy of each translation object you register with Sterling
Gentran:Server.

Click Save and the system compiles the map and generates atrandation
object. The Compile Error dialog box is displayed. Verify that no errors
occurred and click OK to exit the dialog box. The date on which the
tranglation object was compiled is automatically loaded into the Compiled
on box on the Transaction Object Details dialog box.

[ X]

Tranzlation Object Details

— Surnmary -
Author Description Tranzlation Object Function ; Uk
[Sterling [FET_an0 [import =l Cancsl |

- Flags GentrarServer for Wind

: " entrar Server for windows
[~ Gystern | Use Configurable Trimming [ B Eampeiv e Burks Exeuifay

r— Wersion Control

Major version |1 Minar version ID

— EDI Aszociations

Compiled an |1 B-tar-2000

Irpuat Output
pgeney [ | [« [x12
Version | | 03030 | JANSI <12 VERSION
Tranzaction I I |8'ID IINVDIEE
Releaze I_ IEI—
F Group I I IIN I

From the File menu, select Save to save the source map with the
Compiled on date.

Note
You must register this translation object with the Sterling Gentran: Server
system before you can use it.

Reference
See the IBM® Serling Gentran: Server® for Microsoft Windows User
Guide for more information on registering a translation object.
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How to Print the Report

Overview  The Sterling Gentran:Server report enables you to validate and review the map, and make
modifications as needed. If you review the report and determine that the map is incorrect,
you should reiterate the mapping process as many times as necessary (make the
modifications, save the map, recompile the trand ation object, and print the report again).

Procedure  Usethis procedure to print the Sterling Gentran: Server report.

Sep Action
1 From the File menu or Main Toolbar, select Print to access the Print
Options dialog box.

— Repart zections

¥ Print branching diagram

¥ Prirt record details Cancel |

¥ Print mapping details

¥ Print extended rules

™ Frirt code lists

¥ Include anly active objects

2 Accept the defaults on this dialog box (all options checked), so the report
includes all sections and only the activated map components. Click OK
and the Print dialog box is displayed.

3 Set the appropriate options. Click OK if you do not need to change Setup
options, and the mapping report is printed.

Click Setup if you need to access printer setup information (to select a
specific printer, paper orientation, or size and source of paper). The Print
Setup dialog box is displayed.

4 Set the appropriate options. Click OK if you do not need to change Print
options (dithering, intensity control, or print true type as graphics), and
you return to the Print dialog box. Click OK on the Print dialog box and
the mapping report is printed.

Click Optionsif you need to access printer setup optionsinformation. The
Options dialog box is displayed.

5 Set the appropriate options. Click OK to return to the Print Setup dialog
box. Click OK on the Print Setup dialog box to return to the Print dialog
box. Click OK on the Print dialog box and the report is printed.
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How to Test the Translation Object

How to Test the Trandlation Object

Overview  After you compile the map, print and verify the report, and register the translation object
with Sterling Gentran: Server, you should test the trand ation object to verify that the data
istrandated correctly. To test the compiled translation object, you should obtain test data
from your partners and process the data. You should also verify acknowledgement
processing (if applicable) and verify communications with your network.

Reference

See the IBM® Serling Gentran: Server® for Microsoft Windows User Guide for more
information about these topics:

Registering atranglation object
Importing a partner

Selection outbound trand ation objects
Importing files

Viewing raw EDI data

Procedure  Usethis procedure to test the system import (HEADER.TPL) and import (PET_810.TPL)
trand ation objects.

Step

Action

1

Register the HEADER.TPL and PET_810.TPL trandation objects with
Sterling Gentran: Server.

If you have not already done so, import the PETZONE.PAR partner
relationship into Sterling Gentran: Server.

The default full path for the partner fileis:
C: \ GENSRVNT\ TUTORI AL\ PETZONE. PAR

Verify (in Partner Editor) that the PET X 3030 810 Import translation
object is selected for the Outbound Relationship.

Ask your system administrator to add the system import transl ation object
(HEADER.TPL) to the System Configuration program.

Reference

Please see the IBM® Serling Gentran: Server® for Microsoft Windows
Administration Guide for more information about how your system
administrator must modify the system configuration program.

Use the Import option in Sterling Gentran: Server to process the datafile
(PET_810.TXT) through the translation object. The datafileislocated in
the TUTORIAL subfolder under the folder where Sterling Gentran: Server
isinstalled.

The default full path for the datafileis:
c: \ GENSRVNT\ TUTCRI AL\ PET_810. TXT

Application Integration ANSI Tutorial Guide
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How to Test the Translation Object

Outbound Invoice (810)

Step

Action

After the document istranslated, it is located in the Workspace in Sterling
Gentran:Server. View the EDI datato ensure that the document was

tranglated correctly.

Sterling Gentran:Server — May 2011
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GLOSSARY

Glossary

?In Documents  This Sterling Gentran: Server browser contains alist of documents that were received by
the system but failed compliance checking or that do not have an identifiable partner or
transaction set.

?0ut Documents  This Sterling Gentran: Server browser contains alist of documents that were imported into
the system via unattended processing but are invalid.

acknowledgement Thisterm is used to indicate the ANSI 997 functional acknowledgement, the EDIA 999
acceptance/rejection advice, and the EDIFACT CNTRL document.

activation This function enables you to make map components available for use. The system
activates all the groups, segments, composites, and elements that are defined as
“mandatory” (must be present) by the standard. The system does not enable you to
deactivate the mandatory groups, segments, composites, and elements. When trandlating
data, the system does not process groups, segments, composites, and elements (or records
and fields) that are not activated. Therefore, you must activate the groups, segments,
composites, and elements that are not defined as mandatory by the standard, but that you
have determined that you need to use in mapping.

AIAG  TheAutomotive Industry Action Group (AIAG) isthe standards-setting group for the
automotive industry. The standards form a subset of the ANSI X12 standard.

ANA  Article Numbering Association.

ANSI American National Standards Institute. ANSI sets standards for many products and
services, such as safety glasses and battery capacities. The ANSI X12 committeeisthe
chief EDI standards-setting organization for the United States.

application file  If you are creating an import or export map, you must define your application to Sterling
Gentran: Server. In Sterling Gentran: Server terminology, your application fileis aso
referred to as a fixed-format file or a positional file. Your application file must contain all
the information that you either need to extract from your partner’s document (if themap is
inbound) or need to send to your partner (if the map is outbound), so that your system can
accurately process the data.
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application system

application system

browser

button

codelist tables

colours

communications
session

Communicator

compile

compliant

component data
element

Glossary

Computer systems, outside of EDI, designed to fulfill specific business functions. These
include accounting, purchasing, materials control, human resources, shipping, and other
systems.

A browser isawindow that displaysalist of items, such as documents (transaction sets),
interchanges, trandation objects, etc. A document browser displays only documents.

A button enables you to execute acommand. You select abutton either by clicking it or by
pressing TAB until the button you want is selected and then pressing ENTER.
Unavailable buttons are dimmed, and the currently selected button has a darker border
than the other buttons.

These are used by EDI standards as repositories for lists of codes. Each EDI standard
provides a code list for each element that can be further defined with a code.

This feature enables you to select foreground and background colours to visually define
the various map components. The use of colour is optional.

Everything sent and received to/from one telephone number in one continuous period of
connection. This could include sending two or three interchange envelopes to a network,
each for adifferent trading partner.

Thisisthe Sterling Gentran: Server communications software. The Communicator enables
you to send, receive, resend, establish communication port definitions, establish
communication profiles, establish communication scripts, and view and delete
communication sessions.

This function compiles the map and creates a trand ation object. The map that you create
using Sterling Gentran:Server is a source map. When that source map is compiled, the
result isa compiled translation object. This translation object must be registered with the
Sterling Gentran: Server system before you can useiit.

This means that the document conformsto the EDI standards as defined by the translation
object.

A simple data element that bel ongs to a composite data element. Component data
elements are also called subelements.

Sterling Gentran:Server — May 2011
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Glossary

composite data
element

conditions

constant

cross-reference
table

date/time

deactivation

default

dialog box

document
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composite data element

A contains two or more component data elements or subelements. Composites are defined
by the EDI standards that use them (EDIFACT, TRADACOMS, and certain ANSI X12
standards).

Seerelational conditions.

This standard rule enables you to move aliteral constant value to the specified element or
field, indicate a qualifying relationship with another element or field, and map the current
date or time to the specified element or field.

Thistable is created in Partner Editor and is used to convert your values to your trading
partner's values during outbound processing, or your partner's valuesto your values during
inbound processing.

Thistype of field or element contains a date or time. If you specify that afield or element
is a date/time type, you must specify exactly how the date or time must be formatted.

This function enables you to make map components unavailable for use by the system.
The system does not enable you to deactivate the mandatory groups, segments,
composites, and elements.

A predefined value — programs use these built-in values unless you specifically override
them.

A diaog box (or dialog) contains additional information or optionsthat you need to act on.
If you specify any options, you can select a button to execute the command. Some dialog
boxes display warnings or messages indicating why a requested task cannot be
accomplished. If the dialog box has atitle bar, you can move it to another location on your
desktop.

One transaction set containing actual data and treated as a single entity. The amount of
data does not affect whether something is a document or not, only the fact that it is treated
asasingle entity. For example, regardless of whether a purchase order contains one item
or ten thousand, if it is one purchase order, it is one document.

If atrading partner sends you a communication containing 10 purchase orders, you have
received 10 documents. If the communication contained 15 invoices, you have received
15 documents.
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double-click

double-click

EANA

EDI

EDI standard

EDIA

EDIFACT

element

Glossary

Thisindicates that you should position your cursor on top of the designated item and
quickly press and release your primary mouse button twice. The primary mouse button is
the button you access with your index finger, regardless of whether you are utilizing right-
handed or |eft-handed mouse operation.

International Article Numbering Association, Brussels, Belgium.

Electronic Data Interchange (EDI) is the process by which companies can exchange
business documents directly from application to application by computer without paper
documents being produced.

Thisisthe rules for turning a business document into an EDI document.

The Electronic Data Interchange Association, formerly known as the Transportation Data
Coordinating Committee (TDCC).

Thisis the standards organization of the United Nations Economic and Social Council.
The acronym is short for the Electronic Data Interchange for Administration, Commerce,
and Transport.

The smallest piece of usable information defined by the standards. Examples might
include a quantity, unit price, or description. An individual element can have somewhat
different meanings depending on context. Therefore, elements are normally not
considered to have useful meaning until they are combined into segments. An element is
the EDI map component that is mapped (linked) to a corresponding application field to
move data to and from the EDI file.

There are three types of data elements, asillustrated in the table below:

Data Element Definition

Simple dataelement | A single piece of information defined by

the standards.
Composite data A data element that is made up of multiple
element component elements.
Component data A simple data element that belongsto a
element composite data element. Component data

elements are also called subelements.
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Glossary envelope

envelope A way of separating information in transmissions for ease of processing. Each envelope
contains a header segment and atrailer segment, which separate the envelope from other
envelopes and provide information about the contents of the envelope.

There are three levels of envelopes, asfollows:

Transaction Set
Each transaction set (business document) is contained within atransaction set
envelope.

Functional Group
An envelope containing related business documents. The standards define which
transaction sets should be placed together into a functional group envelope.

Interchange Envelope

All material being sent to one trading partner in one communication. The term
Interchange Envelope is the term used by ANSI. EDIA uses the term Transmission
Envelope to refer to thislevel of envelope. Since we use the term transmission for
other uses, we will refer to Interchange Envelope only.

Note

A communications session could easily include a number of interchange envel opes.
For this reason, the standards-setting bodies are considering a fourth level of
envelope to cover an entire communications session.

equalize  Thisfunction enables you to reinstate the two sides of the map with focusin equal
dimensions. The use of the Equalize function is optional.

export map  Thismap defines how to move datafrom the EDI standard-formatted documents that your
partners send you to your application file (flat file definition). An export map is necessary
for inbound processing.

export trandation  See export map.
object

extended rules  Theserules enable you to use a Sterling Gentran: Server proprietary programming
language to perform virtually any mapping operation you require.

field  Thesmallest piece of information defined in the application file. A field isthe application
map component that is mapped (linked) to a corresponding EDI element to move data to
and from your application file.

fixed-format file  Seeapplication file.
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font

font

functional group

group

import

import map

import tranglation
object

In Documents

inbound mapping

In Drawer

Glossary

This feature enables you to globally change the font that is used in the display of all maps.
The default font that Sterling Gentran: Server usesis a Sans Serif 9 point. The Font feature
enables you to change the font type, style, and point size. This gives you the flexibility to
shrink the font if you need to view more of the map on your monitor, enlarge the font, or
change the type and style to be more easily readable by you.

A group of transaction sets that the standards-setting body (such as ANSI) has defined as
fitting together with other related transaction sets. An example might be a Functional
Group defined as containing all purchasing transaction sets.

A looping structure that contains related records/segments and/or groups that repeat in
sequence until either the group data ends or the maximum number of timesthat theloopis
allowed to repeat is exhausted. If you create agroup that is subordinate to another group (a
subgroup), this corresponds to a nested looping structure (aloop within aloop). The
application (positional) file and the EDI file are both groups and therefore, they isvisually
represented the same way as other groups and subgroups in Sterling Gentran: Server.

This command enables you to import datafrom an external application file. Depending on
the content of the file, the system may prompt you for partner, transaction, or translation
object information.

This map defines how to move data from your application file (flat file definition), which
may contain multiple documents, to the EDI standard-formatted documents that your
partners expect to receive from you. An import map is necessary for outbound processing.

See import map.

This Sterling Gentran: Server browser contains alist of documentsthat the system received
but that have not yet been processed by the user. Once the documents are processed
(printed or exported) the documents are transferred to the In Drawer.

The system translates your trading partner’s EDI standard formatted business document to
your application file format, so you can receive documents from you partners. To trandate
inbound data, you need to create an export map.

This Sterling Gentran: Server browser contains alist of documents that were received and
processed.
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integer

interchange

I nterchanges
browser

link

literal constant

location table

lookup table

loop count

loop start/loop end

integer

An integer is a number that has an implied decimal point (e.g., “2.01" isformatted as
“201").

Theinterchange contains all the functional groups of documents (transaction sets) sent
from one sender to one receiver in the same transmission.

This Sterling Gentran: Server browser enables you to view a hierarchical list of all the
interchanges that were sent or received. It contains status information about the
interchanges, (e.g., whether or not afunctional acknowledgement was received and the
status of that acknowledgement). This browser also enables you to access the documents
within the interchanges. The Interchanges browser can always be accessed.

This function enables you to map afield or element from the Input side of the map to a
field or element on the Output side of the map. The link between two map components
(hereafter referred to asfields) is visually represented with aline connecting the two
fields.

These are used by the system as arepository to store information that is used at alater
point in the map. Typically, constants are used in an outbound map to generate a qualifier.

Thisisatable created in Partner Editor that is used to contain address-rel ated information
about the partner.

Thisisatable created in Partner Editor that is used to select information related to avalue
in inbound or outbound data.

This standard rule enables you to count the number of times aloop is repeated, if the
element or field ispart of aloop. If theloop isanested |oop, you can track the current loop
or the outer loop. For example, if the Y loop is nested within the X loop, and the Y loop
has cycled through 15 iterations and the X loop has cycled through 3 iterations, you can
choose to count either the “15” (Y loop) or the“3” (X loop).

Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS and LE
segments differentiate between two or more loops of the same type. If the transaction
contains LS and L E segments and depending on whether your map is inbound or
outbound, you must definethe LS and LE segments for the loops you are using in the map
in one of two different ways.
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map

map

menu

menu bar

networ k

number

ODETTE

Out Documents

outbound mapping

Out Drawer

partner

Partner Editor

positional file

Glossary

A set of instructions you define in the Sterling Gentran: Server Application Integration
subsystem that indicates the corresponding relationship between your application file and
the EDI standards, and defines how the system should translate data.

A list of items from which you can choose. Each item represents acommand. Unavailable
items on a menu are dimmed to inform you they are disabled.

This contains the list of menus for the application.

Also known as a Third Party Network or Value-Added Network (VAN) that accepts and
holds transmissions from companies until it is convenient for atrading partner to accept
them.

Thistype of field or element contains either an integer or real number. If you specify that a
field or element isanumber type, you must designate the format by specifying aformat of
either “N” (integer) or “R” (real) and the number of decimal places.

The Organization for Data Exchange by Tele-Transmission in Europe.

This Sterling Gentran: Server browser contains alist of documents that are ready to be
sent. After the documents are successfully sent, they are automatically transferred to the
Out Drawer.

The system trandlates your application file format to EDI standard formats, so you can
send documentsto your partners. To translate outbound data, you need to create an import
map and a system import map in Sterling Gentran:Server.

This Sterling Gentran: Server browser contains alist of documents that were successfully
sent out by the system.

Another firm with which your company trades documents. Also referred to as atrading
partner.

This Sterling Gentran: Server function enables you to define, edit, and delete all partner
information for your company and all of your trading partners.

See application file.
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post

predefined

printout

promote

qualifier

real number

receive

record

relational
condition

respond
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post

This Sterling Gentran: Server function enables you to move compliant documents from the
Workspace to the Out Documents.

On adataentry translation object, adefault value for aparticular element. You can change
the value as necessary.

Thisis produced when data received from atrading partner passes through a print
tranglation object. You do not have to actually print the data. The printout could beto afile
on your hard disk.

This function extracts one iteration (instance) of a group or repeating segment. This
enables you to map unique data from your application file, and/or enter a specialized
definition. Sterling Gentran: Server specifies that only one-to-one (no loops) or many-to-
many (loop) mapping relationships are valid.

Thisisan element that has a value expressed as a code that gives a specific meaning to the
function of another element. A qualifying relationship is the interaction between an
element and its qualifier. The function of the element changes depending on which code
the qualifier contains.

A real number has an explicit decimal point (e.g., “2.01" isformatted as“2.01"), and
truncates trailing zeroes.

This Sterling Gentran: Server function enables you to manually initiate a communications
session to receive data from your trading partner.

Contains agroup of related fields. A record can occur once or can repeat multiple times.

This function enables to connect fields together for syntax or compliance reasons. For
example, Field A isinvalid unless Field B is present. Therefore, if you set up a condition
that pairs Fields A and B, the system generates a compliance error if one of thosefieldsis
not present.

This Sterling Gentran: Server function enables you to create a turnaround document (using
the Turn Around translation object in the partner relationship) in response to one or more
selected documents in the In Drawer.
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responsible agency Glossary

responsibleagency  An organization that develops and updates standards for EDI communications. These
organizationsinclude ANSI, EDIA, AIAG UCS, EDIFACT, ODETTE, and VICS.

segment A group of related elements or composite data elements that combine to communicate
useful data. Segments are defined by the EDI standards. A segment can occur once or can
repeat multiple times. For example, a catalog price segment might consist of elements for
item description, volume, price, lead time, etc. By themselves, none of these elements
would communicate useful information. Together, they provide the information necessary
for someoneto tell if theitem iswhat is desired, whether the priceis reasonable, etc. A
number of segments together form a transaction set.

select This standard rule enables you to select entries from alocation table, cross-reference table,
partner table, or lookup table (all tables created in the Sterling Gentran: Server Partner
Editor). You can then map the fields in those tables to one or more fields in the data. The
Select function uses the value of the current field to perform the selection.

send This Sterling Gentran: Server function enables you to manually start a communications
session to send data to your trading partner. Only selected documents are enveloped and
sent. If no documents are selected, ALL documents are sent. Successfully sent documents
are moved to the Out Drawer.

set See Transaction Set.

simplemapping  Seelink.

split This function enables you to split (break) a group or repeating segment into two loops.
Typically, you use this function when you need more than one instance of the same map
component that still occurs multiple times.

standard rules  Theserulesgive you accessto functions that are necessary for mapping operationsthat are
more complex than simple linking, but less involved than extended rules. Each of the
standard rules are mutually exclusive (you can use only one on a particular field).

status bar The status bar of an application window defines information about a selection, command,
or process, defines Menu Bar items as the user highlights each item, and indicates any
current keyboard-initiated modes for typing (e.g., CAP for the “Caps Lock” key or NUM
for the “Num Lock” key, etc.).
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string

syntax token

system import map

system import
translation object

system trandation

object

TDCC

TDF

third-party
network

title bar

string

Thistype of field or element contains one or more printable characters. If you specify that
afield or element isastring type, you must designate the format by specifying a syntax
token.

This function enables you to designate a“token” that defines ranges of characters and/or
numbers that are allowed to be used for a string-type element or field. You can then use
the syntax tokens in the Format field of the Field Properties dialog. This enables you to
define what type of characters should be used while compliance checking each element/
field (i.e., aphanumeric within a certain range, numeric within a certain range, etc.).

The translator uses this map to determine which trading relationship (established in
Partner Editor) corresponds to each document in the application file, so the system knows
which import map to use to process the document. You need a system import map that is
defined in EDIMGRL.INI to translate outbound data.

See system import map.

These trandl ation objects control the creation and separation of interchanges, functional
groups, and transaction sets. They also used to generate and reconcile functional
acknowledgements. All the required system translation objects are automatically installed
with the Sterling Gentran: Server system.

See EDIA.

TDF isthe Transaction Data File. Thisfile serves as afilter between your document files
and the Sterling Gentran: Server translator. For outbound processing, dataisimported from
aTDF file and translated to EDI format using a TDF Import translation object. The datais
then ready to be posted and sent to your trading partner. For inbound processing, EDI
documents that are received by Sterling Gentran:Server can be exported to a TDF-
formatted file using a TDF Export translation object. This datafile is then ready to be
processed or converted to your internal application files.

See Network.

Thetitle bar of an application window contains the name of the application and enables
you to move the window to another position on your desktop.
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toolbar Glossary

toolbar This contains buttons that graphically represent commands available in the Menu Bar.

TRADACOMS  TheU.K. standards for EDI that are published by the Article Numbering Association
(UK) LTD.

trading partner Another firm with which you company trades documents. Also referred to as a partner.

transaction set A business form as defined by the standards. Examples include an ANSI 850 purchase
(document)  order or an UCS 880 invoice. The standards define each transaction set in terms of the
segments and elements that make up the form, the order in which they appear, and the

relationships among them. Thisis aso known as “message” in Europe.

trandation object A predesigned layout set up to ensure that input or output for a particular transaction set
existsand is presented in a usable fashion. You must specify which trand ation objects are
used by each partner relationship.

Inbound Translation Objects:
Turn Around: Thistranslation object is used when adocument is received, to
create the natural response document that contains as many elements from the
received document as possible.

Export File: Thistrandation object indicates that when adocument is
received, it is exported to a specified file format.

Print: Thistrandation object is used to print documents.

Outbound Translation Objects:
Import: Thistranslation object is used to import datafrom an application file.

Print: Thistrandation object is used to print documents.

Data Entry: Thistranslation object is used to enter data into the Document
Editor facility.

trangdator Thisisthe engine that processes datafor Sterling Gentran: Server, the Application
Integration subsystem, and the Forms I ntegration subsystem.

transmission See Communications Session.

transmission chain A path an EDI communication could follow, including one company, one trading partner,
and one or more network services.
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Glossary turnaround document

turnaround A document into which data elements from the source document have been automatically
document  transferred using a turnaround map.

turnaround map A seriesof instructions that the system uses to create a turnaround document (alogical
response document to the source) from an inbound (source) document, by transferring
data from the source document to elements in the target document (translation object).

UCS  The Uniform Communications Standard is the standard used by the grocery industry.

update  Thisstandard rule enables you to update a specific field in a document record, envelope
segment, interchange, group, current partner, or document (if the map side format typeis
EDI), with the contents of the element or field.

Caution

Please note that this function updates the internal Sterling Gentran:Server database
tables. We recommend that you use this function only if you are sure you realy
want to update the internal database tables.

Typically, you only use this function if you want to update the document name and
reference in the document table. Any other use of this function could have
disastrous consequences!

use accum This standard rule gives you access to a set of numeric variables that you can manipulate
via numeric operations, and then transfer to and from fields. This function enables you to
add, change, or delete calculations for the element/field, including hash totals (used to
accumulate numeric field values, i.e., quantity, price, etc.). This function also enables you
to map the accumulated total into a control total field, and use accumulators.
Accumulators are used generally for counting the occurrences of a specific element or
generating increasing or sequential record or line item numbers.

usecode  Thisstandard rule enables you to match an element or field against a predefined code
table, specify whether or not a compliance error is generated if the element or field does
not contain one of the values in the code table, and store a code’s description in another
element or field.

user trandation These trandlation objects control data entry, importing, exporting, document turnaround,
object and creating printed reports. These translation objects are created using the Application
Integration or Forms Integration subsystems. The Application Integration subsystem
enables you to generate import, export, and document turnaround translation objects. The
Forms Integration subsystem enables you to generate data entry and print translation
objects.
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VICS

Wor kspace

X12

Glossary

Each standards-setting body updatesits standards on aregular basis. Each formal updateis
referred to asaversion.

The Voluntary Inter-industry Communication Standards is the standards-setting body for
the retail industry, a subset of ANSI X12.

This Sterling Gentran: Server browser contains alist of outbound “Work in Progress”
documents. It also contains recently imported or data entry documents.

The ANSI committee that sets and publishes standards for EDI.
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Notices

Thisinformation was devel oped for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other
countries. Consult your local IBM representative for information on the products and
services currently available in your area. Any reference to an IBM product, program, or
service is not intended to state or imply that only that IBM product, program, or service
may be used. Any functionally equivalent product, program, or service that does not
infringe any IBM intellectual property right may be used instead. However, it isthe user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in
this document. The furnishing of this document does not grant you any license to these
patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.SA.

For license inquiries regarding double-byte character set (DBCS) information, contact the
IBM Intellectual

Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law

IBM Japan Ltd.
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1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

Thefollowing paragraph doesnot apply to the United Kingdom or any other country
wheresuch provisionsareinconsistent with local law: INTERNATIONAL BUSINESS
MACHINES CORPORATION PROVIDES THIS PUBLICATION "ASIS' WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do
not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

Thisinformation could include technical inaccuracies or typographical errors. Changes
are periodically made to theinformation herein; these changes will be incorporated in new
editions of the publication. IBM may make improvements and/or changes in the
product(s) and/or the program(s) described in this publication at any time without notice.

Any references in thisinformation to non-IBM Web sites are provided for convenience
only and do not in any manner serve as an endorsement of those Web sites. The materials
at those Web sites are not part of the materials for thisIBM product and use of those Web
sitesisat your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs and
other programs (including this one) and (ii) the mutual use of the information which has
been exchanged, should contact:

IBM Corporation

JBAIGA

555 Bailey Avenue

San Jose, CA__95141-1003

U.SA.

Such information may be available, subject to appropriate terms and conditions, including
in some cases, payment of afee.

The licensed program described in this document and al licensed material available for it
are provided by IBM under terms of the IBM Customer Agreement, IBM International
Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary significantly.
Some measurements may have been made on devel opment-level systems and thereis no
guarantee that these measurements will be the same on generally available systems.
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Furthermore, some measurements may have been estimated through extrapolation. Actual
results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM has not
tested those products and cannot confirm the accuracy of performance, compatibility or
any other claimsrelated to non-IBM products. Questions on the capabilities of non-IBM
products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

Thisinformation is for planning purposes only. The information herein is subject to
change before the products described become available. This information contains
examples of data and reports used in daily business operations. To illustrate them as
completely as possible, the examplesinclude the names of individuals, companies, brands,
and products. All of these names are ficticious and any similarity to the names and
addresses used by an actual business enterpriseis entirely coincidental.

COPYRIGHT LICENSE:

Thisinformation contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy, modify,
and distribute these sample programs in any form without payment to IBM, for the
purposes of developing, using, marketing or distributing application programs conforming
to the application programming interface for the operating platform for which the sample
programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs. The sample programs are provided "ASIS", without warranty
of any kind. IBM shall not be liable for any damages arising out of your use of the sample
programs.

Each copy or any portion of these sample programs or any derivative work, must include a
copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color illustrations may
not appear.

Trademarks I1BM,thelBM logo, and ibm.com are trademarks or registered trademarks of International
Business Machines Corp., registered in many jurisdictions worldwide. Other product and
service names might be trademarks of IBM or other companies. A current list of IBM
trademarks is available on the Web at “ Copyright and trademark information” at
www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or
other countries.
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IT Infrastructure Library is aregistered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered
trademarks of Intel Corporation or its subsidiariesin the United States and other countries.

Linux is aregistered trademark of Linus Torvaldsin the United States, other countries, or
both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

ITIL isaregistered trademark, and a registered community trademark of the Office of
Government Commerce, and isregistered in the U.S. Patent and Trademark Office.

UNIX isaregistered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of
Oracle and/or its affiliates.

Cell Broadband Engine is atrademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are trademarks of
HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®,
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Rea time®, Gentran: Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks of others.
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